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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Develop Products

Overview of Product Development

Oracle Product Development tracks the early development phases of products that are going to be designed or built.

Product Development uses business objects named items, documents, manufacturer parts, change orders, and

change requests to build development structures that describe the assembly or product to be manufactured, or the
subassembly. Change orders are used to track changes on an item, document, their structure, or on a manufacturer part
that's associated with an item, with a revision attachment, or with the attributes of an item or document.

Here are some business objects and features in Product Development:

- Items and Documents - Introduce new items or documents to the enterprise, and add information and data to
them with easily defined attributes and characteristics;

- Structures - Gather items (with associated manufacturer parts) and documents into a structure (Bill of
Materials or BOM);

- Change Orders - Manage change orders formally and centrally on items, documents, AML, structures, and
attachments, and analyze the impact of each change;

- Quality Issues and Actions - Quality Actions and Quality Issues from the Quality Management work area can
be carried and processed by change orders in Product Development;

- Searches - Find items, documents, manufacturer parts, manufacturers, and change orders with simple or
advanced searches;

- Lifecycle Phases and Item Grades - Differentiate between items with revision-specific lifecycle phases, and
with calculated item grades that help evaluate for production readiness;

- AML - Manage manufacturer parts with an Approved Manufacturers List (AML) that can be associated with any
item or part;

- Incorporate Pre-production Proposals - Incorporate Concepts or Requirements from Oracle Innovation
Management Cloud applications;

- Connect to other Applications - Connect items, documents, and change orders to Project Tasks; and,

- Hand over to Manufacturing - Hand over items, documents, and structures to manufacturing, and track them
downstream to production and through to commercialization.

Related Topics
« How to Use Clipboard

» Use Tasks Panel to Manage Business Objects
« Items and Documents in Product Development
» Overview of Manufacturers

» Overview of Change Orders and Change Requests
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Overview of Innovation to Commercialization

Product Development's functionality can be broadened by Innovation Management and Product Hub applications. The
enterprise can streamline its end-to-end business processes:

Innovation and Proposals: Innovation Management applications;

Design and early Development: Product Development;

Manufacturing to Commercialization: Product Hub.

Innovation Management

Innovation Management is a suite of Supply Chain Management applications that promotes the abilities of the
enterprise to build suitable products. Innovation Management includes three compatible applications:

Ideas Workspace: supports and simplifies the innovation process to create, aggregate, and review ideas about
potential products.

- Concepts Workspace: supports defining a product in its conceptual phase, building requirements
specifications, concepts, and proposals.

Product Development to Commercialization

The enterprise brings matured concepts, proposals, and requirements specification forward to become products. A
product is designed and developed in Product Development, then handed over to Product Hub to be manufactured and
commercialized:

Product Development supports item and document creation and enrichment, and building items and
documents into structures. A structure is a list of assemblies - of items and manufacturer parts - or a list of
documents, both including the design and prototype of the product.

Using change orders to formally modify items, documents, and structures, the product evolves and moves
through initial development stages to readiness for manufacturing.

Product Development helps users manage Master Organization items and documents, while Product Hub helps
users manage Site items.

Product Hub takes the product through stages of manufacturing to commercial release, including multiple
versions, packaging, and other downstream processes. Product Hub allows the detailing-out of commercial and
operational attributes, and facilitates the management of part catalogs.

Integrations

Product Development integrates with Innovation Management to help streamline product innovation, design, and
development processes, and with Oracle Project Portfolio Management to manage development projects.

You can also create integrations with your Computer-Aided Design (CAD) applications to enable items, bills of material
and change orders to be managed in Product Development, while continuing to manage CAD designs and data in an
on-premise CAD product data management application.
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To support CAD integration, web services for Changes, Items and Structures are available. You can use these services
to develop integrations between Product Development and Agile Engineering Collaboration, other on-premise CAD
product data management applications, or cloud-based CAD applications.

Related Topics
« Overview of Product Development
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2 Business Objects and Structures

Overview of Product Development Business Objects

You can manage the design and development of products by using the following building blocks:

ltems

Documents

Manufacturer parts and their manufacturers
« Structures

Formulas

- Change orders and change requests

[tems and Documents

You can create items in Product Development or Product Information Management work areas to represent the parts
and assemblies of a product. A document is another type of item or part, representing description or specification of
items. The specific attributes of each new business object describe the characteristics of the item or document and,
taken together, the particular product. In this way, item and document business objects carry the necessary technical
and engineering information of the product.

Manufacturer Parts and Manufacturers

A manufacturer part is an item produced by a manufacturer. A manufacturer part can be related to any item designed
or produced by your company.

You can add the approved manufacturers list (AML) on an item’s AML tab. You can also add AML on the Structure

tab of the item. A document may not be associated with a manufacturer part. An item which is associated with a
manufacturer part and belongs to a structure will have an icon next to it on the Structure table that indicates the
association with a manufacturer part.

Manufacturer parts are identified with manufacturer part numbers. Oracle Product Development requires a
manufacturer to be created before you may even create a manufacturer part produced by that manufacturer.

Note: Item grade is calculated for items only, not for documents nor for manufacturer parts. However, the
configuration of item grade may allow the AML situation to be considered in the calculation of the item grade.

Structures

A structure is used to define the hierarchy of components that make up an item. It includes all items and supporting
documents required for an assembly or subassembly. Each structure specifies the components involved, their
quantities, and their relationships to the parent item, ensuring correct representation of the product design and build
process.
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Formulas

A formula is used to define how products are created from ingredients. This can be used in real-world manufacturing
scenarios more accurately, including multiple outputs and ingredient-level control. They allow manufacturers to specify
multiple outputs, including a primary product, and any co-products or by-products that result from the process. The
Formula business object captures and maintains details of all products and ingredients defined in the formula.

Change Orders and Change Requests
Change orders and change requests enable you to manage the modifications to an item in your company's design and
manufacturing processes.

When a change order is used to formalize the enrichment of an item (adding and modifying item attributes) or the
construction of a structure, no further modification on any scale can be effected without an additional change order.
Change orders, like items, can be initiated in the Product Development or Product Information Management work areas.

Related Topics
 Items and Documents in Product Development

- Overview of Manufacturers

« Overview of Structures

- What's the difference between an engineering change order and change request?
« Overview of Change Orders and Change Requests

» Overview of Formulas

Overview of Structures

In Oracle Product Development, a Bill of Materials is called a structure.

When you add an item to a parent item, you create a simple structure. As items are added, the structure is always
named and referred to by its top-level item.

A structure holds all the items and documents that make up an assembly or subassembly. ltems and documents might
be in the same structure; there's no restriction on the maximum or minimum number of either type of business object.

Any item on a structure might be associated with one or more manufacturer parts. On the Structure table, an icon
next to an item indicates the presence of manufacturer parts. So, a structure populated with items will likely comprise
associated manufacturer parts.

A document structure holds all the documents that make up a meaningful document, such as a specification for a
product. When you add a document to a parent document, a simple structure is created. A structure of documents will
be named and referred to by its top-level document. A document structure might be only one document.
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5 Get Started

Information Tiles on Product Development Overview
Page

The information tiles organize information about the business objects in Oracle Product Development. They help you
find additional data on favorite items, change orders, and notifications approaching deadlines.

To expand an information tile, click the down arrow icon in the tile. You can then select from, and drill into the
information in that tile.

My Favorite Iltems Information Tile

This information tile organizes items and structures that you've marked as a favorite.

The categories in the tile - Released, Unreleased, and Obsolete - can be similar or parallel with lifecycle phases that are
used by your company. The administrator associates these categories with a lifecycle phase type used in your company.
For example, your administrator can configure the design and the prototype lifecycle phases as unreleased. When you
click each category, you see the items that are currently in the lifecycle phase associated with that category.

My Worklist Information Tile

This information tile filters and collects your notifications about tasks that you must act on. Click each category to see
your notifications in that category. Or click the down arrow icon (View My Worklist) to see your entire worklist.

You can filter the notifications to view either pending or all notifications, and also perform actions on notifications. For
example, you may be notified to review a change order, and you can approve or reject the change order from here.
Actions that aren't available on a selected notification are disabled.

The calculations for the Worklist are based on the Need-by Date attribute.

- Overdue Deadline: The Need-by Date has already passed.
- Approaching Deadline: The Need-by Date is less than 2 days away.

- Waiting for Review: The Need-by Date is in 3 days or more, or not specified.
You can select the Pending option to see the changes that you must act on.

Note: The commercial change orders display the approve, and reject buttons. The approval type column isn't
populated for new item requests, and it doesn’t have the approve or reject buttons.

My Changes Information Tile

This information tile compiles the number of change orders that you created.

- Open link shows all change orders in Draft or Open status;
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Pending Approval link shows all change orders in Interim Approval or Approval status, which means changes
are yet to be approved or rejected;

- Approved link shows all change orders that have been approved, and are therefore ready to be Scheduled or
Completed.

To view change orders, click the View My Changes bar (or the down arrow icon). The My Changes page appears. You can
use the My Changes page to perform the following:

- Create, edit, or delete change orders and change requests.

- Sort change orders based on date, number, and description.

Filter change orders based on type, status, cycle time, date when the change was created, and so on.

Related Topics
- Lifecycle Phases in Product Development

« Overview of Change Orders and Change Requests
« Use Tasks Panel to Manage Business Objects

Search

Search for Business Objects

In the Product Development work area, you can search for the following business objects: items, documents, change
orders, change requests, manufacturer parts, and manufacturers. You can also perform an advanced search using
operators such as Starts with, Equals, or Contains.

Search for Multiple Items or Documents

You can search for multiple items in the same search operation. Before you use this feature, you must deploy extensible
flexfields.

In the Advanced Search region of the Manage Items page, use the search operator In to search for a list of comma-
separated item numbers.

You can copy and paste values from documents, spreadsheets, or reports into the search field. Comma-separated, tab-
separated, or new line separated lists are supported, and the text box allows up to 1000 characters including commas.

Related Topics
« How to Use Clipboard

» Deploy Item Flexfields

Use Product Management Search

The Product Management Search page is used for many objects within Product Management.
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You can select the object that's being searched using the selector next to the page title. The search page automatically
configures based on the selected object. Item, manufacturer, proposal and change types (change orders and change
requests) are the objects that are searchable through this page. You can control the attributes used in search, filters, and
how search will behave in the view.

To access the Product Management Search page, in the Product Management work area, click the Search tab at the
bottom. The Product Management Search page is displayed.

The search page has two main areas:

- Search Region, where you specify the search query.

- Search Results, where the search results are displayed based on the query run in the Search region.

Search Region

You can enter all search queries in the Search text box. This text box combines user entered search data as a query.
When you start typing in the Search text box, the search provides suggestions based on the data entered. Clicking on a
suggestion performs the search.

Autocomplete and Suggestions

Autocomplete provides type-ahead suggestions similar to autosuggest. Autocomplete reduces the number of clicks.
The suggestions are presented as you type within the Search text box. By default, a set of attributes for each object is
configured for autocomplete and keyword search. For example, in item search, the item number and item description
attributes are configured for autocomplete and keyword search to support cases where you search for an item number
or search for an item using terms within the item description.

Note: Autocomplete and suggestions are enabled by default for tem Number and Item Description attributes.

Autocomplete can provide suggestions for up to the first 20 characters you've typed. If the autocomplete or
autosuggest search option provides a suggested match that might not actually be what you're searching for and it's
difficult to select a different value, you can disable the autocomplete or autosuggest search option by setting the
Disable Redwood Search AutoComplete (ORA_EGP_RW_SEARCH_DISABLE_AUTOCOMPLETE) profile option to Yes.
To enable this option, set it to No.

Suggested Filters

You can refine the search by selecting filters and values based on the data in the search results. The first five to seven
suggested filters are displayed beneath the Search text box. The other suggested filters are available by clicking on the
Filters action. These are displayed based on the display order in the view. Suggested filters can be enabled only for date
and text attributes.

Note: You can’t enable suggested filters for long text attributes.

To apply a suggested filter, click it to edit the suggested filter. Click the suggested filter the second time to display a set
of values for the filter that you can select. Search and select a value and click anywhere on the page. The suggested filter
is applied on the search results and the table refreshes to display the result based on the applied filter.

Note: The counts show how often a specific value occurs. The values are provided through aggregation of the data in
the database for the attribute.
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The suggested filter might allow you to select another value, or sometimes you can select one or more values. For
example, to search for items for manufacturers aero Tech and Tech space, you can select both and the search results are
filtered based on your selection.

The following table provides the various suggested filters.

Filter Type Filter Name Description

Filters for Dates/Time Rolling Period This filter allows the user to select one or more
periods when the view is configured. The
periods include:

- Previous hour

- Previous 2 hours

- Previous 24 hours
- Previous 48 hours
- Previous week

- Previous 2 weeks
- Previous month

- Previous 2 months

When the filter is applied in the search user
interface, the user can select a period and the
display value for the attribute is filtered based
on the selection.

Date Range Selector This filter allows the user to define a range for
date. The date range will be use to filter the
display value for the attribute.

Filters for Numbers Number Facet This filter presents a set of operators that you
can select to filter the display value for the
attribute. Filter will display addition fields to
support the operator. For example: if the user
selects Between, the filter will display fields to
enter the Minimum and Maximum values.

Filters for Attributes with List of Values MultiSelectLOV This filter displays the value choices bases on
usage count and you can search for addition
values.

Checkbox This filter display values and you can select one

value using the checkbox.

The Filters action is available beneath the Search field at the end. Clicking this displays the Filters drawer, where you
can select values for the suggested filter. You can apply the search criteria to multiple filters in the drawer and click See
Results to run the search.

To remove the applied filters, click Clear.

I Note: Applying multiple suggested filters with specific values selected will be ANDed together as part of the search.

Keyword Search

When the index is created, each attribute is assigned an analyzer, which is used to create searchable content for the
attributes. Part of this process is tokenizing the characters in the attributes. Tokens are searchable terms that are part of

10
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the index record for the object. The tokenizer will create a set of tokens by reviewing the characters and applying rules
to separate the characters into tokens. For example, if the description contains: ‘CAP, CERAMIC, SMD, 0402, 0.22UF,
Y5V, 10V, +80/-20%’, the resulting tokens would be ‘CAP’, ‘CERAMIC’, ‘SMD’, ‘0402’ ‘0.22UF’, Y5V, “10V’, ‘480’ and *-20'.
Each token is searchable using keyword search.

By default, keyword search is enabled for primary attributes of the objects. For example, for items, keyword search is
enabled for item number and item description.

Administrators can turn on the Keyword enable switch for the ltem Description attribute for cases where they don't
want a match on the Description field. If the Description attribute value is generated using extensible flexfields, the
administrator can turn off the keyword search and use suggested filters to search for content within the Description.

All keyword searches use starts with in the searches.

Search Using Special Characters

Some characters in attribute values are considered special characters. Special characters are treated differently in the
index ingest process and when searching. Special characters are categorized into two groups:

- Operators: These characters are used in search to provide specific operations. For the list operators, see Search
Using Operators.

- Separators: These characters are used to break up a value into searchable terms. For example, in the item
number CAP-PRODA-A1, the - hyphen is a separator special character, which the index ingest analyzer uses
to break up the item number to searchable terms such as CAP, PRODA, and A1. Other separator characters are
space, and coma (,).

The underscore ( _)character isn't a separator or an operator. It's considered as any other character in an attribute value.
For example, if the item number is 1234-Alpha_LITEON and you enter LITEON, the search fails because the searchable
term is Alpha_LITEON.

Search Using Operators

You can use the following operators within the search criteria to perform a keyword search. Operators are enabled by
using the Simple Query String Search (ORA_EGP_SIMPLE_QUERY_STRING_SEARCH) profile option. You can set the
value to Yes to enable operators.

Operator Description

+ AND operator.

| or space OR operator. Space character is considered OR operator.
* When used at the end of a term, signifies a prefix query.

Search for a group of terms as a phrase. For example, “220 Micro Farads”.
(,) Wrap a clause for precedence (for example, wind + (capacitor| cap)).

~n When used after a term (for example, wnid~3), sets fuzziness. When used after a phrase, sets slop.

Search Content Within Item Descriptions Using Phrase Search

You can use double quotes surrounding a group of search terms to find a match closest to the term and to find one
or more terms in a specific order. Use phrase search on item numbers to increase the matches when the item number
includes special characters such as hyphen.

n
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For example, if the item description is:

ltem Number: CAP-0041 Description: CAP .22 Micro Farads 10mmdx17mml 105s mp LOW Axial y5v 0.05 Ohms 10 Year
100 Celsius -35 Celsius .0017 Amperes 8 % 5 Volt

You can search for "330 Micro Farads", or any other combinations of the terms in the order they appear. When you enter
"330 Micro Farads" as the search criteria, the result returns all items that have this phrase. The following screenshot
shows multiple items are found that has the phrase 330 Micro Farads and Capacitors_DQ_MM_1is one of the items in
the search results.

Search Using Query

When you don’t know the part number, you can use a combination of operators, phrase search, and suggested filters to
form a query. For example, the Design Engineer needs a capacitor in the micro farads range and can use 15 volts. The
Design Engineer knows that there are one or more item classes for capacitor and uses the Item Class suggested filter to
select one of the item classes. Next the Design Engineer enters the following query in the search box:

Cap + "Micro Farads" + "15 Volt"
where:
- Capis the keyword to do a keyword search for all part numbers starting with Cap
- +isthe AND operator
- "Micro Farads" is in phrase search format
- +isthe AND operator

- "5 Volt" is in phrase search format

The result of the query returns three parts. Next, the Design Engineer can add additional attributes using the View
Selector to refine the part to use.

= ORACLE

Product Management Search Item v

Q "330 Micro Farads”\

Primary Unit of Measure | | Item Class. Organization Filters.

-

O 3items ® Product Hub Search ‘ Current Latest ‘

Item Number & Item Description & Primary Unit of Measure < Item Class < Organization <
Capacitors_DQ_MM_1 330 Micro Farads ab 15 Volt 1.5 % Each Capacitors_DQ V1
Capacitors_DQ_MM_2 330 Micro Farads ab 15 Volt 1.5 % Each Capacitors_DQ V1
Capacitors_DQ_MM_3 330 Micro Farads ab 15 Volt 1.5 % Each Capacitors_DQ V1

You can use the operators to construct complex queries by combining them with terms in the Search box. The
formulated query can also be used with suggested filters. As example, you can select a filter value for an item class such
as 'Capacitors' and combine it with terms such as 'Axial’, the AND operator '+', and the term 'Micro' to search for all items
within the Capacitor item class that use the Axial mounting and are in the Micro Farads capacitor value range.

Use multiple search terms with operators and suggested filters together to form a query.

Expert users can use additional operators to form complex queries.

12
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Search Using Prefix Search

Attributes such as a part number might often use a prefix term as part of the value. The prefix term maybe followed
by additional terms often separated by special characters. For example, part number SC-MAKE-IT11is a base part and
the part numbers SC-MAKE-IT1-Body represents the body of the part. You can use the prefix search to find all the part
numbers with the prefix SC-MAKE_IT1 by adding a ‘*’ asterisk.

Assume you've a set of part numbers: SC-MAKE-IT1, SC-MAKE-IT1-Body, SC-MAKE-IT1-TOP, SC-MAKE-IT1-CAP, SC-
MAKE-IT1-FRAME, and SC-MAKE-IT1-BASE

You can search using SC-MAKE-IT1* to find all part numbers with prefix SC-MAKE-IT1.

Search Using Match Item Number

You can search for the exact item number or multiple item numbers (entered separated by space characters) using the
Match Item Number filter option. This filter option is always displayed as the first filter under the Search field. This
filter reduces multiple interactions of search and filters to find an item by matching the complete item number. It returns
only the item numbers you enter.

After you enter the item number that you want to search and click the Match Item Number filter, the new query engine
performs the search based on the ltem Number attribute and ignores other attributes that have been enabled for
keyword search. The query engine matches the complete item number that’s part of the index data.

ltem numbers that have special characters including embedded spaces, asterisks (*), or double quotes (“) must be
wrapped in doubled quotes (“). For example, to search for an item number called Spark Plug, you must enter “Spark
Plug” in the Search field because it has space as the special character between two words.

You can use other filter options with the Match Item Number search to narrow your search results. For example, if you
query items and you use child organizations, a search for an item number will return a row for each organization that
contains the item. You can use the Organization filter to filter the results based on the master organization.

If item numbers use prefix or set of characters at the beginning to indicate a type of item, the prefix search can be used
to search all items that have that prefix. For example, if item number is 152-1234, then 152 is a prefix to indicate that
the item is a server. You can use prefix search to search for all item numbers that start with the prefix 152 by adding an
asterisk to the end of the string.

Here's a list of operators that you can use with the Match Item Number filter.

Operator Description

Space Acts as a separator when searching for multiple item numbers.
Asterisk (*) When used at the end of search term, signifies a prefix query.
Double quotes (“) Wraps the item number with special characters.

I Note: The Match Item Number filter is a permanent filter and can't be removed. This filter won't appear in the View.

Search for Proposal Using Proposal Number

You can search for a specific proposal using the Match Proposal Number filter on the Product Management Search
page.
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Search for a Workflow Using Workflow Number

You can search for a specific workflow using the Match Workflow Number filter on the Product Management Search
page.

Apply Operators on Filter Options

You can apply operators on filters used for attributes with list of values. This helps to quickly narrow down search results
by using the operators on attributes that use list of values. To use the filter, you first select the operator, the filter will
redraw and provide addition selections based on the operator.

Here's the list of operators for the filters.

Operator Description

Is one of Display rows that contain one or more values when filtering.
Is not one of Exclude rows with one of more values when filtering.

Is blank Display rows with the attribute value as blank.

Is not blank Display rows with an existing attribute value.

Example Use Cases:
- Is one of: Show all rows where the Currency attribute value is USD.

- Is not one of: Show all rows where the Lifecycle attribute value isn't Design or Prototype to find rows that are
released for commercialization.

- Is blank: Show all rows where the Temperature Characteristic attribute value is null, that's, filter search for
attribute values that aren’t populated.

- Is not blank: Show all rows where the Product Type attribute has a value.

Search and Filter Multirow Data

You can use filters to refine searches for attributes that have one or more values such as item category assignments or
item relationships for items. These attributes are often child objects of the main object. The value selected in the filter
returns only those rows with the value. For example, if you select the Is one of Miscellaneous_1 value for the Category
Name filter, the result displays the items with this value for the category name.

Related Topics
« Search Results

Search Results

The search results are displayed in the search results region. A table within the search results will display the results as
rows. The number of rows isn't limited. The table columns and their order depend on the selected view. The Product
Management Search page is optimized to display more rows in the search results, and you can easily scroll down
through the results. The count shows the number of rows in the search and is dynamically updated without slowing the
search.

- View Data Presence Indicators

- Additional Features
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« Search Query Example

View Data Presence Indicators
The presence indicator indicates that the objects in the row on the search page have additional content.

For example, the Has Structures presence indicator displays a structure icon in the column to indicate that the item
in this row has a primary structure and you can view the (component) details. Other data presence indicators for
components appear only if your administrator has configured them for the selected view. You can add the presence
indicators to filters and as columns in the search results. Also, see the related links topic.

The supported presence indicators are:
« Isused in structures
- Has structures
- Has attachments
-« Has Product Development Relationships
- Has AML
- Has quality issues
- Has pending changes
- Has GTIN relationship
- Has customer item relationships
- Has category assignments
- Has cross-reference relationships
- Has competitor item relationships
- Has supplier item relationships
- Has source system relationships
- Has related item relationships

- Has supplier associations
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Note:
Data presence indicators are accessible for structures and AMLs on both child and reference organization
items, attachments, quality issues, and quality actions on reference organization items.

- To address performance problems related to data presence indicators for reference organization AMLs, create
the profile option EGP_SKIP_DPI_PROPAGATION and set its value to Y. This will stop the application from
generating data presence indicators for reference organization items. To update the data presence indicators
on the existing reference organization items, run the Add Data Presence Indicator to Index scheduled process.

- To update the correct data presence indicator values, run the Upgrade Product Management Data scheduled
process with the following parameters:

o Upgrade Process: Execution
o Functional Area: Item Child Entity Presence Indicator

o Feature: All

You must wait till the scheduled process completed successfully and then submit the index rebuild job.

Clicking the presence indicator icon in the workflow search results takes you to the Affected Objects tab, only
if you have permission to access any of the affected items within the workflow.

Notes on the drawer view:
- On the Attachments tab, you must select only a single row to download the attachment.

- The Pending Changes tab display change orders and change requests that are pending; it doesn’t include
released changes.

- The Product Development Relationships tab will display the relationships you added through the Product
Development work area. When you click the concept component or the requirement specification that's been
added as a related object, the parent concept or requirement is opened.

- The Quality drawer only displays the open quality objects.

Controlling Drill Down to Other Pages

You can control the behavior of drill down when using the link for the object number in the search results or the Has
Structures presence indicator through a profile option. The Drill Down in Place (ORA_EGP_PAGE_LAUNCH_CTRL)
profile option controls if the Structure page will be launched in new browser tab or launched in same browser tab as the
Product Management Search page. The default value is to launch the new page as a drill down in the same browser tab.
Use the Manage Advanced Item Profile Options task to update the value of the profile.

Controlling Display of Attributes with One to Many Values

You can control the display of attributes that have one to many values such as item category assignments,
relationship, or multirow attributes. The Display Data in Redwood Search as One to Many Format
(ORA_EGP_RW_SEARCH_ONE_TO_MANY_SPLIT_ROW) profile option controls if the attribute value is displayed by
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showing the one to many values in the same row in the search result table when the value is Yes. If the value is No, the
one to many display shows each value on different rows.

Related Topics
- Display Data Presence Indicator in Search Results

Using Views in Product Management Search

In Product Management Search, views are grouped into two types—system views and personal views. System views are
predefined and available in the application by default.

Only administrators can create and modify the system views. All other users can access the system views but can't edit
them. Users can create personal views by copying a system view and modifying the columns to suit their requirements.
Personal views are associated with only the user who created them. When the user logs in again, they can access the
personal views they've created. You can also identify important columns and choose the order in which you want to
view these columns for a specific task.

In the Product Management work area, when you click the Search tab at the bottom, the Product Management Search
page displays based on the default system view. If you've set a personal view as default, then the Product Management
Search page will initially display the default view. You can control the display of columns in your personal view. The
personal view will maintain the same view settings as the system view from which it was created.

The following screenshot shows the view name that’s currently being used.

Product Management Search ltem ~

Q

Organtzation  RemClsss  UbeCydePrase  NumiTest Dt Test  PrimaryUsitolMessre  Hassincires  Hesgusitylsse >

o hem o
Number ©  Dascription

IMFG_BIVL_ v Rost ltem Design

IMFG_BLVL, M1 Rost ltem Design

ZMFG_BLVL. Vi Root ltem Design

ZMFG_BL ZMFG_BLVL, M1 Rost lem Design

MFG_BL ZMFG_BLVL_. Vi Root lem Design

ZMFG_B ZMFG_BLVL Ml Root tem Design

o
o
o
[u]
o
[w]

Only the person who created the personal view can use the view. When necessary, the administrator can edit the
personal view on the Configure View page. On this page, the administrator can create system views that the business
users can use to create their personal views.

Create Personal Views
To create a personal view:

1. Click the current system view name.

A view selector appears that displays all the enabled system views and the current view name is highlighted.
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2. To create a personal view based on another system view, you must first click the required system view name to
make it the current view.

The Product Management Search page changes to display the column names based on the selected system

view. Click the view name and then click the lEl Duplicate icon for the highlighted the view name.
The Columns drawer slides open on the right side and displays all the attributes (column names) that are
configured in the current view.

3. You can show or hide the columns by selecting or clearing the checkboxes, and you can change the order of the

columns usingthe = icon. After you've completed the changes, click Save As.

The Columns drawer displays, where you can specify the details for the personal view.
4. Enter a name for the new personal view. Also, you can select the Mark as default checkbox to set the personal
view as the default view. Click Save and Apply to save the view as a personal view.

Edit Personal Views

To edit a personal view, go to the view selector and click the / Edit icon next to the view name. The Columns drawer
appears. You can show or hide columns by selecting or clearing the checkboxes and change the order of the columns

using the = icon. After you've completed the changes, click Save.

Saving Column Spacing

If you change the column spacing in the search results, resave your personal view to save the changes. You can also
manage the column spacing on the Configure View page.

Additional Features
The following additional features are available on the Product Management Search page:

- View selection: Select another view to change the attributes in the search and the search configuration. You
can use the search in the View Selector to find a view by typing the name of the view. All views are created on
the View Management page.

- Clipboard: Select one or more rows and click Clipboard to add them to the clipboard. The items will be
available in the application’s clipboard and can be added to pages in the work areas. The clipboard is now
persisted. This allows to use the fast search on the pages.

You can add items, manufacturers, and workflows to the clipboard only if you've the required view or manage
permissions using the access control list. The tabs available for navigation are based on the view or manage
permissions granted to you for the selected workflow, item, or manufacturer.

To open a specific tab of a workflow in the Clipboard or Recently Visited panel, select the tab from the drop-
down list.

- Hyperlink on the name: Click this link to view the details.
- Sort: Click the small arrows in each column to sort the results in ascending or descending order.

- Revision selector: Control the revision for which the search results are displayed. The item index contains
current revision and future revision content. You can choose to display either the current or latest content for
the item:

o Current: Current effective revision, effective date of the revision is before the current date (system date).

o Latest: Latest revision, if the effective date of the revision is greater than the effective date of the
currently effective revision.
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When you switch between Current or Latest options, the search information you had entered in the
Search field is removed along with the filters.

Export: Select up to 10,000 rows in the search results and export them to an Excel sheet.

- Adjust Column Widths: You can adjust and save column widths for both system and personal views. All

users can access system views while personal views are only accessible to the user who has created it and the
administrator. Previously, if column width changes were made within a view, you had to redo the same changes
when re-accessing the view. From this update onward, the column widths are persisted as part of the saved
view for the personal saved search. To change the column width:

# Hover on the line between the two column headers. The cursor changes to I

b. Click and drag the cursor either to the left or the right to adjust the column width.
c. To save the changes made to the column widths, click the View name, then click the Edit icon next to the
view name.

The Columns drawer is displayed on the right side.
d. Click Save to save the column width dimension changes you made on the Product Management Search
page.
Find Keyword Enabled Attributes When Editing Columns: You can find a column attribute using the search in

the Manage columns drawer. Attributes that are enabled for Keyword Search are displayed with the B icon.

Filters: Click Filters beneath the Search text box to open the Filters drawer, where you can specify the filter
value.

- Clear: Click Clear beneath the Search text box to remove the applied filters.

Search Query Example

Here’s an example that shows how to perform a search using the Search box with filters.

1.
2.

On the Product Management Search page, select ltem using the arrow next to the page title.

In the Search text box, type Capacitor. As you type this word, suggestions are displayed and the suggested text for
autocomplete also appears in grey color. From the displayed suggestions, select XC1103.

The search results are automatically refreshed to display capacitors with the item number XC1103.

Click the Primary Unit of Measure suggested filter beneath the Search text box and select the value Each. Click
anywhere on the page.

The selected filter is applied and the search results are refreshed to display XC1103 items with primary UOM as Each.

Search for Workflows, Approvals, and History

You can use the Product Management Search interface to configure and run a search for workflows, workflow approvals
and workflow history.

To navigate to the search page, in the Product Management work area, click the Search tab at the bottom. On the
Product Management Search page, you can select one of the following:

- Workflow
- Workflow Approvals
- Workflow History
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Search for Workflow

Workflow search can be used to configure and run a search for change orders, change requests, problem reports, and
corrective actions. You can combine multiple keyword searches along with applied filters to complete the search. For
example, you can search for:

- all changes created within a date range.

- all high priority changes in open status assigned to you.

- all changes based on Customer, Supplier, Manufacturer, and Source information.
- data presence indicators for tasks, attachments, and relationships.

- all changes of type New Product Introduction (NPI), and change extensible flexfields of product lines.

Search for Workflow Approvals

You can search for workflow approvals that need your attention by searching for both users and roles with participant
types of Approver, Optional Approver, or Reviewer. This is supported for change orders, change requests, problem
reports, and corrective actions in open, interim approval and approval workflow status types.

When you've a role as a participant and Response Required From is One, use this combination of filter chips to aid
your search:

If the approval task hasn't been claimed by any member of the role:

Participants Participant Role Activity Type

Role Name Role Name Approval

If the approval task has been claimed by one member of the role:

Participants Participant Role Activity Type

User (person who has claimed it) Role Name Approval

Here are the example use cases for Workflow Approvals search by user role:

- Change and Quality Analyst:
o Workflows pending approvals from a user or roles

o High priority workflows pending approval
o Overdue pending approvals
- Approver or Reviewer:
o My pending approvals
o Workflows that need my review
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Manager:
o Workflows pending approvals from my group

o High priority workflows pending approval from my group
o Overdue pending approvals from my group

Participant Elapsed Time in Workflow Approval Search Results

The Participant Elapsed Time attribute in workflow approval search results represents the number of days a workflow
has been awaiting approval from participants. The elapsed time is measured in days for each participant and reflects
the smaller value of the following two durations:

- The time since the change most recently entered the workflow status.

- The time since the user was last added as a participant in that workflow status.

The elapsed timer starts when a participant becomes an approver—either when the change first enters the signoff
status or when the participant is added as an approver to the signoff status.

The timer increases by one day at a time and pauses in either of the following conditions:

- The approver signs off the change for that status.

- The change exits that workflow status.

If the change enters a specific signoff status multiple times, a separate elapsed duration is recorded for each
occurrence.

Search for Workflow History

You can search across change types to find all affected object redlines and updates made to the change header,
workflow status, and other workflow entities.

For example:

- To find all workflow edits made by a specific user, Riley Smith, between June 23, 2024, and July 2, 2024, you can
filter the search results based on workflow type, author, and date.

- To find all workflow history for a specific affected object, enter the affected object name in the search box.

Tips for Search
When you search for workflows, workflow approvals, or workflow history, you can:
- Select any configured view.

Based on the configuration of the selected view, you can:
o search by keywords.

o apply one or more filters on the search results.

« Show or hide columns in the search results.
Use the sort function to sort any column.
Export the selected list of workflows, workflow approvals, or workflow history.

- You can apply filters or remove filters from filter drawer.
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The Workflow Type (on the Product Management Search page) will be filtered to certain change types depending on the
work area from where you launch the search; however, you can override the filter to display all change types.

Work Area Change Types Filtered To

Product Development Engineering change order, change orders without revision control, engineering change request, design
change request

Product Information Management Commercialization change order
Quiality Management Problem report, corrective and preventive action
Note:

- When you select the object, it will be opened in its respective work area, regardless of the work area from which
you've launched the search.

« You can search for multiple changes by entering change numbers separated by space. For example: NPI123
ECO124 ECR156.

Product Lifecycle Management Navigator

You can use the Product Lifecycle Management Navigator to access your saved searches across Product Lifecycle
Management objects and add, pin, and copy items, manufacturers, or workflows to and from your clipboard.

With the saved searches for each object, you can quickly navigate to the records you want without re-entering the
search criteria. Also, you can refine your search further or create a new saved search.

Tagging lets you organize saved searches and clipboard items for a specific purpose. By assigning tags to relevant
objects, you can effortlessly recall these collections when conducting searches, streamlining access to valuable
information. You can search for tagged objects using the Tag filter and select a tag group.

You can also navigate to a specific detail tab from the clipboard.

To access the Navigator, on the News Feed page, click the Product Management icon or click Product Management
Overview in Quick Actions. The Product Management landing page is displayed. Click the Navigator tab at the bottom
to view the Navigator.

You can pin the Navigator so that it persists in the left-hand panel. When you unpin, it automatically closes. Click the
Navigator tab to access it again.

Access Saved Searches
In the Navigator's Saved Searches tab, you can:

- Easily find and select personal saved searches across objects using the Filters option. Filters limit searching
saved search based on:

o Pinned items

o Object type
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o Tag used for an object

Run saved searches by clicking the link for the object.
Use the search to search for saved searches by name

Use the Tag icon and tag the saved search into one of the existing tag groups. You can also create a new tag.
When you click the Tag icon, a blank field appears. Type the tag name and press Enter to create the tag. When
you hover or click the Tag icon for an object, the associated tag name is displayed.

Note: When you use a saved search in the Navigator, the saved search persist the view with the saved search. If you
use the Saved Searches icon to select a saved search, the view isn't persisted with the saved search. If the current
view doesn't contain attributes for the filters in the saved search, the filters won't be displayed or applied, and can
result in a different search results.

Access Clipboard
With the Product Lifecycle Management Navigator Clipboard tab, you can:

- Add items, manufacturers, or workflows you want to save and access at a later time. You can select the item,
manufacturer, or workflow and launch the detail page.

Items added to the clipboard will be available in the clipboard in the Product Development and Product Hub
work areas.

Pin clipboard items so that they appear at the top (beginning) of the clipboard for quicker access.

Use the filters to limit searching clipboard items by:
o Pinned or not pinned objects

o Object

Pinned items are always displayed at the top (beginning) of the clipboard and have their checkboxes selected,
followed by objects most recently copied to the clipboard

- Click the Tag icon for an object to view the tagged groups.

Related Topics
- Search Region

Reports and Analytics

You can use Reports and Analytics in the panel drawer to create reports and analytics about business objects.

Quickly view or run analytics and reports that are related to your work in the Reports and Analytics pane. With the
required privileges, you can also create and edit analytics and reports here.
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Use the Item Audit Trail

An audit report is the history of an item, a listing of all actions or modifications that have been made on the item.

Because the audit trail could show a complete history across all items, it's necessary to filter first for the data you need.
Your search for items or documents can be restricted by Date, User, Product, Event Type, Business Object Type, and
Description.

To use the audit trail, do the following:

1. Use Navigator to go to the Product Management work area. From the list of offerings, click Product
Development.

2. From the Tasks panel tab, click View Item Audit Trail.

3. Onthe Audit Reports page, enter the search criteria, including Date, User, and product information, Event
Type, Business Object Type, and Description. Also select whether you want to include child objects.

4. C(lick the Search button.

Review the history in the search results page. To export the search results to a spreadsheet, click the Export
icon.

Audit Report on Change Orders

To create an audit report on a change order, open a change order, select Actions > Audit and select a status. Then open
the Audit Results side tab and check the results.

The report checks for consistency in the item structure, when the change order holding the structure is moving to
the Approval status. These consistency checks ensure that child items are in the same or higher lifecycle phase as the
parent item; and an Approved parent item doesn't refer to a child item that's still in Draft.

The audit results either show a "no error or warning" message, or show a list of errors and warnings.

How to Use Clipboard

You can copy items and documents to the clipboard and paste them on to other items and documents or affected
objects of a change order.

Clipboard

Copy items and documents from the Favorites and Recent ltems tabs available on the clipboard to speed up your work.
Use the clipboard icon that appears on the Affected Objects tab and Relationships tab to copy items to the clipboard.

The clipboard contains:

- Clipboard: a cumulative list of multiple copied items. The most recently copied item appears at the beginning
(top) of the list. The contents of the clipboard are now retained when you sign out of the application and sign
back in.
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Favorites: a list of items that have been specified as favorites by clicking the Add to Favorites (star) icon in the
item header. Click the Refresh icon to display recently added favorites; the most recently added one appears at
the start (top) of the list.

Recent Items: a list of items that you've visited. Click the Refresh icon to display recently visited items. The
most recently visited item appears at the beginning (top) of the list.

Note: The use of the clipboard is subject to security controls. If you've privileges only to search for and view items,
then you can copy and paste the items but not edit them. If you don't have privileges to search for and view items,
then you can't copy the items, and they don't appear on the clipboard.

You can quickly create a structure by using an item on the clipboard. Here's how the Copy and Paste actions work with
the clipboard:

In the source structure, select items or documents and use the Copy icon, or Actions > Copy. The items appear
on the clipboard.

- Open the destination structure and click Clipboard on the side panel.
Review the item (or structure) you want to copy.
- Select the items and drag (move) or use the Paste icon or Actions > Paste.

The following notes about clipboard are applicable to change orders, change requests, problem reports, and corrective
actions:

- The clipboard retains its content when you sign out of the application and sign back in.

- The clipboard can hold up to 500 items and you can sort the items by the date you added them, from latest to
oldest.

- Select one or multiple items from the clipboard and use the drag and drop (select and move) or paste icon to
add them to the Affected Objects tab, Item Structure tab, or Relationships tab.

- The selections you make on the clipboard are deselected when you:
o add more items to the clipboard.

o sign out and sign back in.

Points to Remember:

Note that you must first copy the items to the clipboard, select them from the clipboard, and paste them to the
Affected Objects tab or Item Structure tab.

- When you copy the items from the search results table to the clipboard, the items in the clipboard are
deselected.

- When you select items on the clipboard and move either to the Favorites or Recent Items tabs and return to the
clipboard, the selection persists.

The contents of the clipboard aren’t cleared out when you sign out. To remove items from the clipboard, you can select
a single item or several items and click Remove (the X icon). Click Clear All to clear the clipboard.

Pages Where You Can Copy and Paste Items

Here are the pages from which you can copy items and structures:

- Change Order > Impact analysis
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Item > Item grade
[tem > Where Used

Here are the pages on which you can paste items with the clipboard function:

[tem > Structure table

Document > Structure table
- Change Order > Affected Object > Structure table
- Change Order > Affected Object table

Copy Items from Product Development to Quality Management

Once you copy items into the clipboard in the Product Development work area, they also appear on the clipboard in the
Quality Management work area. So you can copy items and paste them directly into the tables of Affected Objects or
Related Objects in:

« Quality issues

- Quality actions

Use the Clipboard to Paste Items into a Change Order

You can use the clipboard to copy and paste items to a change order's affected objects table.

1. Navigate to the Product Development work area.

2. Open an item and click the Structure tab.

3. Select the row that you want to copy. Since you can no longer copy and paste directly from the source location
to the target location, you must first copy the items to the clipboard.

4. Create a change order in which you want to paste the item.

o From the Tasks panel drawer, click Create Change Orders.
o From the Change Type list, select the type of change order.
o Inthe Name field, enter a name for the change order.
o Inthe Description field, enter a brief description.
o Click Save.
5. Paste the item into the change order.
o Inthe change order, click the Affected Objects side tab.
o Select the item from the clipboard and click the Paste icon to paste the item you copied.

Similarly, Copy icons in the Change-Impact Analysis and the Item-Grade tabs, enable you to select and copy multiple
items into the clipboard. The Copy icon in the Item-Where Used tab lets you copy only a single row. Selecting a row or
multiple rows activates the icon and a description of the item appears when you hover over it in the clipboard.

Related Topics
« Watch Video: Use the Clipboard
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Use Tasks Panel to Manage Business Objects

You can use the Tasks side tab to create and manage business objects even when you're performing another task on the
interface.

Let's say that you're building a structure and you realize that your structure needs an item that doesn't exist. Then you
use tasks side tab to create a new item and add that to the structure. You can add information to any object as you
create it; or, you can save it in simple form and add more data later.

Related Topics
« View Item and Document Details

« Overview of Change Orders and Change Requests

Use Reports and Analytics

To create reports and analytics about business objects, click the Reports and Analytics panel tab.

If you have permissions, you can create and edit analytics and reports. You can also add reports and analytics from the
Business Intelligence catalog.

To navigate to the Reports and Analytics work area, click Navigator > Tools > Reports and Analytics.
Use the work area to perform an analysis. For example, in a table or graph you can use analyses to:

Summarize or break down simple, real-time data.

Make short-term decisions.

Related Topics
» Creating and Administering Analytics and Reports for SCM
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4 Items and Documents

ltems and Documents in Product Development

ltems and documents have many features in common. Both types of business objects are derived from the same
original class type. From the primary Root Item Class, the administrator may create a Root Document Class.

Additional class types may be created based on the root classes. Different class types allow different kinds of items and
documents. Items created from the same item class inherit the same template of attributes. Documents created from
the same document class inherit the same template of attributes.

The document business object behaves in much the same way as the item business object. A document that contains
information or specification about an item or assembly can be added to an item structure. Or, a document structure
could be built with documents that contain item requirements or specifications in parallel with every item of an item
structure.

The differences between items and documents are:

- Documents can't be associated with manufacturer parts;

- Documents don't use the item grade function and attributes.

Related Topics
« View Item and Document Details

« Overview of New Item Requests

View Item and Document Details

An item's General Information side tab is the starting point to access its basic information. Depending on configuration
and company needs, the attributes of an item might number a dozen or go well beyond a hundred.

Here are the side tabs available on items and documents:

Note:
- A blueicon indicating the presence of content appears on the side tab. Additionally, when you hover on the tab,
the tooltip displays Has Content.

- Blueicons aren't displayed for those tabs that always have content, or have content calculated upon selecting
the tab: General Information, History, and Iltem Grade.

- General Information - the default or cover page of an item or document.

You can view an item's revision number and the corresponding change order from the Revision list on any item
page. The current effective revision is marked with an asterisk (*) character.
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Note:
o Canceled item and document revisions don't appear in the Revision list.

o Previously effective revisions of the item can't be edited.

- Attachments - text or graphic files, or URL, with more information about the item or document; attachments
can be classified in a category. Includes revision-specific content.

- Structure - the Bill of Materials for assembilies, products, and other collections of items and documents.
Includes revision-specific content.

- Quality - displays those quality issues or quality actions to which this item or document has been added.
Includes revision-specific content.

- Changes - lists change orders or change requests that the item or document is on.

- Relationships - user-set association between any two business objects or structures. Includes revision-specific
content.

- Team - users and groups who have access to the item or document.
- Where Used - displays those item-structures to which this item is added.
- History — shows data changes made to audit-enabled item attributes.
Here are the side tabs that are only available on items:
- AML - Approved Manufacturers List; manufacturer parts supplied by approved manufacturers are associated
with items to be added to structures. Includes revision-specific content.
- Item Grade - notifies conditions of risk for the item.

General Information

You can view the fields that are predefined in the application, and the extensible flexfields configured by your
administrator. The administrator can decide whether you can view or edit flexfields by assigning privileges to attribute
groups and users. The flexfields are defined in the item classification; so, available fields are derived from the item class
hierarchy and respective attribute assignments.

You can also add a thumbnail or graphical image of the item.

Here's a description of the key attributes and fields on the general information page:
User Item Type

An attribute that describes the item. For instance, Finished Goods, Freight, or Inventory Type.

Note:

- Redlines to this attribute are seen on the Edit Item page and on the change order in Simplified Change
Management Interface.

- If you create an item in Product Development, you can’t modify User Item Type from Product Information
Management.

- To hide User Item Type in Product Development, use Page Composer.

Unit of Measure
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The Unit of measure attribute is used by various functions and transactions to express the quantity of items. Each unit
of measure you define must belong to a unit of measure class.

The administrator uses the Manage Units of Measure task in the Setup and Maintenance work area to add UOMs to the
list of available UOMs.

You can update the primary unit of measure on a new item request-enabled item when it’s in the Draft status. The
item can be a part of a structure and you can change the UOM to any UOM. If the item is part of a structure or has

a structure, once you change the UOM, save and close the item, a message informs you that the primary UOM was
changed for the item and that this may affect the components in the item structure or any structure where the item is
used. After you update the UOM, you must check and manually update items in any impacted structures.

Note: The primary unit of measure won’t be editable for approved items on new item request classes and non-new
item request classes.

Created From

You can view the Created From attribute on the General Information page where you can see the source item from
which the current item was copied. You can click the source item name to view details and navigate to the source item.
You can also view the details of the Created From attribute in the item history. Here, if the source item is deleted, you
see an ID as the attribute value instead of the item name.

In the Product Development work area:

- the Created From attribute displays the source item name along with the revision.

- when you click the hyperlink, it opens the specific revision of the source item from which the current item was
created.

Irrespective of having access to the item, the hyperlink appears in the Created From field. If you don't have access to the
source item, an error message appears when you click the hyperlink. If the source item is deleted, a message informs
you that no matches were found. If the item wasn’t created using Save As, the attribute value for Created From is blank.

Product Line Attribute
You can use this attribute to assign the item to a product line in your company. This enhances the supply chain's
operational information.

To add product lines, click the plus icon. In the Assign Item to Product Lines dialog box, you can identify which product
line is already assigned to an item. You can also search for a product line and sort the available lines.

Note that the product lines are available for selection here only if your administrator has set up the catalog rules for the
Product Development functional area as described in the topic: Functional Area Catalogs Rules.

Operational Attributes

An enterprise can have hundreds of additional operational attributes for any item or product. These attributes don't
need to be displayed on its main development pages, in fact, they may not become relevant until later on the path to
commercialization. The administrator defines the visibility of operational attributes in Product Development work area.

You can modify the operational attributes from the Product Information Management work area. Here’s how:
Open the item and click the Specifications tab. Operational Attributes appear in tem Organization.
Change-controlled Item Attributes

These attributes can only be modified through a change order.
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Where Used

You can view the other item structures to which the item has been added. You can also use filters to view specific
structures. Note that the following data security privileges are required to view the Where Used report: View Item Basic,
Maintain Item Basic, and View Item Structure or Maintain Item Structure.

Here are the filters and fields on the Where Used tab.

Show Structure Levels: Filter items based on the level in which this item is used in another structure.
- First level: view first level of the structure in which the item is used.
- Top level: view topmost level of the entire bill of material in which the item is used.

- Alllevels: view all levels from the item to the topmost level in which the item is used.

Note that the duplicate components appear only in first and all level views.

Show Items: Filter items based on their approval status in a change order.
- Implemented: view items that are already effective.

- All: view items that are effective and items that are yet to go through the change order approval process.

Filter a large list of items: Use Query by Example. Let's say that you want to filter items by a lifecycle phase.
« Click Query by Example.
- Enter the filter criteria in the field corresponding to Lifecycle Phase.

Date: This is the reference date used when running the where-used query.

Let's say that the date appears as 7/18/19. Then it's the where used data as on 7/18/19. The table shows how the date
differs based on the selected item revision.

Selected Item Revision Date

Past effective Revision end date
Current effective Current date
Pending Current date

Future effective Future effective date

Include Substitute Components
Select this to identify where the item is used as a substitute component. Here are the important columns for substitutes:

- Item: shows the structure in which the item is used as substitute. The number of structure levels shown in the
item depends on what you select in the Show Structure Levels filter.

- Substitute For: Shows the components for which the context item is marked as a substitute. Appears only if
you select First level and Include substitute components filters.
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Here are some additional details on substitute components:
- You can view substitute components only for first level structure in the Ul and all levels in the OTBI report.

- The component number displayed in the Substitute For column is read-only.
When you click the information icon (orange triangle) on the item, a panel that includes links to item entities
appears. Note that you'll only see items for which you're granted access.

- You can enable substitute component search by default using the profile option Include Substitutes in ltem
Where Used Data.

- When you select Include Substitute Components, the Where Used results are restricted to:
the master organization and primary structure in Product Development, and to the context item's organization
in Product Information Management.

- You can perform a search on primary, alternate, or all structures based on the search filters in Product
Information Management.

- The change order details report (in Product Development) includes the following substitute component
attributes: Primary UOM, Enforce Integer Requirement, Priority, and Global descriptive flexfields.

Team
At the item class level, your administrator defines users and groups who have access to items and assigns appropriate
privileges.

At the item level, you can use the Team tab to add additional users and groups who should have access to the item.
Note that you can't delete or modify the users and groups defined by the administrator.

History
You can view the history of data changes made to audit-enabled item attributes. Audit data is presented only for the
item that you're currently viewing or editing.

When you click the History tab on an item, you see the changes made in the recent week. You can view data changes
made on the following item tabs: General Information, Structure (excluding reference designators and side tabs), AML
(except for preliminary items), and Security.

You can also search for audit data by a combination of criteria such as user details, the type of data change (add,
update, or delete), a specific field, a specific value in a field, or a specific part of item data such as extensible flexfields.
Audit-enabled data can include operational attributes of items, item-level extensible flexfields and flexfield security,
item structures, and item structure components. You can also access this data from Navigator > Tools > Audit Reports.

To see more details in search results, you can select the following:

- Show User-Related Details: Shows the user ID in addition to the user name.

- Show Attribute Details: Shows the actions that were performed on the attribute (created, updated, or deleted),
along with old and new values.

- Show additional object identifier columns: Shows additional columns for Context Name and Context Value,
to indicate each unique context in which the item is used. For instance, if you add a component to the structure,
then the Context Value 2 column shows the component that was added (if the checkbox is selected).

Additional information:

- The History tab is available only if your implementor has assigned you the appropriate privileges.
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- To view audit data, your audit policy must include the item data attributes that you want to audit. Audit policies
are set up using the Manage Audit Policies task in the Setup and Maintenance work area.

Related Topics
« Overview of Structures

« Why am | unable to view the Substitute For column in the structure details?

- Manage Attachments in ltems and Change Orders

 Relationships in ltems and Documents

» How Item Grade is Calculated

« How Units of Measure, Unit of Measure Classes, and Base Units of Measure Relate to Each Other

Find Attributes on Item Page

You can search for extended flexfield attributes on the item or document page even when the attribute groups are
collapsed. You can also find the next attribute that matches your search criteria.

This is useful when you have to find and edit specific item attributes in items and documents that have a large number
of extended flexfields. You can also choose to keep attribute groups collapsed by default to ensure faster loading of item
and document pages.

Note:

- To keep attribute groups collapsed by default, your administrator must configure the value for the item profile
option ACA_ITEM_EFF_DISPLAY to Collapse All using the Manage Administrator Profile Values task (in the
Setup and Maintenance work area).

- The search doesn't mark up Unit of Measure type attributes in a different color and style.

Here's how you find extended flexfield attributes:

1. Enter the text pattern you're looking for in the Find attributes field on the item or the document page, and click
the Next button.

Note: Pressing Enter won't start the search.

The attribute matching the text pattern appears in a different text color and style for easy identification.
2. To view the next matching attribute, click Next.

The page automatically scrolls to show you the next attribute that matches the text pattern.

If a matching attribute is found within an attribute group that's currently collapsed, the group is expanded to
show you the attribute.

3. To edit the attribute, move the cursor to the attribute field.
4. To navigate through the attribute search results, click the Previous button adjacent to the search field.
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Take Action on Items and Documents

Here are the actions available on items and documents:

Assign to Change Order or Assign to Change Request: quickly assign the item or document to a new change
order or change request.

Save As: create an item or document from the one you're working on.

The primary unit of measure and item attribute values are copied from the item you're working on; you can
modify these values in the Save As dialog box.

The item lifecycle phase is copied from the template defined in the item class. Note that this value is unavailable
in the Save As dialog box.

Delete: mark an item for deletion and add it to a delete group. You can create a new delete group or add the
item to an existing group.

To confirm the item deletion use Manage Delete Group available in the Tasks panel. The item must meet the
deletion constraints so that it's not used in any structure or change order.

In case you want to again use the item and it can't be deleted due to constraints, you must restore the item.

Send Object: send a message about the business object to another user.

Messages displaying the list of recipients can be sent to a single or multiple users. This feature works for items,
documents, and change orders.

Generate Report: generate an item structure report that displays the main attributes of component items as
well as descriptive flexfields and AML. You can configure the attributes that you want to display in the report
template.

Note:
o To generate the item structure report, you will require the Bl Consumer role and the Generate
Item Change Order Report (EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV) privilege.
o You can generate the report only in Product Development or the Product Information
Management work area and not within Oracle Analytics Publisher. Note that the template is

configured using Oracle Analytics Publisher.
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- Download Attachments: download item and manufacturer part attachments for either first or all structure
levels. You can choose from options and specify which attachments you want to include in your download when
you select Download Attachments from the Actions menu of a change.

If you choose Single level and select Include manufacturer part attachments, then the root item's
attachments including its manufacturer part attachments are downloaded.

If you choose All levels and select Include manufacturer part attachments, then the item and its structure
attachments including manufacturer part attachments at all structure levels are downloaded.

Note:

o You can only download attachments for the manufacturer parts for which you have permission
to access.

o Downloaded attachments appear in Zip files with subfolders showing the item structure
hierarchy. You can find manufacturer part attachments in the AML subfolder.

- View Reports: view the configured Oracle Transactional Business Intelligence (OTBI) reports for the item.

You can search for specific reports or view the configured reports. You can also view specific context options
such as Structures, Where Used, AML, and more.

- Publish for Analysis: publish the structure and where used data for analysis in Oracle Transactional Business
Intelligence (OTBI).

To publish data for analysis, click Actions > View Reports > Publish.

Note: Ensure that all users who need to publish data for analysis have the View Product Management
Reports (ACA_VIEW_PRODUCT_MANAGEMENT_REPORTS_PRIV) privilege to view reports. This is true for
suppliers as well, if you intend to have them run scheduled processes for structure and component reports
directly in OTBI or through the Reports and Analytics side tab.

- Create Quality Issue: a quality issue is a defect, deficiency, or a significant variation in an item's expected
appearance or performance.

- Create Quality Action: a quality action is a necessary activity required to mitigate a quality issue and prevent
its further occurrences.

Note:
- The availability of an action depends on your privileges and the administrative setup.

- Some of the tasks can also be accomplished from other user interface components.

This action is found only on items (not documents):

- Refresh Cost: retrieve the latest costs for the item or structure, and to perform the cost rollup.

Related Topics
» Use Tasks Panel to Manage Business Objects

« Manage Attachments in Items and Change Orders
» Overview of Change Orders and Change Requests
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Review [tem and Document Changes

The Changes page contains two subcategories, Pending and Released. When you click the Changes side tab of an item,
the ltem Changes and Structure Changes tabs appear. They display either the Pending Changes or Released Changes in
a table format.

The Item Changes tab displays the pending change orders and change requests of the item. The Structure Changes tab
displays the pending change orders across all the items in all the revisions in the structure.

Pending Changes

Displays change orders and change requests that are in the following status: Draft, Open, Interim Approval, Approval,
Hold, and Canceled. To view canceled change orders, you must select Show Canceled Changes.

Released Changes

Displays change orders that are in the Scheduled, and Completed status.

When to Use Change Orders

Manage item revisions by submitting the item for approval by a change order. Attachments and AML must also be
modified through a change order. You can't directly modify a manufacturer or an attachment.

Related Topics
» Create a Change Order and Submit it for Approval

Lifecycle Phases in Product Development

Lifecycle Phases are used as an indicator of the stage for an item or document during the design and development
process. Each phase represents a set of standard tasks or deliverables that are required before promoting an item to the
next phase.

Each item or document must have a lifecycle phase associated with it. An object from a given class can be assigned to
any of the lifecycle phases associated with that class. Before you can create or import items or documents or structures,
the appropriate lifecycle phases must be created and assigned to the class used to create that object or structure (or to
a parent class of the class used to create the object). When a business object is assigned to a lifecycle phase, that phase
is visible as part of the object's attributes. In item or document structures, lifecycle phases name specific processes that
are somewhat different - or in any case named differently - than the phases for the objects on the structure.

Four lifecycle phase types are predefined in the application:
Design;
Preproduction or Prototype;
Production;

- Obsolete.
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To change the lifecycle phase of an item, you must assign it to a change order. You can also reinstate the lifecycle
phase from obsolete to an earlier one.

The administrator can create names for the lifecycle phases that are particular to your company's processes. There can
also be multiple phases based on the same predefined phase; for example, the predefined Production phase can be split
into phases named Production and In Manufacturing, each having company-specific meaning in the steps to build and
ship products.

Related Topics
+ Create a Change Order and Submit it for Approval

Considerations for Lifecycle Phases and Effective Dates

When you change the lifecycle phase or effective date, some restrictions apply.

Restrictions on Promoting Lifecycle Phase

In an item structure containing child items created in the Product Development work area and the Product Information
Management work area, there's a restriction when promoting the item lifecycle phase. On promoting the parent item,
the application restricts promotion of Product Development items. However, Product Hub items are automatically
promoted.

For example, consider the following item structure that includes items in the Prototype lifecycle phase:
Item-1 (created in the Product Information Management work area)
ltem-2 (created in the Product Development work area)

o Item-3 (created in Product Development)
o Item-4 (created in Product Development)

[tem-5 (created in Product Development)
[tem-6 (created in Product Information Management)
o Item-7 (created in Product Information Management)

On changing the lifecycle phase of Item-1from Prototype to Production, here's what happens:

Lifecycle phase of child items created in Product Development remains unchanged.
Lifecycle phase of child items created in Product Information Management changes to production.

Restrictions on Demoting Lifecycle Phase

In an individual item, the application restricts demoting the item lifecycle in the following scenarios:

Production to Design
Production to Prototype
Prototype to Design
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Restrictions on Future Effective Date

If you set a future effective date for an item in the design lifecycle phase, the application prompts you to select whether
you want to change the effective date or retain it. Note that the best practice is to make the item effective on approval. A
future effective date might initiate a complex process after the item approval.

Related Topics
» Can I change the lifecycle phase on an obsoleted item?

How Item Grade is Calculated

The Item Grade side tab displays the Item Grade page. The application computes a temporary grade for the item, using
standard rules from the industry.

Documents or manufacturer parts don't support the Item Grade function.

Grade Items in Risky Conditions

Grading is computed for all the Items from the entire item structure. It takes into account certain risk conditions of the
item and its structure to compute the grade. Risky conditions that merit attention and modification may include the
following:

- A child item at leaf node that has no approved manufacturers list (AML).
- A child item that has an unapproved manufacturer part number (MPN).

- A child item which is at a lower lifecycle than its immediate parent item or the structure's top-level item. For
example, a bicycle wheel might be at the Production phase of its lifecycle, while the bicycle itself is still in Pre-
production: because there are other subassemblies that aren't yet ready for Production, this is appropriate. You
wouldn't want the bicycle to have achieved Production phase while its wheel is still in Design. The grade rule
provides an alert on the bicycle's Details tile.

Default Rules

Grade computation can be configured to ignore or take into account any of the rules. You can select one to five of these
issues to be involved in item grading:

Lifecycle Mismatch
Unapproved MPN
Inactive Items

Unreleased Items
No AML

Standards for Grading

These are the default grading standards. The application doesn't count all the instances of violations; it counts an issue
or criteria as "1issue" no matter how many times the issue is violated:

- Anitem with O issues that has an Approved status is graded A.
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- Anitem with 1issue is graded B.

- Anitem with 2 issues is graded C.

- Anitem with 3 issues is graded D.

It can also be configured to use numeric grading, so that the number 5 corresponds with the letter grade "A", 4 with "B",

and so on.

Click an element on the Item Grade tab to discover what issues or conditions affect its grade.

Configure Action Links to Items from Reports

You can create action links (or deep links) to navigate from Oracle Transactional Business Intelligence (OTBI) reports to

specific items.

WN =

o

o

o

Navigate to the Product Development work area.
To create an analysis, click the Reports and Analytics side tab and click Browse Catalog.
To create a report about items and add fields:

In the Catalog page, from the New menu, click Analysis.
Select Product Management: Item Revision Real Time from the Select Subject Area menu.

From the Subject Areas panel, click Item > Main. Use the scroll bar to select Item Name, Item ID, and
Organization ID. Other columns of data are optional.

4. The Item ID and Organization ID don't' work with a decimal value. To set a non-decimal value for the item ID:

o

o

o

o

o

Click Inventory Item ID. From the menu, click Column Properties.
In the Column Properties dialog, click the Data Format tab.
Select the Override Default Data Format check box.

Set the value in Decimal Places to a non-decimal value. Click OK.
Similarly set the Organization ID to a non-decimal value.

5. To configure the name column as a URL that opens the selected object in another tab:

[e]

o

o

In Selected Columns, select the Item Name.

From the menu, click Column Properties. In the Column Properties dialog click the Interaction tab.
From the Primary Interaction menu, select Action Links and create a link format.

Click the + icon to add an action link.

From the New Action Link dialog, select Navigate to a Web Page.

In the Create New Action dialog, add the URL. This creates a web page and passes dynamic values to
load the selected object. The template of the dynamic URL is:

https://<hostname>/productLifecycleManagement/faces/deeplink?
objType=ITEMS&action=EDIT&objKey=itemld=<INVENTORY_ITEM_ID>&orgld=<ORGANIZATION_ID>

Note that:
- Object Type is ltem
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- Action is Edit
- Object Key is Item ID

6. To define parameters:
o Click Define Parameters. The value for the object key is dynamic and the object ID is retrieved from the
report data.
o Click the menu available in the Values column and the third row. Select Column Value and then select
Item ID.
o Click the menu available in the Values column and the fourth row. Select Column Value and then
Organization ID.
o To ensure that the URLs work automatically, select the Fixed and Hidden check boxes in all the rows.
7. Inthe Create New Action dialog, add the reference to Item ID in the URL field.
8. Click Options to open the Action Options window.
9. Select the Open in New Window check box and click OK. You return to the Create New Action window.
10. Click OK. You return to the New Action link window.
11. Click OK. In the Column Properties window, select the 'Do not display pop-up if only one addition link is
available at runtime check box. This helps when there are multiple links with different actions. Click OK.
12. Click Save Analysis.
13. Click the Results tab. Click a link in the search results and notice that the object opens in a new window.
Related Topics

» Configure Deep Links in Oracle Fusion Cloud Product Lifecycle Management

Generate Item Structure Report

You can generate and view the item structure report from both the Product Development and Product Information
Management work areas.

1.

Navigate to the Edit Item page of an item.

2. C(Click Generate Report from the Actions menu.

3.

0 03O U A

In the Item Structure Report dialog, select the fields which must appear in the report.
o Levels - Single or all levels of the structure
o Columns - Main, Main and AML, All
o Templates - Default Item Structure Report. You can also include templates you've configured.

If you're unable to view the Default Item Structure report template, ensure that you have the following
privilege: Generate Item Change Order Report (EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV)
o Format - Format of the file here by default is Microsoft Excel.

Click Submit.

Click OK to confirm the message which shows the Scheduled Process Request ID.

Navigate to View Scheduled Processes in the Tasks panel.

Enter the Process Name or Process ID and check the status of the report.

Click the output that appears in the View Output column.

Click the file name or URL in the Attachments dialog and you can view the columns and levels that you
selected.
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- The columns in the item structure report only display the attributes that you have configured in the template.

- You can generate the report only in Product Development or the Product Information Management work area
and not within Oracle Analytics Publisher; configuration of the template is done in Oracle Analytics Publisher.

Related Topics

« Configure the Template for the Item Structure Report with Additional Attributes

» Configure the Template for the Item Structure Report with the Main and AML Attribute

Considerations for Managing Flexfields in Items and

Change Orders

Item extensible flexfields and item revision extensible flexfields are handled differently in Product Information
Management and Product Development work areas.

Here's what you should keep in mind if you're managing flexfields in both work areas.

Flexfield Type

Item Extensible Flexfield

Item Revision Extensible Flexfield

Best Practices

Product Information Management

Available in items and change orders.

On selecting a revision, only the current
effective values appear.

Appears on the item page where it's configured.

Appears in the change line in the classic
Product Information Management work area,
but not in the Simplified Change Management
Interface.

Here are some best practices for managing flexfields:

Product Development

Available in items and change orders.

On selecting a revision, revision-specific values
appear.

Not supported.

Doesn't appear in the item view or change order
affected objects view.

- In Product Development, you can use item extensible flexfields to track different attribute values by revision
when specific data isn't explicitly tracked through change control.

« In Product Information Management, you can choose not to include item attributes in change control, but still
use item revision extended flexfields to track the difference in values between revisions.

ORACLE
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FAQs About Items and Documents

Why can't | search for items across work areas?

Sometimes you may be unable to search for items by the same criteria using the Manage Items task or unable to
navigate to Item Details page from search results in either Product Development or Product Information Management
work areas.

In this case, perform the Deploy Item Extensible Flexfields task in the Setup and Maintenance work area, using the
Refresh and Deploy Offline option.

Note: You should consult with Oracle Support before running this deployment option in other situations.

Related Topics
« Deploy Item Flexfields

How do | set the parameters used to calculate Item Grade?

Open the Tasks panel, click Manage Configurations. Select the Items tab, and make selections in the Grade and BOM
Grade sections.

What's the difference between the terms released and unreleased
in the My Favorite Items information tile?

It depends on the item lifecycle phase configured by your administrator.

For example, your administrator can configure the prototype lifecycle phase as unreleased, and the production lifecycle
phase as released. Depending on this configuration, the My Favorite Items information tile displays the number of
released and unreleased items.

Related Topics
- Configure Item, Document, and Change Management in Product Development

What's the difference between an item and a manufacturer part?

An item is produced or assembled by your company.

A manufacturer part is entirely produced by an outside manufacturer. It's identified by a manufacturer part number.
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How do | configure the display of operational attributes in the
Product Development work area?

Open the Tasks panel tab, click Manage Configurations. Select the Items tab, and make selections in the Item Attributes
Display Settings section.

Update UOM Values After Creating an Item

You can update the primary unit of measure of a new item request-enabled item, in the draft status.

If the item is a part of a structure, after you update the UOM, you must check and manually update items in any
impacted structures.

Note: The primary unit of measure won’t be editable for approved items on new item request classes and non-new
item request classes. For information about the checks performed when the primary UOM is updated, see Checks
Performed for Item Attribute Changes section.

How can | quickly edit the details of an item attachment?

On the item's Attachment side tab, click the Direct Edit icon.

How can | promote or demote an item's lifecycle phase?

To promote or demote the item lifecycle phase in Product Development, use a change order on an engineering item.
In Product Information Management, use the item page or a change order for a commercial item. On the item click
Actions > Change Lifecycle Phase.

Note: You can also change the lifecycle phase of an obsoleted item from update 23A onward.

Can | change the lifecycle phase on an obsoleted item?

You can change the lifecycle phase on an obsoleted item from update 23A onward. Here's how:

In the Product Development work area, assign the item to a change order. On the Affected Objects tab, use the New
Lifecycle Phase column.

In the Product Information Management work area, use the item page or a change order for a commercial item. On the
item click Actions > Change Lifecycle Phase.
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Will attachments | add in Product Development show up in
Product Information Management?

The attachment you add for an item Product Development is visible in Product Information Management only if the
Product Development item is in a lifecycle phase higher than design.

Note that the attachment appears as an item revision attachment in Product Information Management.
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5 Documents

Create and Edit Documents

You can create documents using the Product Management Search page for items. Here's how:

1. Click the Create Document button on the Product Management Search page for items.
In the Create Document drawer:
o Select a document class.
o Update the basic attributes.
o Select an item template.

Note that the Create Document option will appear based on the following configurations in the Manage
Configurations task (within the Product Development work area):
o The Enable Document Management option is selected.

o The Document Class Name field is configured to manage the root document class.

Also, you must enable the profile option Enable the Redwood page for View Document
(ORA_EGP_VIEW_DOCUMENT_REDWOOD_ENABLED).

Note: You can also create a document from the New document action in Quick Actions on the Product
Management landing page.

2. Click Create.

Here are some tabs that appear on a document:
- Attributes
- Attachments
« Structures
- Categories

Relationships

Note: When you create a new item of type document class in Redwood, the Ul displays only the Links table in the
Relationships tab.

Actions on Documents

You can use the Actions button on the document to:

- Assign the document to changes such as change orders, change requests, problem reports, and corrective
actions.

- Send notification using Send Object.
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- Navigate to the Spotlight and review the document structure.

Attributes

Here’'s what you can do on the attributes tab:

- Edit the main and additional attributes such as extensible flexfields.

- Update the Rich Text content in the Formatted Description field.

Attachments

Here’s what you can do on the attachments tab:

- Add or remove item attachments and item revision attachments on documents.
- Download the attachment files.

- Edit the attachment attributes such as Title and Description.

Structures

Here’s what you can do on the Structures tab:

- Update the structure and component attributes.
- Add and delete items or documents as a component to the structure.
- Add, delete, and update reference designators and substitutes.

-+ Create structures
o You must create a primary structure before adding components.
o You can create structures from existing ones, copy structures, and create alternate structures. You can

also use structure header descriptive flexfields, and structure header attachments on engineering items
early in the design process.

o Here’s how you create a structure on a document:
Open the document and navigate to the Structures tab.
Click the ellipses (three horizontal dots) icon and click Create Structure.

In the New item structure drawer, enter the structure details and click Apply.
After you create a structure, the following actions appear when you click the ellipses (three horizontal dots)
icon:
o Edit Structure (or Structure Details)
- Click Structure Details to open a drawer using which you can edit the structure.
- You can access structure header descriptive flexfields and attachments on documents.
o Add to Delete Group and Delete
- If you've saved the structure, you can’t delete it directly. You must click Add to Delete Group.
- If you haven't saved the structure, you can delete it using Delete.
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Categories

Here’s what you can do on the Categories tab:

- Add new product lines to the document.

- If you have used the 'Product lines' attribute in the classic interface, the same will be visible in the 'Categories'
tab in a Product Lines catalog.

I Note: You can add only Product lines as Categories for a Document.

Relationships

Here’s what you must know about the Relationships tab:

- The relationships you created on the document in the classic interface appear in the Links section on
Relationships tab.

- From a document you can create links to other documents, items, change orders, change requests, problem
reports, corrective actions, concepts, ideas, items, proposals, and quality actions.

- To create a link, select an object type. The objects corresponding to the organization in which document is
created are populated in the Name column. On selecting the object, the other fields are populated. To save your
changes click Apply and click Save.
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6 Quality Management in Items

Overview of Quality Issues and Actions

The Product Information Management and Product Development work areas integrate with the Quality Management
module to help you gain insight to quality issues and actions related to items.

A quality issue is a defect, deficiency, or a significant variation in a product's expected appearance or performance.
Feature for Product Development users.

Feature for Quality Management users.

A quality action is a necessary activity required to mitigate a quality issue and prevent its further occurrences.

Note: On opening an item in the Product Development work area, the Quality tab displays a blue icon, if the item has
quality-related data. And on hovering over the Quality tab, the tooltip displays Quality: Has Content.

The Quality tab displays both these tabs:
- Quality Issues and Quality Actions

Problem Reports and Corrective Actions.

Overview of Problem Reports and Corrective Actions

The Product Information Management and Product Development work areas integrate with the Quality Management
module to help you gain insight to problem reports and corrective actions related to items.

- A problem report is a generic quality incident or problem reported from a customer's perspective.
- A corrective action is an action that you take to address or prevent the problem from occurring again.

You can create problem reports and corrective actions for an item from Product Information Management, Product
Development and Quality Management work areas, and from Supplier Portal.

- On opening an item in the Product Development work area, the Quality tab displays a blue icon, if the item has
quality-related data. And on hovering over the Quality tab, the tool tip displays Quality: Has Content.

- The Quiality tab displays both these tabs:
o Quality Issues and Quality Actions

o Problem Reports and Corrective Actions

To use advanced workflow capabilities such as additional controls and group approvals, create and manage problem
reports and corrective actions just as you would change types in Product Development.
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This is particularly recommended for engineering design use cases where you capture issues related to items. You then
collaborate with suppliers through workflow steps for proper resolution.

These types of problem reports and corrective actions are structured more like change requests. They provide tabs
for General Information, Affected Objects, Tasks, Attachments, Workflow, Impact Analysis, Relationships, Security, and
History.

By configuring the workflow steps, you can:
- Specify automatic status promotion or demotion
- Define entry and exit criteria
- Control who can perform what action
- Perform impact analysis

- Create and assign tasks to track dependencies.

Create Problem Reports and Corrective Actions

You can create problem reports and corrective actions from the:

- Create (+) menu on the Overview page in the Quality management work area
- Actions menu of an item in the Product Development work area

- Actions menu of an item in the Product Information Management work area

You can see that they appear on the Quality tab of items in the Product Development, Product Information
Management, and Quality Management work areas. Remember that the Create Problem Report and Create Corrective
Action options appear on the Actions menu only after you create and save an item.

For suppliers the page reloads with the newly created object.

Note: The newly created problem reports and corrective actions automatically display organization data from the
item.

The workflow of a problem report or corrective action progresses as specified by the statuses defined by the
administrator. For more details, see Set Up Problem Reports and Corrective Actions.

Create 8D Corrective Action.
You can choose to create a corrective action from the following two options in the Type drop-down list:

- Corrective Action — action to mitigate a quality issue and prevent its further occurrence.

- 8D Corrective Actions — action that uses the 8D methodology. An investigative dive to find the cause of a
problem, a solution to fix it and a method to prevent recurrence.

The 8D methodology involves a systematic investigation into the root cause of a problem to prevent recurrence. It uses
a structured, preconfigured template based on 8 disciplines to define the problem, identify the root cause, and run the
corrective and preventative action (CAPA) to prevent recurrence.
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Here's a brief description of the eight disciplines:

1. Plan and form team: Create a plan to minimize or mitigate the problem and establish a team of skillful and
knowledgeable people

Define Problem: define and describe the problem

Interim Containment: define and implement containment actions

Determine Root Cause: identify the root cause

Verify Correction: verify and choose the most effective corrective action

Implement Corrective Actions: implement the corrective actions

Prevent Recurrence: implement actions to prevent a recurrence

Recognize Team Effort: acknowledge and congratulate the collective effort of the team.

NS AWN

Note: Although the change type 8D Corrective Actions is predefined, the attribute visibility setting is read-only. The
change type inherits the configuration from its parent change type, Corrective Action.

Create a Corrective Action from a Problem Report

You can also create a corrective action from the Actions menu of a problem report. The corrective action opensin a
dynamic tab for editing. For suppliers the page reloads with the newly created object.

While creating a corrective action from a problem report, you can select to copy over the descriptive flexfields,
attachments, relationships, and tasks for the problem report. You can also copy over the affected objects including
descriptive flexfields to the new corrective action. The corrective action is automatically linked to the problem report in
the Relationships tab.

Related Topics
» Overview of Change Type Setup

» Configure Change Orders
» Understand Change Types

Access Quality Objects from an Item Structure

This topic describes how you can navigate from an item to related quality objects.

Note that:

- Blue dot icons appear in the Quality column of components on an item’s structure table, to indicate the
presence of quality-related data. Data includes quality issues, actions, problem reports, and corrective actions.

- You can click the blue dot icon to navigate to the corresponding object in the side tab view without losing
context.

You can access and view quality issues and quality actions for all revisions of an item from the Quality tab. You can
access the quality objects from:

« Quality tab in Product Development and Product Information Management work areas.
Navigate to Item > Quality tab.

- Item structure component’s side panel in Product Development work area.
Navigate to Item > Structure. Select a component and click the Quality tab in the side panel.
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Redline item structure component’s side panel in Product Development and Product Information Management
work areas.

Navigate to a Change Order > Affected Object tab. Click the affected object that you want to view. Click the
Structure tab and select a component. Click the Quality tab in the side panel.

You can also perform the following actions from the Quality tab:
« Query by Example
Export to Excel
Detach the Table

Note: When doing QBE on Severity, enter only the text value, and not the numeric prefix. For example, if severity is "1
High', enter only 'High' in the QBE field.

Attributes that appear on the quality issues and quality actions table are similar to the ones that appear on the Manage
Quality page.

I Note: Users with the item privilege EGP_VIEW_ITEM_PRIV can view the Quality tab on the ltem Details page.

Secure Access to Quality Issues and Actions

This topic describes how security is supported in Oracle Quality Management. Use the Security side tab on issues and
actions to add users and roles who can view and search for issues or actions.

Security is applied at two levels:
Functional Security
Data Security

Functional Security

Functional security defines the functions you can perform and the pages and objects you can access. For example, it
defines who can

- enter the quality management work area
- create a quality action
- create a quality issue
The two types of privileges in Quality Management are:
Manage - lets you create and edit issues and actions
Review - provides a read-only view of the issues and actions.
Functional security in Quality Management is based on the following privileges:
Manage Quality Action - (ENQ_MANAGE_QUALITY_ACTION_PRIV)
Review Quiality Action - (ENQ_REVIEW_QUALITY_ACTION_PRIV)
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- Manage Quality Issue - (ENQ_MANAGE_QUALITY_ISSUE_PRIV)
- Review Quiality Issue -(ENQ_REVIEW_QUALITY_ISSUE_PRIV)

You can assign these privileges only to the user roles, and not directly to the user.

For example, assign John Smith with a quality analyst role (that contains the Manage Quality Action, Review Quality
Action, Manage Quiality Issue, Review Quality Issue privileges) to create and edit quality issues and actions. The two
privileges are assigned to specific task flows and menu actions.
While setting up functional security, consider:

- the privileges assigned and the user roles to which they're assigned

- the users, the functions they can perform, and the functionality and work areas they can access

Oracle delivers some users, user roles, and privileges which are ready to be used. The users and user roles can be
adapted and assigned respective privileges.

Data Security

Data security defines access to specific data (records) and is applied in addition to functional security. For example,
even though you can create and manage quality issues (functional security) as a user you may not see the quality issue
"ISSUE46", because the data record isn't visible for your user role (data security).

To enable Data security, you can:
- define data security grants for accessing the issue and action tables for specific user actions
- define data security grants for editing in the issue and action Security tab

- define which users and roles can access a specific issue or action by adding them to the Security tab of the
issue or action

- define which user can see which quality issues based on inventory organization assignment
- grant permissions to perform changes depending on the status of the object.

Data Security Grants on Tables

Data Security grants on the issue and action tables define each user role. All the users who need to see, update or
delete issues and actions, need to be assigned to a user role that grants them access to these data tables with the
corresponding user action.

You can grant overall access to the issue and action table, or access to specific user actions like Read or Update.

Note: Data security grants can't be defined for the creation of issues and actions, as the data doesn't yet exist. Hence,
creation can only be allowed or prevented through functional security.

Data Security Grants on Application Objects

Data security grants are essential to add and remove users and roles on the Security tab of issues and actions. Hence,
you require an additional data grant for application objects on the table FND_OBJECTS for issues and actions.

Data Security Grants Based on Users and Roles on Security Side Tab

The Security side tab for issues and actions makes previously public issues and actions private by assigning them to
specific users and roles.

After you add the first user and user role to the Security tab, only respective users and user roles (user assigned to these
user roles) have access to these issues and actions. In addition, the Creator and Assignee are automatically granted the
privilege to see the issues and actions.
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Permissions to Perform Changes Based on the Object Status

Depending on the type of data, you can restrict the user from editing the issue or action even if the appropriate
privileges and grants are available. For example, if the quality issue or action is:

- logged as Production Exception
- logged as Inspection Nonconformance
- in a state which prevents editing

You can't edit a record or its relationships; this is to prevent any inconsistencies between production exceptions that you
log in manufacturing and the respective quality issues.

You can't delete inspection nonconformances, but you can perform most editing operations.

You can't edit quality issues and actions if they're in certain states, such as waiting for approval, or after approval and
closure. This ensures that other quality users can rely on the fact that's issues and actions that they approve or have
approved, won't change.

Visibility of Quality Actions and Issues Based on Inventory Organization Assignment

You can assign a specific organization to a quality action or issue to identify where the issue or action has occurred.
Note that users who need to create or access quality issues or actions for an inventory organization must also be
assigned to that organization. You can do this using the Manage Data Access for Users task in the Setup and
Maintenance work area.

If you're using configured job roles to access quality objects, ensure that these job roles are assigned to the appropriate
data security policies in the Security Console, specifically Grant on Inventory Organization.

The following data security function must be entered for user-defined roles in the Security Console for the Quality
Actions Data privileges:

- Policy Name: Grant on Inventory Organization
- Database Resource: Inventory Organization
- Dataset: Select by Instance Set

- Condition Name: Access the inventory organization parameter for table INV_ORG_PARAMETERS for the
inventory organizations in which they can operate.

- Actions: Manage Quality Organization
Access to Affected and Related Objects

You can add items, manufacturing work order operations, manufacturing resources as affected objects to quality issues
and actions. Relate Oracle Innovation Management and Product Development objects like ideas, requirements and
change orders to the quality issue and action.

Functional and data securities govern quality issues and actions. So, even though you can view a related idea or an
affected item, you can't open it unless you've the appropriate privileges.

For example, to open and see the details of an affected item, you not only are required to have functional privileges to
view and manage the item but also have data security grants to the inventory organization.

User and Role Data Security

The security side tab on issues and actions enables you to add users and roles who can view and find this issue or
action.
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The creator and assignees can automatically access the issue or action. Users not listed on the security tab can't find or
view the issue or action.

Related Topics
 Restrict Available Objects Through Configured Roles
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7 Manufacturers and Manufacturer Parts

Overview of Manufacturers

An Approved Manufacturers List (AML) represents a list of manufacturers, suppliers, or vendors approved by a
company for the purpose of procuring manufactured items. You can add manufacturers to the AML tab on an item.

The AML tab on an item captures information about the manufacturers and manufacturer parts associated with the
item.

In the Product Development work area, you can do the following:
- Create manufacturer parts.
- Create the manufacturers and associate them with manufacturer parts.
- Secure access to manufacturer parts.
- Assign the manufacturer parts to the items.

For more information on creating a manufacturer and manufacturer part, see the related topics.

Related Topics
« Create a Manufacturer

Create a Manufacturer

You can create a manufacturer from the Product Development work area.

To create a manufacturer from the Product Development work area:

1. From the Tasks panel drawer, click Create Manufacturer.

2. Inthe Create Manufacturer dialog box, enter the manufacturer name and provide a brief description. Click
Save and Close.

3. Enter any additional information, if required. Click Save and Close.

Create Manufacturer

You can create a manufacturer from the Product Management Search page for Manufacturers.
Additionally, you can use generative Al to generate and fill in the following profile details for manufacturers:

Description
- Global Revenue
Headcount Details
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Website
Classification
Industry
Channels
Brands

Products

To use generative Al, you must opt in to the feature: Use Generative Al to Populate Manufacturer Profile Attributes.

Here’s how you create the manufacturer:

1.
2.

On the Tasks panel tab, click Search Product Management.
Select Manufacturer from the Product Management Search drop-down list.

The New Manufacturer drawer appears.
Enter the manufacturer details and click Create.

Separate tabs are available for Company Profile Attributes, Location, and Additional Attributes.

Note:

o The Additional Attributes tab displays only required extensible flexfields and is hidden if none
are required.

o Use business rules to hide one or more of the following tabs: Company Profile Attributes,
Location, and Additional Attributes.

If you're using generative Al, enter the manufacturer name and click Al Assist to fill in the profile details. Here
are some points on generative Al:

o The manufacturer name is required to generate the profile details using Al Assist.
o You can use the Al Assist feature multiple times if required for the same manufacturer name, to get the
best desirable response from Al.

o The Company Profile Attributes and the Country Attribute within Location can be auto-populated using
Al Assist feature.

- When you manually enter values in the company profile attributes while editing a manufacturer

and then click Al Assist, your existing values will be replaced with Al-generated values. But you can
still revert to the previous values by clicking Cancel.

4. Save your changes.
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Note:
- After creating the manufacturer, you can select an attachment and view it directly in a viewer without
downloading it.

- You can add attachments details and preview them in the side panel. If there are multiple attachments, use the
arrows to view each of them.

- The Favorites and Recent Items links to manufacturers will launch the manufacturer page in the Product
Development work area.

- You can create an image category for manufacturer objects to categorize image files added to them.

Related Topics
« Set up Manufacturers and Manufacturer Parts

Create a Manufacturer Part

In the Product Development work area, you can create a manufacturer part, and then assign the part to an item.

1. Create a manufacturer part using the following steps:

o From the Tasks panel drawer, click Create Manufacturer Part.
o Inthe Create Manufacturer Part dialog box, select the corresponding manufacturer or search for it.
o Enter a manufacturer part number and provide a brief description.

o Select whether you want to activate the manufacturer part, retain it as inactive, or pending. Click Save
and Close.

o Enter any additional information. Click Save and Close.

2. Assign the manufacturer part to an item, using the following steps:

o Open the item in which you want to assign the manufacturer part. Click the Structure AML tab.

o Select the row of the item to which you want to assign the manufacturer part.

o Inthe side tab, click AML, and click Actions > Select and Add.

o Inthe Add AML dialog box, select the manufacturer and the part number.

o Select whether the part is preferred or alternate. You can assign multiple manufacturer parts to an item.
o Click OK and click Save.

The new manufacturer part is assigned to the selected item.
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You can also create manufacturers and manufacturer parts from:

- The AML tab of the item
- The AML tab in the change order
Manufacturer parts can be associated with an item in a structure. The same manufacturer part can be added to multiple

items in a structure. To locate where it's assigned across all items and structures, use the Where Used side tab on the
manufacturer part.

Create Manufacturer Part

You can create a manufacturer part from the new user interface.

You can create or edit a Manufacturer Part from the following locations:
Manufacturer MPN tab
Product Management Landing Page

Create a Manufacturer Part from Manufacturer MPN Tab

Here’s how you create a new manufacturer part from the Manufacturer MPN tab:

1. Inthe Product Management Landing page, search and select the manufacturer.

2. Inthe MPN tab of the manufacturer, click Add.

3. Inthe New Manufacturer Part side panel that opens, enter the details of the new manufacturer part.
4. Click Create.

A new manufacturer part is created.

Note: When you create a new manufacturer part from the MPN tab, the Trading Partner Type and Manufacturer are
defaulted to Manufacturer and Manufacturer Name respectively. Both of these attributes are read-only and can't be
changed.

Create a Manufacturer Part from Product Management Landing Page
Here’s how you create a new manufacturer part from the Product Management Landing page:

1. In the Product Management page, click Actions, and search for New Manufacturer Part.
2. Inthe New Manufacturer Part window that opens, enter the details of the new manufacturer part.
3. Click Create.

A new manufacturer part is created.

Search for Manufacturers

Find manufacturers and manufacturer parts with simple or advanced searches.
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Use the Add Fields button on the Manage Manufacturers page to include attributes such as D-U-N-S number, Country,
State, City, and so on, in the search criteria. These attributes appear as columns in the search results table.

Use the Create Saved Search dialog box to include the attributes such as D-U-N-S number of the manufacturers in the
Saved Searches list of the Manage Manufacturers page. Save the search with this additional criteria so that it's available
in the Saved Searches list for reuse.

Search for Manufacturer

You can search for manufacturers using the new interface. Here's how:

1. On the Tasks panel tab, click Search Products.

2. Select Manufacturer from the Product Management Search drop-down list.

3. Onthe Product Management Search Manufacturer page, enter the search criteria for manufacturers and select
a view.

The availability of manufacturers in the search results can be managed through access control lists.
To view the details of a manufacturer, click the Manufacturer link in the search results. Here are the tabs that appear on
a manufacturer:
Details
Location
Manufacturer Part Number (MPN)
- Attachments

Related Topics
« Overview of Access Control Lists

Search for a Manufacturer Part

Here's how you search for the manufacturer part:

1. Search for the manufacturer on the Product Management Search page.
2. Navigate to the MPN tab in the Manufacturer page.

All the manufacturer parts of the selected manufacturer are listed.

Edit a Manufacturer Part

Here's how you can edit a manufacturer part

1. In the MPN tab of the manufacturer page, click the hyperlink in the Manufacturer Part Number column to edit
an existing manufacturer part.
2. Inthe side panel drawer, edit the descriptive flexfields and add attachments to the manufacturer part.
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I Note: You can download the manufacturer part attachments from the panel drawer.

Access to Clipboard and Recently Visited

You can add manufacturers to the clipboard only if you have the view or manage permissions to those manufacturers
using an access control list. From the clipboard, you can navigate to the various tabs of a manufacturer as per the
permissions defined in the manufacturer access control list.

View the manufacturers in the recently visited section if you've the view or manage permission on the manufacturer.

Related Topics
« Access Control Lists for Manufacturers

Where Used

Use the Where Used side tab on the Manufacturer page to locate where the manufacturer part is used across all
items and structures. Additionally, use the Export to Excel option in the Where Used side tab to share and analyze
manufacturer data such as manufacturer part number, description, status, created by, creation date, last updated by,
and updated date.

Considerations for Managing AML

If you're using both Product Development and Product Information Management, here are some considerations for
managing AML:

- After you create an item and define its AML in Product Development, it will be visible on the item in Product
Information Management only when the item is in a higher lifecycle status than Design, such as Prototype or
Production. To make changes to the item AML after the item is in production, you must create a change order.

- For commercialization or item master use cases, always use the Trading Partner Item Relationships feature
directly in Product Information Management. This relationship enables you to track the manufacturer part
number for an internal item in the same way as the AML.

- You can't control Trading Partner Item Relationships using change orders, or use predefined fields to track
preference and approval status of manufacturer parts.

+ You can delete an AML through import using the Delete transaction type in the change order context.

- You can also add an item to a change order using the import batch option and specify an end date for the AML.

Note: The deletion of AML is recorded in the redline summary.
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Secure Access to Manufacturers

Use the manufacturer-specific privileges to securely access the manufacturer data. These privileges provide granular
access control to manage manufacturer data.

Here are the privileges required to secure access to manufacturers:
- Create Manufacturer: You can only create manufacturers with this privilege.
o Create Manufacturer (EGP_CREATE_MANUFACTURER_PRIV)

Users who are assigned the Create Manufacturer privilege should also be given the Manage
Manufacturer privilege (EGP_MANAGE_MANUFACTURER_PRIV)
- View Manufacturers: You can view all the manufacturers with this privilege.
o View Manufacturer (EGP_VIEW_MANUFACTURER_PRIV)
Manage Manufacturers: You can view and edit the manufacturers.
o Manage Manufacturer (EGP_MANAGE_MANUFACTURER_PRIV)
o View Feature States Value by Web Service (RCS_VIEW_FEATURE_STATES_WEB_SERVICE_PRIV)

Secure Access to Manufacturer Parts

Use the Security tab on the manufacturers and the manufacturer parts to secure access to manufacturer parts. You can
add the users and roles (groups) who should have access to manufacturer parts.

Note: You can access the Security tab only if your role has these policies assigned to it:
EGP_TRADING_PARTNER_ITEMS

EGP_PRIVATE_TRADING_PARTNERS

Secure Access to All Manufacturer Parts Created for a Manufacturer

Here's how you secure access to all the manufacturer parts created for the manufacturer.

1. Click the Security tab on the manufacturer.

Deselect the Public check box.

Click Create to configure a person or a group to access manufacturer parts.

Select whether you want to grant access to a person or a group, and select the name of the person or the group.
Select the privileges you want to provide:

vh N

o View: allow users to view the manufacturer part.
o Maintain: allow users to edit the manufacturer part.

o Administer: allow creating new manufacturer parts for the manufacturer.
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To allow more persons or groups to access manufacturer parts, repeat the previous steps.
6. Save your changes.
The security is inherited by all manufacturer parts created from the manufacturer.

I Note: To revoke access to a person or group, select the person or group and click the Delete button.

Secure Access to Individual Manufacturer Parts

Prerequisite: You must enable security on the trading partner item using Manage Trading Partner Items > Edit
Trading Partner, in the Product Information Management work area. This will allow you to view the Security tab on the
manufacturer part (in the Product Development work area).

Here's how you secure access to an individual manufacturer part.

Click the Security tab on the manufacturer part.
Click Create.
Select whether you want to grant access to a person or a group, and select the name of the person or the group.
Select the privilege you want to provide:
o View: allow users to view the manufacturer part.

PUWNA

o Maintain: allow users to edit the manufacturer part.

Note:
o A check box appears in the Inherited column if the grant is inherited from the manufacturer.

o The Security tab isn't displayed on the supplier portal.

Additional Considerations

- The Security tab on the manufacturer page shows updates made to the Public setting and data grants
on the trading partner in the Product Information Management work area. Likewise, such updates to the
manufacturer made in Product Development are replicated on the trading partner page in the Product
Information Management work area.

Manufacturer parts inherit the grants added to the parent manufacturer, but the security tab isn't displayed on
the manufacturer part. Edit the trading partner item to see these inherited grants and add additional singular
grants in the Product Information Management work area. These individual grants apply to the manufacturer
part and item AML.

Related Topics
- Data Security for Manufacturers and Manufacturer Parts

Create Manufacturer Part Using Save As

You can use the Save As feature to create a new manufacturer part from the Actions menu on the Manufacturer Part
page.
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Here's what you can copy over from an existing manufacturer part:

- Attachments

- Additional Information such as descriptive flexfields

-+ Security Settings

- You must have the Manage Manufacturer Part privilege to use the Save As feature; if you don't, the Save As
option is grayed out.

- If the source manufacturer part is private, then you must have a Maintain grant privilege to use the Save As
feature.

Created From

You can track which manufacturer part was used to create a new part using the Created From field on the General
Information page. This field displays a link to the source manufacturer part from which the current manufacturer part
was created. You can click this link to navigate to the original part and view the details.

- The Created From field displays the source manufacturer part name.

- In the Save As dialog box, if you change the manufacturer from the source manufacturer, the Save As dialog
box displays the grayed out Security check box. The manufacturer part instance grants aren’t copied to the new
manufacturer part.

Note: The Supplier Portal doesn’t provide the Save As option or display the Created From field on manufacturer
parts.

Create OTBI Reports for Manufacturers and ltems

You can create reports in Oracle Transactional Business Intelligence (OTBI) for manufacturers, and manufacturer parts
along with items.

You can also analyze manufacturers by various criteria such as:
- configured attributes
- location attributes such as Country, State, and City and

- manufacturers without associated manufacturer part numbers.

Related Topics
« Use Reports and Analytics
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FAQs About Approved Manufacturers List

How can | search for manufacturer parts based on specific
attributes?

From the Tasks side tab, select Manage Manufacturer Parts.
On the Manage Manufacturer Parts page, you configure the criteria to search for manufacturer parts.

Click Add Fields to add more attributes to the search criteria. The attributes appear depending on the descriptive
flexfields configured by the administrator.

Why can't | add a manufacturer part to an item?

The item might be assigned to a change order with a pending revision.

Will the approved manufacturers list (AML) | add in Product
Development show up in Product Information Management?

The AML you add for an item in Product Development is visible in Product Information Management only if the Product
Development item is in a lifecycle phase higher than design.

What's the difference between manufacturers and trading
partners?

The Product Development work area uses manufacturers and manufacturer parts.

The Product Information Management work area uses trading partners and trading partner items.
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8 Structures

Overview of Structures

In Oracle Product Development, a Bill of Materials is called a structure.

When you add an item to a parent item, you create a simple structure. As items are added, the structure is always
named and referred to by its top-level item.

A structure holds all the items and documents that make up an assembly or subassembly. ltems and documents might
be in the same structure; there's no restriction on the maximum or minimum number of either type of business object.

Any item on a structure might be associated with one or more manufacturer parts. On the Structure table, an icon
next to an item indicates the presence of manufacturer parts. So, a structure populated with items will likely comprise
associated manufacturer parts.

A document structure holds all the documents that make up a meaningful document, such as a specification for a
product. When you add a document to a parent document, a simple structure is created. A structure of documents will
be named and referred to by its top-level document. A document structure might be only one document.

Create Structures

You can create a structure by either selecting and adding existing items, or creating new items. Use the Actions and
View menu on an item to create and modify the structure.

Here's how you create a structure:

1. Open the item and navigate to the Structure tab.
2. To add a new item in the structure, click Actions > Create.
3. To add existing items to the structure, click Actions > Select and Add.

- You can’t add a parent component to a child component. This applies to both preliminary structures and
affected item structures on engineering and commercialization change orders.

- You can add duplicate components to a structure using Find Number that enables you to differentiate between
multiple instances of a component within a structure.

Create an Item and Build an ltem Structure

This topic covers how to create an item and build an item structure. A structure contains information on the parent item,
components, and descriptive elements.

1. Inthe Product Development work area, create an item using the following steps:
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o

From the Tasks panel tab, click Create Item.
In the Create Item dialog, select the class in which you want to create items.

Note:
- You can only select an item class for which you've been assigned privileges.

- When you create an item in a child item class, the attribute values are applied only
from the default template for the child class and not from the item class hierarchy.

Enter a name for the item and provide a brief description.

The name and description can be generated automatically by configuring the item class.
Select the primary unit of measure for the item.

Enter the value for item attributes.

Attributes and their values appear only if they're configured for the item class. You can use the
predefined values or modify them.

Click Save and Close.

2. To copy existing items that you want to use for building the item structure, do the following:

From the Tasks panel tab, click Manage Items.
Enter a criteria to search for existing items and click Search.

In the search results page, select the items you want to add to the item you created. Note that you can
use the control key to select multiple items.

Click Copy and click Done.

The items are copied to the clipboard.

3. To build the item structure using the items you copied, do the following:

o

o

o

In the item that you created, click the Structure tab.

Since you can no longer copy and paste directly from the source location to the target location, you must
first copy the items to the clipboard.

Select the items from the clipboard and click the Paste icon. The items are pasted to the structure.
Click Save.

4. To create a new item and add it to the structure, do the following:

o

o

[e]

o

In the item that you created, click the Structure tab.

Click the Create icon.

In the Item Create dialog box, enter the details of the new item.
Click Save and Close.

5. To add an existing item to the structure, do the following:

o

o

[e]

In the item that you created, click the Structure tab.
From the Actions menu, click Select and Add.
Enter the criteria to search for the existing item and click Add.
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o Inthe Select and Add dialog box, select the item.
o Click Apply and Close.

Structure Details

View and Edit Structure Details

To view the structure component details in a side panel, select a component row on the structure tab of the item.

You can enter the following component details from the side panel: reference designator, additional information,
attachments, AML, additional attributes, and substitute components.

The header of the side panel shows the name of the selected component. You can move from one component row to
another, and use the side panel to navigate easily between the component details.

Note:
« You can edit a component from the item structure page, if it's not assigned to any change order.

- When you perform a Save As from the Actions menu of a structure having substitute components, the
substitute components are copied over to the new item structure.

- You can edit reference designators using the side panel, if your administrator has set the Reference
Designator Range Indicator to None. Otherwise, you can edit them directly in the structure table.

- If you have added a component to a common structure associated with one or more organizations, and one
of those organizations became inactive, the assignment to the inactive organization is skipped, and this
information is recorded in the log file.

Icons on Component Rows

The pencil icon in a column indicates that there's additional information that you can view. You can click the icon to
navigate to the corresponding tab in the side panel view.

The following icons appear only if you've opted in for the feature User Interface Improvements for ltems and Changes.

- Ablue dot icon in any of the following columns of a component row - attachments, AML, substitute
components, pending changes, and quality - indicates the presence of content. Click the dot icon to navigate to
the corresponding tab in the side panel view.

- For quality-related data, the blue dot appears if there’s at least one quality issue, quality action, problem report,
or corrective action in any workflow status against any item revision. If no issues or actions appear against the
item you've chosen, select other revisions and see which ones have issues or actions logged against them. With
problem reports and actions, you can see them across all revisions of the item.

7
ORACLE



Oracle Fusion Cloud SCM Chapter 8
Using Product Development Structures

- Inthe redline view of the affected item’s structure, the reference designator, and substitute component icons
appear in blue when there are redlines.

Note: The structure component attachments, AML, additional attributes, pending changes, and quality tabs on the
side panel appear in the read-only mode on engineering change orders.

In the following image, you can see the blue dot icon in the Changes column indicating the presence
of content in it. You can click the blue dot to open the Changes side tab for the selected component.
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Points to Consider

- The affected item's structure tab on a commercialization change order doesn't include side panel tabs for
attachments, or AML. It also doesn’t have the blue dot icons for Pending Changes or Quality related data.

- Pending Changes and Quiality side panel tabs aren't displayed in the Supplier Portal.

Find Number

You can differentiate duplicate components in an assembly using the Find Number attribute.

The find number identifies a specific instance of an item in a structure. When a duplicate component is added, the
application will automatically increment the find number, but you can modify it before you save your changes. Once the
item is saved, here’s how you can change the find number:

Delete the component and add it again with the new find number.
Or
Use the Replace action to replace a component with the same component and provide a different find number.

Example: Consider that a server containing 4 similar processors is positioned at the same level in the structure. Each
instance of the processor will have a unique find number. This will allow you to have duplicate instances at the same
level in the BOM and differentiate each instance.

Here are some additional details:

- You'll be prevented from creating duplicate find numbers for Model and Option Classes. The Find Number
column will be displayed and defaulted to 1. Also, you can't add the duplicate component row.
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- You can't create overlapping effectivity dates for the combination of component and find number.

You must ensure that the date range of the duplicate component is outside the date range of the initial
component. Note that the date range is calculated based on the start and end dates of the component.

- Attributes such as Quantity, Basis Type, and Supply Type can have a different value in the duplicate row.
Similarly, structure entities such as substitute components and reference designators can also have a different
value in the duplicate row.

Find Numbers are automatically incremented when you add duplicate components in the user interface, but not
when you update structures using REST services or import.

In the item structure import, if the find number value isn’t provided, it will be defaulted to 1. If you have a
duplicate instance of the component in your structure, you must provide a unique find number value in import.
In the absence of the unique find number, the import will create a single component with the find number value
defaulted to 1and the other components won't be created. This is applicable for REST APIs and SOAP Services
as well.

If you perform a Replace action to update the New Find Number value using import, it's recommended not to
import changes to other attributes in the same import batch.

Here are the best practices and recommendations:

- All existing and new customers should use Item Sequence for sequencing the structure. It's recommended not
to use Find Number for sequencing of the structure. Find number should only be used to include duplicate
components in a structure.

- Agile PLM customers migrating to Oracle Fusion Cloud should map Agile PLM Find Number to Item Sequence.
- CAD integration customers should map Agile PLM Find Number to Item Sequence.

- Agile PLM MCAD customers using the find number feature must map Find Number to structure component
descriptive flexfields.

Suggested Operation Sequence

You can use the Suggested Operation Sequence column to record a design engineer's suggestion for the operation
sequence of components in a manufacturing work definition. This doesn't have a default value and isn’t automatically
incremented.

Note: Suggested operation sequence isn’t a required value.

Example: In an assembly that includes 3 components, you can suggest an operation sequence for component A as 1,
component B as 2, and component C as 3. The manufacturing team can refer to this to specify a sequence for assembly
of components (in the manufacturing work definition).

Related Topics
« Can | modify the find number when the item is on a change order?

Key Actions and Features on a Structure Page

Here are some of the key actions and features available on the toolbar or the Actions menu on a structure.

Fill Up (Ctrl+U), or Fill Down (Ctrl+D), and Fill Selected (Ctrl+S): you can quickly fill in attributes when you've
added new items (this is also available when modifying a change order).

o FillUp (Ctrl+U) and
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o Fill Down (Ctrl+D) are available when you've selected a consecutive range of rows. Remember that
you've to select the table cell and modify the value in the cell for Fill Down and Fill Up to work.

o Fill Selected (Ctrl+S) is available when you have used Control-click to select nonconsecutive rows.
Note that the Effectivity Date attribute isn't automatically populated.

- Search: Enter the criteria to search for components within the structure. The application performs a search
based on the component name and description.

- Quantity Related: Select this to validate whether the item structure quantity matches the reference designator
count. A message appears in case of quantity mismatch. This is enabled by default in Product Development
structures. This action is also available on the reference designator dialog box.

- Align Quantity: Select this to automatically update item quantity to match the reference designators count.
This action is also available on the reference designator dialog box.

- Set Quantity Related to No: Select this to disable the Quantity Related setting that creates a dependency
between component quantity and the number of reference designators. If the Quantity Related field is set
to No, the application allows a mismatch between the component quantity and the number of reference
designators entered for the selected component.

- Set Quantity Related Field to Yes: Select this to enable the Quantity Related setting that creates a dependency
between component quantity and the number of reference designators. If the Quantity Related field is set
to Yes, the application checks whether the specified component quantity matches the number of reference
designators entered for the selected component and displays a warning if there’s a mismatch.

- Freeze: This is useful when you want to work with a large amount of component data spread across multiple
columns in the item structure. To freeze a column, select the column and click Freeze. Scroll through the
columns keeping the frozen column in context. For example, you can keep the item name column frozen and
scroll to view all its additional attributes.

Replace a Component

You can replace a component in your item structure, copying over key data from the original component to the
replacement component.

You can replace a component from:

- anitem structure page in the Product Information Management work area

- achange order’s Affected Objects Structure tab in the Product Development work area

How You Replace a Component
1. Depending on your work area, here’s how you select the component you want to replace.

In Product Development,
o Open the change order that contains the component you want to replace.

o Click the Affected Objects tab and select the component you want to replace.

In Product Information Management,

o Open the item that contains the component you want to replace.
o Click the Structures tab and select the component you want to replace.

2. C(lick Actions > Replace. You can also use the Replace icon on the toolbar.
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3. Search for and select the replacement component.

The original component is redlined and the replacement component appears in green (which is different from
the initial color). The original component also appears in the Replaces column for your reference.

End date of the original component becomes the start date of the replacement component.
4. Save your changes.

In the Product Information Management work area, you can save your changes to the item or save the changes
to a change order and route it for approval.

How Start and End Dates are Derived
The table lists how the start and end dates are derived upon replacement.

In Product Development In Product Information Management

Upon replacement, the end date of the

original component and the start date of

the replacement component will be the

same as the effective date of the affected

object. Upon replacement, the end date of the original component and the start date of the replacement
component will match the date in the Date field on the toolbar of the item structure page.

If the affected object is effective on

approval, this will be the date when the If a replacement is to be effective only in the future, select a future date in the toolbar and then perform
change order is moved to Scheduled the Replace action. The replacement is visible in the structure when the date selected is after the start
status. date of the replacement component.

If the affected object has a future effective
date, this will be the same as the effective
date.

What's Copied Over to the Replacement Component

When you replace a component, item sequence, structure component attributes, substitutes, and reference designators
are copied over from the original component to the replacement component.

Here are the attributes that are copied over:

Component Attributes

- Item Sequence - Read-only
- Quantity

- Yield

- Comments

- Start Date

- End Date

- Planning Percent

« Check ATP

- Required to Ship

- Required for Revenue
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Include on Shipping Documents
Automatically Request Material
Basis

Enforce Integer Requirement
Supply Type

Component UOM

Substitute Components

Item

Description

Primary UOM

Quantity

Inverse Quantity

Priority

Enforce Integer Requirement

Descriptive flexfields

Reference Designator

Reference Designator
Description

Descriptive flexfields

Considerations for Replacing Components
The table shows considerations for replacing components based on the work area.

In Product Development

- You can't replace a component that's
already a replacement for another
component in the same change order.

- You can use the Undo Redlines action
to revert the replacement action when
the change order is in Open or Interim
Approval status, provided you have the
permission to perform the action. This
permission is defined in the Additional
Workflow Controls table in the change
type setup.

- If you're replacing an item with a
document, then the reference designators
aren't copied to the replacement.

- The replacement attributes are displayed

In Product Information Management

Once a replacement is selected, neither
the original nor the replacement
component can be edited.

The Replaces column is visible by
default and retains the record of replaced
components even when you enter future
dates in the Date field. The original
component is shown in the Replaces
column until it's replaced with another
component.

Across Product Development and Product
Information Management

If a component has redlines, for example,
the quantity is updated, the component
can'’t be replaced.

If the replacement component selected
has a different UOM from the original
component, a warning message appears
and the quantity is reset to 1. Reference
designators and substitute components
aren’t copied over. The replacement
component's UOM will show the item’s
primary UOM.

If the replacement component was
defined as a substitute component of the
original component, then it isn't copied
to the substitute component table of the
replacement component.

in the Change Order Details report.
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Related Topics
 Items and Documents in Product Development

« Define a Change Order
- View and Edit Change Details

Track Replacements

You can generate the Change Order Details report to track replacements made to structure components using the
change order. Here are some points on the report:

- Replacement attributes can't be hidden.

- The Replaces column appears in the Structure Changes table showing the original component that was
replaced.

- The Change Action column shows the replacement component as Added and original component as
Disabled.

- Copied reference designators and substitute components are shown against the row marked Added.

- Change Action and Replaces attributes are shown in the Pending Component section.

Add Reference Designators on ltems
Reference designators commonly serve as a labeling system to refer to components.

If your administrator has configured reference designators for adding them inline with item components, here's how
you add them:

1. Navigate to the Structure tab on the item and select a component in which you want to add reference
designators.

2. Inthe Reference Designator column, click the expansion button '...'
3. Inthe Reference Designator dialog box, enter the range for designator values.

For example, if your administrator has selected '+' as a range indicator, you can enter 'A1+ A5' and the
application will expand the range to create five reference designators: A1, A2, A3, A4, and A5. The expanded
range appears in the side panel once you save your changes.

Additional options in the Reference Designator dialog box:

o Quantity Related: To validate whether the item structure quantity matches the reference designator
count, select this option. A message appears in case of quantity mismatch. This is enabled by default in
Product Development structures.

o Align Quantity: If the structure item quantity doesn't match the count of reference designators, select
this option and click OK. This would allow automatic update of item quantity, to match the reference
designators count.

Note: You can also access Quantity Related and Align Quantity functions from the toolbar of the Structure
tab, and the Actions menu. To modify the details of reference designator, you can use the Reference
Designator dialog box or the Reference Designator column.
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4. Click Save.
To view and modify descriptive flexfields, you can use the side panel.

Note: Modified reference designators appear in italicized red colour after you save your changes.

Related Topics
- Items and Documents in Product Development
« Define a Change Order

- View and Edit Change Details

Delete a Component
When you delete a component, here's how the side panel displays details:

If you delete a component row, the side panel automatically displays details about the next component.
If all components are deleted, the parent component detail is displayed.

- When you select multiple components and delete them, the side panel displays details based on the
component you select first. For example, if you first select the component named Component_2, then the side
panel displays information about the next component named Component_3.

Note: You can’t delete a component if the structure is created in the Product Information Management work area.
If you want to delete the component from the structure, you must do it from the work area where the structure was
created.

Manage Substitute Components
You can add and update substitute components for items, from the contextual side panel on the item structure tab.

Here's how:

1. Launch the item from the Affected Objects tab on a change order.

2. C(lick the Structure tab on the item.

3. Select the component for which you want to add the substitute.

4. Inthe side panel, select the Substitute Components tab to add the substitute.

Here are some details on managing substitutes:

- Only the structures of preliminary items (items that have never been released before) can be updated. Similarly,
only substitute components in preliminary stage can be updated. Once released, components and substitutes
can be updated only through an engineering change order.

- The lifecycle phase of the substitute should be the same or higher than the component. You can add a

substitute component belonging to a lower lifecycle to an item, only when a released item with a higher lifecycle
phase than design is allowed to be added to a preliminary item by disabling lifecycle validation.

Note: To disable lifecycle validation deselect the Enable Lifecycle Validation check box in the Item Structure
Type Details task. To access the task, in the Setup and Maintenance work area select Product Management
offering > Functional Area: Structures > Item Structure Type Details.

If you have a parent item which is preliminary, you can add components that are released or preliminary. In both
these cases, you can add substitutes. You can also add substitutes to a sub-assembly.

- You can't add a parent item as a substitute.
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- When you add a substitute in the side panel, the quantity is defaulted to the original component value and can
be edited.

- Once released to a pre-production lifecycle, only the additional attributes (descriptive flexfields) can be updated
in the Product Information Management work area.

- You can identify where an item is used as a substitute by using the where used query on the item structure
page.

Related Topics
« View Item and Document Details

View Structures

You can create an item from the Product Management work area and build a structure or search for a structure and view
the structure details with the component details appearing in the side drawer.

When you search for structures, you can view structure presence indicators (structure icon) that lets you access the item
structure from the search results. You can create a structure by either selecting and adding existing items or creating
new items. Here's how you access items.

Navigate to the Product Management work area and do one of the following:

1. Click Items from Actions on the Product Management Home Page
2. Select Items from the Product Management Search drop-down list on the Product Management Search Page.

When you navigate to an item and the structure tab within the Redwood page, you can create a new structure, modify
the header structure, and delete an existing structure. After you create the header, you can build and modify the single-
level structure by adding one or more components using the search and select icon in the toolbar.

Structure Details

Here's how you access and create a structure:

1. Open the item and navigate to the Structure tab.
2. Click the ellipses (...) button and click Create Structure.
3. Inthe New item structure drawer that appears, select any one of the options:
o Create new - using the Create new option, you can add Structure Name, Structure Description and the
required details in Additional details field and click Apply.
o Create from existing - using the Create from existing option, you can either choose an existing structure
or a new structure and fill in the required details and click Apply.
o Create from common - using the Create from common option, you can either choose an existing
structure or a new structure and fill in the required details and click Apply.

Note: You can’t add a parent component to a child component. This applies to both preliminary structures and
affected item structures on engineering and commercialization change orders.

You can create items directly within the structure. When building your item structure, you can create new items or
documents and add them as a component directly. It then becomes a part of the item structure, and you can edit or
modify the component level attributes.

I Note: Creating a new component is only supported for the single level structure.
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You can drag and drop (select and move) items from the clipboard or spotlight in the navigator to create a structure.
After you add the components, double-click the cell to modify the component level attributes and the component
descriptive flexfields. You can use additional indicators to explore subassembilies.

When you select the component, you can:
- Refine your search using filter chips
- Multiselect the item components to add

- Search and select the components to add to a structure and perform a search for another component. You can
also select a saved search.

o The count in the Add button shows you the number of components that you're adding. Click the Show
Selected button to see the selected components.

Note: To save your search, you must first perform your search, apply the filters, then save your search as personal or
system search.

After you add the components, you can modify the following:
- Component level attributes
- Component descriptive flexfields
- Reference designators

- Substitute components

Use Filter columns to narrow down the components that require review. The column filter icon appears when you hover
over the column header.

Views in Structures

On navigating to the structure, you can choose to view the entire structure or focus on specific levels. The views that
you can explore are:

- Single level: displays the single level view of all the structure components. Item structures are editable only in
the single level. In this release you can create a new item or document and add it directly as a component while
building a structure.

- Multi level: displays all the levels that are available for the structure components. You can't edit structures in
the multi level view.

- Hierarchy: displays the details of all the structure components in a tree-format. In the hierarchy view that’s
available, you can view the entire tree of the structures in read-only mode with separate icons for parent
subassembly, item, or document subassembly document, and document. This view is available in the change
context and displays redlines for the first-level only. Filter the columns in the Hierarchy view to narrow down on
components and focus on the most relevant ones.

- Summary: provides us with an aggregate of the components across the entire structure. The summary table
contains the item attributes that you can configure for a new Task Flow view - Structure Summary. Click the
View Details eye icon to see the detailed component-level attributes in the side drawer, which is the same as
that visible when you select the single level, multi-level, or hierarchy views.

Edit Structures
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Right-click the component row of a structure, to use the copy and paste attributes or use the keyboard shortcuts CTRL
+C and CTRL+V for the same. You can only copy and paste the attributes that are edited inline and not the ones edited
in the side drawer. If you copy consecutive cells that are read-only, only the editable cells will have its values pasted.

Modify single level structures with the spreadsheet-like functionality. Use the fill handle to copy values to multiple
components. As in a spreadsheet, select a cell, grab the small square icon in the corner, and drag it in any direction -
vertically, or horizontally to fill cells.

To perform bulk edits, select multiple cells and drag up or down (select and move in different directions). To quickly
update cells, select multiple cells, right-click and select Autofill.

Double-click the descriptive flexfield attribute cell in a component row, which will open the side drawer and modify
component descriptive flexfields. When you drag and drop (select and move) an item, remember that only the item
is copied and not the structure child entities like component level attributes, reference designators, and substitute
components.

Points to Consider

- If you haven't created a structure, you must first create the structure header. This enables the edit capabilities in
the grid. Example: You must create a primary structure to add components.

- The primary structure is the default structure view when you navigate to the structure tab. If you've only
created an alternate structure and not created a primary structure, you can see a 'No data to display' message
when you navigate to the structure tab. Select the alternate structure from the drop-down list to view the
components.

Where Used

You can also view the structure and where used report based on the selected context date. For structures, you can select
the context date only for the current revision. Regardless of the component revision you choose, the where used report
is derived based on the current revision.

- For structure, you can only select the date between the start and end revision date of the current revision.
o If the current revision is the latest revision, then there's no end date.

- For where used, you can select past or future date.

On selecting All view and a specific date, the where used results will display the past, current, future effective, and
future pending parent items from that date onwards.

Spotlight

You can add individual components or subassemblies to the Spotlight displayed in the Navigator for that transaction.
After adding the components, you can (select and move) drag and drop them from the spotlight to another structure.
The drag and drop feature is also supported from the clipboard. Select the items by selecting the checkboxes and drag
(move) them to the structure tab. Use the Replace action to replace one component with another.

The spotlight includes reference designators, substitute components, component level attributes, component level
descriptive flexfields when you drag and drop (select and move) the components directly to an item or to an item in
change context. When you drag and drop (select and move) components from the spotlight and select the Copy Details
toggle button, the component level attributes are copied.

You can undo the redlines of both saved and unsaved changes within an item's pending revision. This is applicable for
the Structure tab in the change context. The Undo Redlines button is enabled when one or more redlined rows are
selected.
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Here are some actions you can perform from the structure grid:
- View details of the component on the header, including the lifecycle phase of the item and the revision.
- Create, modify, and delete the structure header.
- Create, modify, and delete the component and its child entities in the structure.
- Replace a component with another component.

- Select different views created by your administrator through Configure Views. The view can contain item
operational attributes, item extensible flexfields, component level attributes, or component descriptive
flexfields.

- Toggle between the single level, multilevel, and hierarchy views.

- View the levels displayed on a structure.

- View the progress indicator when the data is loading.

- Apply filters on the structure (filter supports item and item description).
- Export the selected columns and rows or all.

- Detach the table to view in full screen mode.

- Add component items to the clipboard and spotlight.

- Drag and drop from the clipboard and spotlight.

- View the total count of rows in the structure and the number of selected rows.
- Hide and unhide columns.

- Resize rows and columns.

- Sort columns in an ascending or descending order.

- Select multiple rows, columns, or cells.

- The Replace action is enabled only on a row that isn't modified, added, or deleted.

- When you initiate the Replace action, before saving, the row—including reference designators, substitute
components, and descriptive flexfields—is read-only.

Reference Designators and Substitute Components

You can also add or modify reference designators and substitute components of a component which are additional
attributes available in the structure grid. Use these attributes in existing views or to create new views. Select and click
the data presence indicator on the reference designator and substitute component columns of a structure to view
details in the side drawer. Separate tabs are available for reference designators and substitute components. Global
descriptive flexfields are always visible for both reference designators and substitute components in the side drawer.
You can modify the reference designator descriptive flexfields in the side drawer. Configure business rules on the
standard attributes and descriptive flexfields of reference designators and substitute components.

To add reference designators, double-click the empty reference designator cell, which will open the side drawer. You
can add a range, if the range indicator is configured in Manage Item Structure Type Details task, and comma separated
values. For more details, see Configure Reference Designator Options

- Quantity Related: validates the component quantity against the reference designator values.

- Align Quantity: automatically calculates the quantity based on the number of reference designators and
displays it in the quantity column for the component.
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Search for the structure component based on the reference designator. However, remember to include the Reference
Designator Search attribute in the views you create to search for components using the reference designator.

After you add the reference designators, you must click Apply so that they appear in the table. Modify the description
by selecting the pencil icon in each row. You can navigate to the next component using the navigator icons in the side
drawer and click the pencil icon to enable the edit mode. To modify an existing reference designator, double-click the
cell to navigate to the side drawer and the pencil icon to switch to edit mode. You can only delete reference designators
in the Details area of the side drawer for reference designators.

Note: If you've configured range indicators for reference designators before 24D, you must run the Product
Management Search Ingest Job.

Use the Enterprise Scheduler Service job: Product Management Search Ingest Job to ingest the new range indicator
and replace the existing range indicator:

- Ingest Object = Item Structure
- Object Type = Reference Designators
« From Date = Enter a date

- To Date = You can select the current date
After this job is completed, the Enterprise Scheduler Service job to run Bulk ingest to OSCS job starts automatically.
When both jobs are completed, the range indicator will show the latest selected range indicator.

If the range indicator is enabled, you can see the configuration for quantity and the reference designators with the range
indicator in the Reference Designator tab.

To add substitute components and descriptive flexfields, double-click the component cell which will open the side
drawer. To modify and delete components, click the pencil icon next to the substitute component. You can search for the
structure component based on the substitute component.

Side Panel View in a Structure

The drawer appears when you click the presence indicators on the rows of a structure and provides you more
information about the structure (component details). You can quickly navigate to the next or previous component row
details without closing the drawer using the navigation buttons displayed in the drawer region.

Here’s the data you can view and actions you can take from the drawer:

In Product Development In Product Information Management Actions

[tem Revision Attachments - ltem Attachments Download attachments

ltem Revision Attachments

Pending Changes Pending Changes Navigate to change orders or change requests

Quiality Quiality Navigate to open quality issues, quality actions,
problem reports, and corrective actions

Product Development Relationships NA Navigate to related objects created in the
Product Development work area
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In Product Development In Product Information Management Actions
AML NA Navigate to manufacturer parts
Reference Designators NA View details of the reference designator and

search for specific reference designators

Substitute Components NA View details of substitute components

Notes on the side drawer view:

Has Pending Change: Displays only pending change orders and change requests, not the released changes.
Has Quality Issue: Displays pending quality issues, quality actions, problem reports, and corrective actions.

Has Relationships: Displays relationships added through the Product Development work area. When you click
the concept component or the requirement specification that you added as a related object, the parent concept
or requirement opens.

Has Item Attachment: Displays attachments that you can download. You must select only a single row to
download attachments. Selecting multiple rows will disable the Download button.

Has Reference Designators: Displays all the details of reference designators. You can even search for specific
reference designators.

Has Substitute Components: Displays all the details of substitute components.

View Revision-Specific Values for Items in Pending Revisions

When you select the revision of an item, the content is displayed with or without the redlines, depending on whether the
revision is in the past, current, pending, or future state.

Note:

- The Guide Me button appears when you configure the Page Properties for guided journeys in a structure.

- You can configure guided journeys for structures that will let you provide relevant instructions or guides to

create or modify the structure.

You can select Edit in Change Order from the Actions menu of a pending revision within the appropriate change order
context to edit a pending revision. When you select an item revision, your ability to edit and see redlines depends on
whether the revision is:

Current — The revision is editable and doesn’t show redlines once updated.

Pending - The revision is editable when you select Edit in Change Order. Redlines are displayed after saving the
item.

Past — The revision is read-only and doesn’t show redlines.
Future Effective - The revision is read-only and shows redlines until the change becomes effective.
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Depending on the selected revision, only the following tabs associated with change control will display content and
values specific to that revision. Other tabs will not display any data.

- Attributes
o Each of the following attribute groups will be displayed according to the selected revision:

- Basic, Manufacturing, Service, Inventory, Physical Attributes, Sales and Order Management,
Purchasing, Planning, and Additional Attributes

- Attachments
o Item attachments remain consistent across all revisions.

o Attachments tied to a specific revision are revision specific. When you add an item to a change order,
the pending revision also displays the current revision attachments. Deleting an attachment from the
pending revision won’t remove it from the current revision.

o When you add an item to a change order, the pending revision also displays the current revision
attachments. Deleting an attachment from the pending revision won’t remove it from the current
revision.

o Attachments added to a pending revision won't appear in the current revision.

- Structure

o Inthe structure, the attribute values for both the component and the item displayed correspond to the
specific revision you've selected within the context item. If the selected revision is the current revision,
then the component will display the current revision, and the item entities will be editable. The values
of the following attributes, that are added to the structure table, are dependent on the selected context
revision:

- Component revision

- Component attributes

- Component descriptive flexfields
- Reference designators

- Substitute components

- Item operational attributes

- Item extensible flexfields

- Relationships-trading partner items (AML)
o Trading Partner Items will be displayed in the context of the selected revision.

o Other tables aren'’t revision based and they aren't change controlled.

You can create guided journeys that includes tutorials and best practices to assist users as they work with item
structures.

Data for Change Orders Across Pending Item Revisions

Depending on the revision selected (Current, Pending, Past, or Future Effective), the following tabs which are under
change control will display content and values for that revision. You can edit a pending revision within the appropriate
change order context.

- Attributes
- Attachments

- Structures
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- Relationships

Depending on the change order associated with the item pending revision, the following tabs in the item will either be
editable or read-only when you click Edit Change Order, from the Actions menu as shown in the following table:

Item Tabs Entities Engineering Change  Non Revision Change Commercial Change Commercial
Order Orders Order with Engineered Change Order
Flag Setto Y with Engineered

Flag Setto N

Attributes Item Basic Attributes Editable (Description, = Editable (Description, = Editable Editable
(Main attributes) User Item Type, User Item Type,
Lifecycle Phase) Lifecycle Phase)

Read-only (Item Class, Read-only (Item Class,

Approval Status, Approval Status,
Revision, Primary Unit = Revision, Primary Unit
of Measure) of Measure)
Attributes Item Operational Read-only Read-only Editable Editable
Attributes
Attributes Item Extensible Read-only Read-only Editable Editable
Flexfields
Attachments ltem Attachments Read-only Read-only Read-only Read-only
Attachments Item Revision Editable Read-only Read-only Read-only
Attachments
Associations Organizations Read-only Read-only Editable Editable
Categories Categories Read-only Read-only Read-only Read-only

Depending on the change order associated with the item pending revision, the structures and relationships tabs in the
item will either be editable or read-only when you click Edit Change Order, from the Actions menu as shown in the
following table:

Item Tab Entities Engineering Non Revision Commercialization Change Commercialization Change
Change Order Change Order Order with Engineered flag Order with Engineered flag
settoY settoN
Structure Structure name Primary-editable Primary-read-only Primary-read-only Primary-editable
(flow)
Alternate-read-only  Alternate-read-only = Alternate-editable Alternate-editable
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Item Tab

Structure

Structure

Structure

Structure

Structure

Structure

Structure

Relationships

Relationships

Relationships

ORACLE

Entities

Structure header
attributes
(Description

and Descriptive
Flexfields) and
attachments

Structure Grid
Table (Includes
Component Details
attributes)

Structure
Component
Descriptive
Flexfields

Component

Level Attributes
(Component
Material Control,
Component Order
Management,
Component
Shipping Details)

Component
Level Attributes
(Component ltem
Details)

Reference
Designator

Substitute
Components

Trading
Partner ltems >
Manufacturer

Trading
Partner Items
> Competitor
or Supplier or
Customer

Related Items

Engineering
Change Order

Primary-read-only

Alternate-read-only

Primary-editable

Alternate-read-only

Primary-editable

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-editable

Alternate-read-only

Primary-editable

Alternate-read-only

Editable

Read-only

Read-only

Non Revision
Change Order

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-read-only

Editable

Read-only

Read-only

Commercialization Change
Order with Engineered flag
settoY

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-editable

Primary-read-only

Alternate-editable

Primary-editable

Alternate-editable

Primary-read-only

Alternate-read-only

Primary-read-only

Alternate-editable

Primary-read-only
Alternate-editable

Read-only

Read-only

Read-only

Chapter 8
Structures

Commercialization Change
Order with Engineered flag
settoN

Primary-read-only

Alternate-read-only

Primary-editable

Alternate-editable

Primary-editable

Alternate-editable

Primary-editable

Alternate-editable

Primary-read-only

Alternate-read-only

Primary-editable

Alternate-editable

Primary-editable

Alternate-editable

Read-only

Read-only

Read-only
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Item Tab Entities Engineering Non Revision Commercialization Change Commercialization Change
Change Order Change Order Order with Engineered flag Order with Engineered flag
settoY setto N
Relationships Links Read-only Read-only Read-only Read-only
Relationships GTIN Read-only Read-only Read-only Read-only
Relationships Cross-references Read-only Read-only Read-only Read-only
Relationships Spokes system Read-only Read-only Read-only Read-only
items

Compare Structures

You can compare two item structures—a baseline and another structure—using the Compare action on the Structures
tab of an item.

The comparison results are shown with filters to help refine your view.
To compare structures:

- On the Structures tab of an item, click Actions (three ellipses button) > click Compare.
o The Compare structures drawer appears.

You can select the values for the following attributes for both the baseline and the compared structure:

- Organization Name
« Item Number

- Revision Number

« Structure Type

When you click Compare in the Compare structures drawer, a single-level structure comparison is initiated across both
the structures. Note that the columns in comparison results are based on the selected view.

Note:
- Only two structures and one level of the structure can be compared at a time.

- You can compare two structures and their components across different organizations, revisions, and structure
types.

« You can compare components and their attributes side-by-side and scroll through the results both horizontally
and vertically.
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You can quickly determine the differences between the structures by using the filters such as All, Differences, Added,
Changes, Removed, and Unchanged available in the comparison results.

- All: shows items that are similar in both structures, missing in the compared structure, highlights difference in
the compared structure, and lists any items that are additionally available in the compared structure.

- Differences: shows items that are missing in the compared structure, highlights differences in the compared
structure, and lists any items that are additionally available in the compared structure.

- Added: shows items that are additionally available in the compared structure.
- Changed: highlights the differences in the compared structure.

- Removed: shows items that are unavailable in the compared structure.

- Unchanged: shows items that are similar between both the structures.

You can search for a specific component (across both the structures) in the comparison results by entering the item
number in the search box.

When you click Detach on the Compare structures page, the comparison results grid expands to an entire page,
allowing a better view of the additional rows.

You can scroll through the results both horizontally and vertically and locate the specific cells that interest you.

The comparison results are highlighted with colored icons for better readability and understanding of the differences.

Note:
- If you have the same components on both the baseline structure and the compared structure, and if at
least one of the attribute values present in the current view are different, an edit icon is displayed, and the
differences are highlighted in yellow on the cell. The attributes include the Item Sequence.

- If a component exists in the baseline structure, but is missing in the compared structure, a plus icon is
displayed with the row highlighted in green.

Perform Guided Task Flow to Mass Replace Components

You can perform a mass replacement of components across multiple structures using a guided task flow. Your
administrator can configure the guided task.

You can view all the items where a component is used and replace it with a different component across one or more
selected structures. Here's how:

1. On the Tasks panel tab click Perform Guided Tasks.
2. On the Explore page, search for a component replacement journey and select it or select a component
replacement journey appearing on the page.
3. Click Start This Journey.
4. Search and select the original component you want to replace and the replacement component. Click Done.
During the selection, the components will be filtered based on the organization selected in the configuration.
5. Select for one or more structures from the where used list that shows where the original component is used.
You can refine the search within the displayed list, if the list returns too many results. Click Done.
Notes:
o If the replacement component is configured to be routed through an engineering change order, the
search results will only include engineering structures created in the Product Development work area.
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o

o

If the replacement component is configured to be routed through a commercialization change order, the
search results will include commercial structures created in the Product Information Management work
area and engineering structures in the Prototype or Production lifecycle phases. The results will exclude
Packaging Structures.

If the replacement component isn't configured to be routed through any change order at all, the search
results will include both engineering structures and commercial structures.

6. Review the summary of the selections from your previous tasks and click Done to submit the mass replacement
action.

Notes:

o

o

[e]

You can create a new engineering or a commercialization change order. You also select an existing
change that’s in the Draft or Open status.

Depending on the configuration of the guided task, the changes will be applied directly to the selected
structures of the commercial items or added as affected items to the change order through the
scheduled process for engineering and commercial items.

When the scheduled process is complete, the change order is created in the open status.

If the guided task isn't configured for the change type, then there's no need to select the change type or
create the change order. The replacement will be made directly on the item.
When the components are replaced, the reference designators will also get replaced.

7. View the change order status.

You can view the details such as batch name, change order name, job ID, and job status.

Note: To view the status of the tasks on a later date, you can click the View Guided Tasks link in Product
Management Experience in the Tasks panel tab.

Rules About Item Structures

Here are some rules about item structures.

During the Item Lifecycle Phase

- You can’t reinstate the parent item in a structure if the child component is marked obsolete.

- You can assign an item in Draft approval status to an item structure.

- A component's lifecycle phase should be the same or higher than the parent assembly's lifecycle phase; this
applies to items of lifecycle phase Preproduction or Production only.

If an assembly is approved, components in the draft status can't be added. This applies to items of lifecycle
phase Preproduction or Production only.

- A hand-over of a structure to the downstream processes is triggered by changing the lifecycle phase of the
parent item to Preproduction or Production.

When You Create Change Orders

- You can edit an item without going through change management control, only if the item isn't assigned as an
affected object to a change order.
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- If you're unable to add an item to a structure, here are some of the possible reasons:
o There's another, later revision of the parent item.
o The parent item is on a change order with a pending revision.

o The item was earlier assigned to a change order and the change order is complete. So you're not allowed
to modify the item's attributes, structure, AML, or attachments. To modify the item, assign it to a new
change order.

o You're adding a parent component to a child component.

o If the item is a commercial item, you can't add it to an engineering change order.
- You're restricted from deleting a component (or its parent) if the item is released through an engineering
change order, assigned to a pending change, or part of a canceled change. However, you can delete

components (and items) assigned to commercialization change orders and that aren’t part of a structure on an
engineering item using the delete group.

When You Deprecate ltems

- You can deprecate an item if it isn't used in another structure.
- A child item can still be active if its parent is obsoleted.
- A child item can't be obsoleted if the parent item is active.

To Calculate Item Grade

- You can add items or other subassemblies to the top-level item. After you add the items, the grade of the top-
level item must be refreshed. This results in a display of a newly calculated value of the grade.

- The grade of the entire top-level assembly or item takes into account various statuses of the child items within
the structure.

- You must examine a structure to see which items don't have an AML or which ones have pending changes.
Based on these conditions, you can decide to improve the grade, and then publish the item for manufacturing
readiness.

Import an Item Structure

Importing structures of items is similar to importing regular items. When you intend to collect items in a structure and
then import that structure, the regular items must first exist in the application.

If some or all items going into the structure don't exist already in the application, these items must be created or
imported before you design and import the structure.

1. Download the ltem Structure Import template file from the following guide: Oracle Fusion Cloud SCM File-
Based Data Import (FBDI) for SCM.

This guide contains information about the template.
2. Enter the item information on the EGP_STRUCTURES_INTERFACE tab:

o Set the Transaction Type to SYNC.
o Enter a Batch ID such as 200.
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o

o

o

Enter the Structure Name such as Primary.
Enter an Organization Code such as 000.

Enter the Item Name.

In the EGP_SYSTEM_ITEMS_INTERFACE tab, you need not enter the item version start date. The application
calculates this value based on item effectivity date in the EGP_ITEM_REVISIONS_INTERFACE tab. In case of
multiple item revisions (or effectivity dates), the earliest date is considered.

3. Enter the structure information on the EGP_COMPONENTS_INTERFACE tab:

o

o

o

Set the Transaction Type to SYNC.

Enter the same Batch ID as on the EGP_STRUCTURES_INTERFACE tab.

Enter the Structure Name as Primary.

Enter the same Organization Code as on the EGP_STRUCTURES_INTERFACE tab.
Enter a child item in Component Item Name.

Enter the parent item in the Structure Item Name.

Enter a number for the component item sequence which determines the order in which child items are
listed. In the absence of a sequence number or in case of a duplicate sequence number, the application
automatically generates the sequence number.

Enter a number for the quantity of each item.

4. Generate CSV files:

[e]

o

o

Select the Instructions and CSV Generation tab and click the Generate CSV File button.
Click Save each time the macro prompts to do so.

Locate the zip file that was generated by the macro.

5. Import the zip file:

o

o

o

o

o

From Navigator, open File Import and Export.

Click the Create New + icon.

Click the Browse button and locate the zip file that was generated by the macro.
In the Account field, select SCM / item / import.

Click Save and Close.

6. Load data to interface tables:

From Navigator, open Scheduled Processes.

Click the Schedule New Process button.

Search for and select Load Interface File for Import as the process name.

Click OK.

Select Item Import as the Import Process.

Select your zip file as the Data File.

Click Submit.

Note the process number.

Click the Refresh icon on the Scheduled Processes Overview page to watch for the process to complete.
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7. While still in Scheduled Processes, click the Schedule New Process button.
o Search for and select Item Import and click OK.
o Enter the same Batch ID that you put in the spreadsheet.
o Select the same organization that you put in the spreadsheet.
o Set the other fields as required.
o Click Submit.
o Note the process number.
o Click the Refresh icon on the Scheduled Processes Overview page to watch for the process to complete.

FAQs About Structures

How can | view the manufacturer parts used in an item structure?

On the Edit Item page, click the AML tab.

The following subtabs appear:

ltem AML subtab - lists the approved manufacturers for the item.
- Structure AML subtab - lists the manufacturer part numbers used in the structure of the item.

How can | view attachments for all the components of an item
structure?

On the Edit Item page, use the Actions menu to download the report containing attachments for all the components of
an item structure.

How can | find out when the component is added and removed
from the structure?

The start date and end date fields on the item structure page indicate the date when the component was added and
removed from the structure.

Why can't | modify the structure?
Because the item structure either has another revision or is on a change order with a pending revision.
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How can | reinstate a parent item in a structure that contains
obsolete components?

You must first reinstate the obsolete components and then reinstate the parent item.

Can | use a replaced component in another item?

Yes. For instance, you replaced a component because a buyer rejected it based on company regulations. But you can
still use the component in another item where the regulations don't apply.

Related Topics
» Replace a Component

How can | remove an obsoleted component from an item
structure?

Change the lifecycle phase to Production and remove the component from the item structure. Then change the lifecycle
phase to Obsolete.

To change the lifecycle in the Product Development work area you must create a change order and release it. But in the
Product Information Management work area you don’t have to create the change order.

How can | compare different revisions of the same item?

On the Structure tab of the item, use the Actions menu and select Compare Structure. In the Compare By list, select
Revision. You can compare different revisions of the same item or different items.

How can | inform other users about my new item structure?

Select Send Object in the Actions menu and add the users you want to inform.

In a structure, how can | view the items available in an item class?

Export the item structure using the Export to Excel icon and filter the spreadsheet to view items by the item class.

You can also view the item class on the Structure and Where Used tabs of the item.
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In a structure, how can | manage mismatches in lifecycle phase?

To manage the lifecycle phase for a structure type, use the Enable Lifecycle Phase option available in the Manage Item
Structure Type task.

To access the Manage Item Structure Type task, navigate to the Setup and Maintenance work area. Select the Product
Management Offering, and Structures functional area.

Select the Enable Lifecycle Phase option to manually correct any mismatches in lifecycle phase. Deselect the option to
allow creation of item structures with components at a lower lifecycle phase than the parent item.

The changes you make to the Enable Lifecycle Phase option don't impact existing structures. For such structures you
must manually correct the mismatches in lifecycle phase.

Why can't | access the item structure and edit its AML and
attachments?

To view and update the item structure, you must have the Maintain Item Structure security grant assigned to your role.

To edit AML and attachments, you must have the Maintain Item Basic security grant.

Related Topics
« Set Up Data Security for Item Classes

How can | update the effective date of a future-dated component
through an import map?

To update a future dated component through the import map, pass the current EFFECTIVITY_DATE as the
Structure.Component.Start Date and pass the effective date you wish to update as the NEW_EFFECTIVITY_DATE to the
Structure.Component.New Start Date in the import template. Additionally, provide a correct current effective date and
time zone in the data file for the component item.

Note: The current effective date passed in the data file must exactly match the current effective date of the
component item.

Can | modify substitute components?

Yes. You can modify substitute components using an engineering change order.

95
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20042755

Oracle Fusion Cloud SCM Chapter 8
Using Product Development Structures

Related Topics
« Manage Substitute Components

Why am | unable to view the Substitute For column in the structure
details?

Ensure that you've selected Include Substitute Components in the search filter and the Substitute For column in View
> Columns.
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9 Formulas

Overview of Formulas

Formula development includes multi-product support and new attributes for tighter integration with downstream
applications. These enhancements allow you to model real-world manufacturing scenarios more accurately, including
multiple outputs and ingredient-level control.

You can use the Structure Item Type — Formula to create product formulas with ingredients. When you select the
Formula item type, a new Formulas tab appears on the Item page.

In the Formula grid, you can:

- Easily distinguish products and ingredients: Separate header rows help to distinguish between products
and ingredients. You can also view formula details in the hierarchy view, this lets you expand or collapse any
formula that contains products and ingredients.

- Associate formula names with co-products and by-products to automatically common the primary product
formula structure to the corresponding co-products and by-products: To common the primary product formula
structure into co-products or by-products, select the formula name. This enables you to view co-products and
by-products separately, making it easier to identify the primary products in which this formula is used as a co-
product or by-product.

Note:

o When selecting the formula name of a co-product or a by-product, you can only select one that
hasn't been before used for that same co-product or by-product.

o As a best practice, you can choose a formula name other than Primary. This is an optional step. If
you choose to leave the formula name blank, commoning will not occur.

o For co-products and by-products, deleting the formula name from the component table doesn't
remove the common formula. To remove it, you must open the formula item and make the
change there.

- Associate the formula name with formula ingredients to ensure the correct components are selected during the
formula expansion: In the Ingredients section, you can select formula names for rows that are formulas (and
not standard items). You can choose any of the existing formula names to associate with the ingredient. The
selected formula name identifies which child components are displayed in the multi-level and hierarchy views.

Note: If the ingredient is a formula and no formula name is specified, the application defaults to the primary
product’s formula name (if present on the ingredient) when expanding it in the multi-level or hierarchy view.
If that formula name doesn't exist on the ingredient, it will not be expanded.

- Apply change controls on formulas: You can redline formula name selections for co-products, by-products, and
ingredients. You can also redline the primary product, including formula-specific attributes such as Completion
Type. Formula-specific attributes are displayed in the Change Order Summary report. When a redline exists, the
report shows both the old and new values for these attributes.
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Formulas Operations

Here's what you can do in the Formula grid:

- Create, edit, and delete the formula header.

- Add, edit, and delete products and ingredients.

Edit the child entities in the formula.
Delete primary formulas

Components of Formula

A Formula structure can include both products and ingredients.

Products

Products have a structure item type of Formula.

The product types can be:

1
2,
3.

Primary
Co-product
By-product

For example, when making tofu, the primary product is tofu, soy milk can be a co-product and okara (soybean pulp) is a
by-product.

Ingredients

After you add rows, the product type defaults to Ingredient. A formula item can be a co-product, by-product, or
ingredient, whereas a standard item can only be an ingredient.

Create Formula

A predefined item template named Formula is available to support the creation of formula items.

Note: You can create a Formula template with predefined attribute values for item classes. You can edit the template
as required to meet your business requirements. For setup details, see Add Predefined ltem Templates inManage Item

Templates.

Here's how you create a formula:

1.
2. Click the Add icon.

3.

4. Onthe Create Item page, enter values for the mandatory attributes, and select Formula in the Apply

5.

From the Product Management Search page, select Item.
Click Create Item.

Templates field.
Click Create.
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6. Navigate to the Formulas tab, click the button with three dots (...) next to the Search box, and then choose
Create Formula.

7. Inthe New formula drawer, enter a Formula Name, provide a Description, and add any additional details or
attachments as required.

After you create the formula header, the parent formula item is automatically assigned as Primary Product.
8. The attributes displayed on the Formulas tab includes:

Item Number
ltem Sequence
Product Type

« Structure ltem Type

Note: The columns displayed in the Formulas tab depend on the selected view. A predefined Product
Management Formula View includes the following default attributes: Item Number, Item Sequence, Product
Type, and Structure Item Type. You can configure your preferred view to include additional attributes that
meet your business requirements.

- The Component level attributes displayed on the Formulas tab includes:

o Absolute Yield: Displays Absolute Yield (Quantity x Yield) for each component (includes both ingredients
and products). This field is read-only.

o Product Type: This attribute categorizes output as:
Primary Product

Co-product

By-product

Ingredient

This classification helps define outputs more accurately and is essential for downstream traceability.

Note: After you add ingredients and products, double-click a cell to edit ingredient level attributes.

o Contribute to Yield (Ingredients only): Select Yes to indicate that the ingredient contributes to the total
formula yield, or No if it doesn't. Use the Contribute to Yield attribute for loss items or carriers that don't
affect the final product quantity.

o Completion Type (Products only): Specifies how the product is treated at formula completion. Valid values
are Manual or Automatic. Use the Completion Type attribute to ensure consistency in completion logic
across downstream manufacturing processes.

- Component descriptive flexfields. Double-click a cell to edit the component descriptive flexfields.
- Substitute Components.

Reference Designators.

Note: Support for Reference Designator isn't available.

Related Topics
« Manage Item Templates
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Edit Formula

You can add, edit, and delete formulas and their constituents — products and ingredients.

Here's how you edit the formula:

1. Click the Select and Add Items icon in the toolbar to open the Search and Select drawer.
2. Inthe drawer, search and select to add one or more ingredients to the formula. You can also search for more
ingredients or use a saved search.

You can use filter chips with multi-select to refine your search.

The count on the Add button shows the number of ingredients you're adding. Click the Show Selected button
to view the ingredients you've chosen.

3. After you add rows, the product type defaults to Ingredient. If you don’t want to add the row as an ingredient,
change the Product Type field to Co-product or By-product before saving your changes.

Note: While a formula item can be a co-product, by-product, or ingredient, standard items can only be
ingredients.

Delete Formulas

To delete a primary formula, add it to the Delete group.

Note: Before deleting, ensure that the primary formula isn’t referenced in any other structure or formula as a
component. You'll get an error message if you try to delete a formula that's used in another formula as co-product,
by-product or ingredient. To delete a primary formula, remove the reference and ensure that the primary formula
hasn't been used anywhere as a component in structure or ingredient or product in formula.

Additional Actions

Here are some actions that you can perform on formulas:

- Copy and Paste: Copy a cell and paste it into one or more cells within the same column.

- Spotlight: Save a formula to Spotlight to view all associated ingredients and products. When you add them as
formula components, they default to ingredient.

- Clipboard: Add ingredients and products to the clipboard for easy reuse.
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- Change Control: Change ingredients and products, including some attributes of the primary product, and track
changes using redlining.

Note: When the Engineering flag is set to:

o Yes, the formula item can be included in an engineering change order where you can redline
revision attachments.
o No, the formula item can be included in a commercialization change order where you can't
redline revision attachments.
For more information, see the link provided for Data for Change Orders Across Pending Item Revisions topic
in the Related information section of this topic.

- Create a new formula by copying an existing one: In the New formula drawer, select Create from existing to
copy a formula from the same or another organization into a different formula header.

- Create a common formula: In the target organization, you can reference an existing formula when creating a
new formula. Any updates made to the existing formula are automatically reflected in the referenced formula.
The referenced formula itself can’t be edited.

In the New formula drawer, select Create from common to select an existing formula to be referenced in a new
formula.

- Replace ingredients, co-product or by-product.

Import Formula

You can import a formula along with its ingredients when the structure item type is set to Formula. If the items don't
already exist in the application, they're created automatically, followed by their formula structure.

You can also use the Import operation to set values for the following attributes:
- Completion Type
- Contribute to Yield
- Component Type
- Basis

- Product Type (applicable only for formulas)

Integrations

REST: Create a Formula item with the Structure Item Type set to Formula, and then add its component items. The Items
V2 and Item Structures REST APIs support the creation of Formula item types and their associated structures.

In REST, the Formula Name attribute (CompAlternateBomDesignator) is available in Item Structures. Associating a
Formula Name with a co-product or by-product will automatically make it common with the primary product’s formula
structure.

SOAP: Create a Formula item with the Structure ltem Type set to Formula, and then add its component items. The
Item and Item Structures V2 SOAP services are now enhanced to support the creation of Formula item types and their
associated structures.
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FBDI:

- Create a Formula item with the Structure Item Type set to Formula (Code = 6), along with its ingredients before
creating the Formula structure.

- Item FBDI supports creating new items with the Structure Item Type set to Formula (Code = 6).

- Item Structure FBDI supports creating a Formula structure. You must create a primary product before you
create its structure.

- Use import to define the values for the following attributes:

o

o

o

o

[e]

Completion Type
Contribute to yield
Component Type
Basis

Product Type (only applicable for formulas)

Business Intelligence Cloud Connector

The new formula related attributes Component Absolute Yield, Component Contribute to Yield, Component Completion
Type, Component Product Type and Component Type within structure components are available for Business
Intelligence Cloud Connector (BICC) extraction in the formula components - ComponentsExtractPVO.

Related Topics

- Data for Change Orders Across Pending Item Revisions
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10 Change Management

Overview of Change Orders and Change Requests

Change orders and change requests let you process changes to items, and documents. Change orders allow you to
markup the required changes, and the changes become effective on approval. But change requests don't provide any
markup.

Note: Change objects may be referred to generally as change orders, change requests, or changes. However,
when being specific about change types that your company may use to create individual change objects, you must
differentiate between change order and change request types.

As a product manager you can manage change orders. Your users can:
- Create change orders within predefined change types.
- Author and view product changes.
- Submit changes for review and approval.
- Track change statuses.
Implement changes on a scheduled date.

To ensure successful and validated completion of change orders, changes are submitted through a formal review and
approval workflow.

Change Types

You can create change orders based on the predefined change types setup by your administrator. To create a change
type:

In the Setup and Maintenance work area, go to the following:
- Offering: Product Management

Functional Area: Change Orders
- Task: Manage Change Order Types

Note: For details of all notifications in Product Management, see View Product Management Notifications on the
Oracle Help Center.

To use change orders, you must create at least one change type. The change type can be end-dated if it's not used in
any change orders that have a workflow in progress.

To create a change type based on predefined types:

In the Setup and Maintenance work area, go to the following:

- Offering: Product Management
Functional Area: Change Orders
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- Task: Manage Change Order Types

This table provides information on the predefined change types and supported features.

Change Type

Engineering Change Order

Change Order without
Revision Control

Change Request

Deviation Change Request

Commercialization Change
Order

Problem Report

ORACLE

Description

Used when tracking major
changes during the design
phase of the item.

The revision number is
automatically incremented
when you make changes.

Used when revision control
isn't required or when
changes are minimum.

For example, replacing an
existing manufacturer part
with a similar part supplied
by another manufacturer.

Used when suggesting
changes for a released
item.

For example, a supplier
could request changes in
certain specifications.

Used when deviating from
a process or specification
for a specific time period.

For example, suggesting
the use of a substitute
component as a temporary
means of resolving an
issue.

Used during the
commercialization phase of
the product. Can be created
and edited in Product
Information Management.
Also available in Product
Development as read-only.

Used to implement
Quiality Management

for engineering design
and development
through Oracle Product
Development Cloud. It's
also required to enable
supplier collaboration for

Supports Revision Control

Yes

No

No

No

Yes

No

Supports Audit Report

Yes

Yes

No

No

No

No

Chapter 10
Change Management

Supports Redline
Modifications

Yes.

Displays the following
modifications in redline:
item detail, EFF, structure,
AML and attachment.

Yes.

Displays the following
modifications in redline:
AML, EFF, and item detail.

No

No

Yes

No
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Change Type Description Supports Revision Control Supports Audit Report Supports Redline
Modifications

issue identification and
resolution.

A problem report is a

type of quality issue,

such as a defect,
deficiency, or a significant
variation in a product's
expected appearance or
performance.

This change type is
applicable only for users in
the Quality Management
work area.

Corrective Action Used to implement No No No
Quiality Management
for engineering design
and development
through Oracle Product
Development Cloud. It's
also required to enable
supplier collaboration for
issue identification and
resolution

A corrective action is a type
quality action to mitigate a
quality issue and prevent its
further occurrence.

This change type is
applicable only for users in
the Quality Management
work area.

Note: The 8D corrective action is 'inherited from' the predefined corrective action change type and hence you can't
view it in the drop-down list of change types in manage change types.

Related Topics
« Define a Change Order

« View and Edit Change Details
» Create a Change Order and Submit it for Approval
« Use Predefined OTBI Dashboards for Changes and Items
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Define a Change Order

Here's the sequence of steps to define a change order.

1. Create the change order, giving it an appropriate name and purpose or description.
2. Assign items and documents that are affected by the change order.

o Manufacturer parts can't be added to a change order; you must add a manufacturer part's associated or
parent item.

3. Edit the item or document and modify their definitions:

o Update the item or document attributes; or,
o Modify the structure, in these ways:

- by adding new structure components;
- by withdrawing existing structure components; or,
- by modifying structure attributes.
4. Check the impact of the change by analyzing the impacted products.
5. Adapt the change to impact the intended products only.
6. Define the list of approvers for the change - individual users or user group. If the user group is expanded into a
comma separated list, the number of characters in the list should not exceed 2000.
7. Submit the change order for approval.
8. Approvers review and then approve or reject the change.
9. If rejected, rework the change and resubmit for approval.
To add an affected object to the change:

Open the Affected Objects panel.

Open the Actions list and select Add. Or use the + Add icon.

Search for appropriate items or documents.

From the returned search results, use the arrow to assign an affected object.
5. Save your modifications.

To change the revision of an affected object on the change:

PUOUN

1. Inthe row of the affected object, you can make a manual change to the revision.
2. Save your modifications to the business object.
To change the metadata attributes of a business object that's held on a change:

Select the affected object.
Open the Actions list and select Edit. The object's Details page displays.
Modify object attributes.
4. Save your modifications to the business object.
To change the structure of a business object that's held on a change:

WN =

1. Click the affected object.

The object details page appears.
2. Switch to the item or document structure by clicking the Structure icon.
3. Add a new item or document structure component. Or, Modify or Withdraw an existing structure component.
4. Save your modifications to the business object.
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Set Status on Changes

The list of default statuses that can be set from the Change Status button on changes depends on the workflow
definition. The workflow in Product Development always has an Approval status.

- Approval: Select this status when you create the change order or change request and want to send it to
reviewers for their review and approval or return.

- Hold: Select this status when the change must be withdrawn from active evaluation and review.

- Cancel: Select this status if you must delete the change order.

Related Topics
» Overview of Change Orders and Change Requests

« View Affected Objects and Change Operations

Create a Change Order and Submit it for Approval

Changes are created to modify an item. Use the Product Development work area to create a change order and submit it
for approval.

Create a Change Order from Scratch

Use the Navigator to go to the Product Development work area.

Open the Tasks panel tab.

Click Change Order > Create Change Order.

From the Create Change Order window, select one of the predefined change types.
In the Name field, enter a name for the change order.

In the Description field, enter a brief description of the change order.

Note: The Create dialog box also shows the required extensible flexfields as well as the ones configured in
number assignment rules for the selected change type. For more information on number assignment rules,
see the related links.

CUAUWNA

7. Click Save and Close.

8. C(lick the Affected Objects tab and then click Add Item.

9. Search for an item and click Add to add it to the list of affected objects.
10. Click Save. By default, the change order is in Draft status.

11. Click the Change Status button to move the Change Order from Draft status to Open status.
12. Click the Approval option in the Change Status list to submit the Change Order for approval.
13. Add Approvers, as needed, and click Submit.

You can enter other information to the new change or save it and later add more information.

Create a Change Order by Copying an Existing Change Order

From the Actions menu in a change order, use Save As to create a new change order of the same type or a different
type. Here's what you can copy over from the existing change order: descriptive and extensible flexfields, attachments,
affected objects, and relationships. Note that you can copy relationships only in engineering change orders and change
orders without revision control.
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Create a Change Order from a Change Request

From the Actions menu in a change request, use Create Change Order. Here's what you can copy over from a change
request: affected objects, flexfields and extensible flexfields of affected objects, attachments, and relationships.

Related Topics
« Overview of Change Orders and Change Requests

« Define a Change Order
« Why am | unable to create a change order?
» Rules and Rule Sets

Manage Change Orders and Change Requests

You can search for and perform actions on changes using the Manage Change Orders and Manage Change Requests
pages.

You can filter changes based on type and use other criteria to narrow your search results to the most relevant results.
You can also use the Add Fields button to add more fields to the search criteria. The fields you add can be configured to

appear as columns in search results.

Note:
- To configure the fields appearing in search results, click View > Show more columns.

- When you search for the Change Request change type, the search results also include deviation requests.

Here are some actions you can perform from the Manage Change Orders and Manage Change Requests pages:

- Add new change orders or duplicate existing ones.

Delete change orders by adding them to a delete group. You can delete change orders that are in the Draft
status. You can delete change orders that are in the Canceled status too, but a canceled change order with even
one scheduled or completed line can’t be deleted.

Manage the change order workflow by using change order actions: Promote, Demote, Hold, Release Hold, and
Cancel.

- Generate change order details report.
Here are some details on the Manage Change Orders and Manage Change Requests pages:

Search Filter

You can use this filter to search by a change type. The default search filter is set to All Change Types.
- Saved Search

The default saved search is titled Application Default. This is executed when you select a change type.

Manage Watchlist
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Use the Watchlist to track important business objects. The watchlist is categorized by the functional areas.
Each item on the Watchlist page is made up of descriptive text followed by a count. Click the watchlist item to
navigate to the object of interest.

You can create your own watchlist items based on saved searches. Click the Manage Watchlist icon on the
Manage Change Orders or Manage Change Request page. In the Manage Watchlist dialog box, select the check
box Include Saved Searches to add the saved searches to the watchlist.

You can use the Watchlist page in the Set Preferences work area (Navigator > Tools > Set Preferences) to
determine which categories and items to show or hide in the watchlist.

You can create watchlists for corrective actions and problem reports.

Related Topics
« Using Common Features Guide

View and Edit Change Details

A change order's General Information side tab is the starting point to access its basic information.
Here are some side tabs available on change orders (and change requests).

- General Information: the default or cover page of a change order.
- Affected Objects: items or documents that are the subject of the proposed change or modification.

- Attachments: text or graphic files, or URL, with more information about the change order; attachments are
classified in a category.

- Workflow: the sequence of statuses through which the change order advances.

Impact Analysis: impacted assemblies are those that are impacted by modifications to items or structures on
this change order.

Relationships: association between change order and another business object.

- Security: add team members to the change order; search and select by Person (user name) or by Role.

When the role is expanded into a comma separated list, the number of characters in the list should not exceed
2000.

History: a table showing the sequence of actions performed on the change order.

Content Presence Indicators

When you open a change order, you can view blue side tabs, indicating the presence of content in them.

Icons for tabs that always have content or have content that is calculated upon selection are always gray in color. They
include the General Information, Workflow, History, and ltem Grade tabs.
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General Information Tab

When you open a change order, the General Information tab is displayed. You can fill in attributes for the change order.
The change order number can be filled in during creation, or, depending on the configuration, it can be automatically
generated.

This tab can also include the following additional fields:

- Attributes such as descriptive and extensible flexfields set up by your administrator. Depending on the
configuration, you can enter up to 4000 characters in the descriptive flexfield.

- Trading Partner Reference attributes such as Customer, Supplier, Manufacturer, and Source are associated to
changes such as change orders, change requests, problem reports, and corrective actions. These attributes also
appear for supplier portal users.

Note:
Change types that are created based on a predefined change type inherit the attribute visibility configuration of
the parent change type.

Use the Manage Change Header Attributes action in Additional Workflow Controls to allow or disallow
participants from modifying the general information.

- Affected objects in engineering change orders and change orders without revision control can include
engineering objects.

- Affected objects in commercialization change orders can include engineering objects that are ahead of the
design lifecycle phase, and non-engineering objects.

Attachments Tab

Click the Attachments side tab, the Attachments page displays. Files can be associated with this change order using the
+ Add icon or Actions > Add. If you select a listed attachment, the X Delete icon and Actions > Delete are enabled.

When you want to modify an attachment, you must first distinguish the purpose and place where the attachment
appears. An attachment on a change order is a document that further explains something about the change order itself.
This attachment can be modified directly, as long as the change order is in an editable status; there's no need for an
additional change order.

Attachments on items are managed with the mechanism of a change order, in which proposed modifications to the
attachment are described, reviewed, and approved, much like proposed modifications to the item's design or attributes.

Related Topics
« Secure Access to Changes

- Terminate and Restart a Workflow
« Replace a Component
» Configure Change Types
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Edit Released Engineering ltems

You can edit released engineering items by assigning them to a change order or using change order import. To modify
the entire structure that contains the released item, you must also assign the parent item.

If you're using change order import, you can modify the following: item general information, structure components,
reference designators, substitute components, and AML. This isn't applicable for commercial items and
commercialization change orders. For more information, see the related topic on ltem Batch Change Order Options.

Before you edit released engineering items, note that:
- You don’t have to route the items through a change order if you're modifying the following:
o Preliminary engineering items that have never been added to a change order.

For example, you can modify the AML through import map without a change order, if the item hasn’t
been assigned to any change order.
o Item extensible flexfields and operational attributes that aren't change-controlled.

o Attachments on the item.

- You must use a change order to modify released engineering items or structures through FBDI also.

To avoid enforcing change control during migration or mass update, set the profile option
EGP_CONVERSION_MODE to Yes. Remember to set it back to No after the process is complete.

Related Topics
- Item Batch Change Order Options

Modify Assignee

If your workflow is stuck due to absence of the assignee, you can modify both assignee role and default assignee.

You can modify these fields on the following objects: change orders, change requests, problem reports, and corrective
actions if they're stuck.

Before you modify the assignee role or the assignee, here's what you need to know:

It's recommended that you always populate the Assignee Role field on the General Information tab so that the
Assigned To user can add approvers during the approval workflow.

The Assignee Role field can be edited in the Draft and Open statuses. If the object is in interim or approval
status, you must terminate the workflow.

- To modify the Assignee Role and Assigned To fields, you must have the Manage Assignee privilege. You must
also have permission to manage change header attributes as defined in the Additional Workflow Controls table
in change type setup.

If the assignee role isn't defined, the new assignee must have the BPMWorkflowAdmin privilege to terminate
the workflow and reassign.

m
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20030178

Oracle Fusion Cloud SCM Chapter 10
Using Product Development Change Management

- If the assignee role isn't defined and the new assignee wants to reassign or delegate a task from BPM
Worklist, the new assignee must have the BPMWorkflowSCMAdmin privilege to view all the approval tasks in
Administrative Tasks.

- You can't edit the Assignee Role or Assigned To fields for objects that were added prior to the support of
Additional Controls in update 20B.

- Only the Assigned To user can see the Terminate and Restart actions in the Actions menu. Ensure that a user
name is provided in the Assigned To field.

Note: If you have modified the assignee's user name during a change order or new item request workflow, an error
message appears. To resolve the error, terminate and restart the workflow.

Related Topics
« Configure Default Assignee for Quality Issues and Actions

Take Action on Changes

Here are some of the actions available on the Actions menu of a change in the Product Development work area:

- Change Order Details Report: generate a report of the change order. You can choose a template, format, and
locale. To generate this report, you must have the following roles:

Bl Consumer and EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV_OBI.

Note: If the column width in a multi-row table on the report exceeds the page width, the content is truncated
in the PDF format. It's recommended to use the HTML format in such cases.

- Delete: mark the change order for deletion and add it to a delete group.

You can create a new delete group or add the change order to an existing group. Note that you must perform
this action from the Product Information Management work area.

You must then confirm the deletion using Manage Delete Group available in the Tasks panel. The change order
must meet the deletion constraints so that the affected object isn't used in any other structure.

In case you want to again use the change order and it can't be deleted due to constraints, you can restore the
change order using Actions > Delete on the Edit Delete Group page.

- Send Object: works for items, documents, and change orders. A message about the business object is sent to
another user.

Messages displaying the list of recipients can be sent to a single user or multiple users. If there's a need to
restrict a user from viewing the recipient list, it's recommended to send notifications to a single user.

- Audit: create an audit report on a change order. Select Audit, and select a status from the fly-out list. This
generates the audit. (Which statuses are displayed depends on workflow definition.) Now, click the Audit
Results side tab. The audit checks for any problem or violation of the entry or exit criteria on the Status
changes in the workflow of the change order. The Audit Results lists all these as well as more general issues
with the change order.

12
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa26a&id=s20072665

Oracle Fusion Cloud SCM Chapter 10
Using Product Development Change Management

Download Attachments: appears on the list when this change order has one or more attachments. Selecting
the action opens a dialog box. You can choose from options and specify which attachments you want to include
in your download.

Publish: publish engineering change orders to an XML report. A process ID is generated for each report. To
view the report, click Tasks > View Scheduled Process and enter the process ID.

Move Change Lines: move the selected affected objects to a new change order within the same organization.

- View Reports: view and launch preconfigured reports for change orders.

Related Topics
- View and Edit Change Details

« Move Change Lines

» Cancel Change Lines

» Replace a Component

« Where can | approve or reject a change order?

» Manage Attachments in Items and Change Orders

Change Order Details Report

You can view the Change Order Details Report in a Microsoft Excel format, where you get to see information organized
in separate tabs for detailed analysis.

The Change Order Details Report provides you information about the change order (Name, Type, Description) along
with Line Item details (Item Details, Current and New Revision, Status), and Item Changes (Additional Attribute
Changes). You can generate the report from a change.

You can analyze the information provided in multiple sheets, which display change attributes (including extensible and
descriptive flexfields), all the redlines made on the affected items, along with the change order header and attachment-
related information.

Select the Change Order Detail Report option from the Actions menu of a change to generate the report. On the
Change Order Report page, you can see these details:

- Template: ChangeOrderSummaryReport.xls

« Output Format: Excel (mhtml)
Click Go.

Download the report in the .xIs format and because it contains Macros, you must first unblock the security to run
Macros. Here's how:
Right-click the .xls file and select Properties.

-+ Select Unblock in the Security section on the General tab.

Note: If you open the report without unblocking the security settings, it prevents Macros from running, leading to
discrepancies in the report.
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Here are the sheets available in the Excel-based report:

Name of the Sheet

Change Order Information

Affected ltems

Item Attribute Redlines

[tem Stucture Redlines

Item Structure - Reference Designator
Redlines

[tem Structure - Substitute Component
Redlines

ltem AML Redlines

ltem Attachment Redlines

Item Organization Redlines

Item Supplier Association Redlines

Item Packs Redlines

Change Attachments

Change Tasks

Change Relationships

Report Features

What it Displays

Change header attributes, and descriptive flexfields and extensible flexfields on changes.

Affected item attributes with revision-specific redlines and lifecycle phase changes.

Redlined attributes with the old and new attribute values for comparison.

Item structure and its attribute redlines excluding reference designators and substitutes.

Reference designator redlines on components.

Substitute component redlines.

AML (Approved Manufacturers List) attachment redlines.

Redlines made on the affected item's attachment attributes.

Organization related redlines made on affected items.

Redlines made on the supplier associations of an affected item.

Information on the item packs linked to an affected item, along with its redlines.

Updates made on the attachments linked to the change order.

All the tasks created for the execution of the change order.

The objects that have been linked to the change object as a relationship.

Change actions on all the sheets are color coded for clarity and better comprehension.

- When you add data, the cell is color coded in green.

- When you delete data, the cell is color coded in red. A red strikethrough appears against the deleted text.

- When you update data, the cell is color coded in yellow.

If you redline an attribute the old and new values are populated in adjacent columns, with the old value showing up
first (to your left) and the new value after that (to your right). The redlined attribute appears with a strikethrough (in red
color) and the column header changes color (turns yellow).

ORACLE
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All the new sheets listed in the table may not be available for all the changes. Here are some examples:

- A change request won't include any redline information sheets because you can’t redline any fields in the
change request.

- If there’'s no information related to the change in a particular sheet, that sheet is automatically hidden in the
report.

Only the data available for you in the Ul is included in the report you generate, for a change. If you're restricted from
viewing certain data in the Ul, the same restriction will apply to the data in the report.

Points to Consider

- The Change Order Details Report is enabled for engineering change orders, change orders without revision
control, commercialization change orders, change requests, problem reports, and corrective actions.

- Item Main, Item Structure Attributes, and Item Basic are attribute columns that are populated in the Item
Packs Redline sheet.

- The data security applicable for the Ul of the change applies to all sheets in the report, except for the ltem
Attachment Redlines and Change Attachments sheets.

Related Topics
- How to Add Additional Attributes to a Change Order Details Report

Add or Remove Participants from Future Status

You can add or remove participants from a future status in the workflow when the change is in draft, open, interim
approval, approval, or scheduled status. Note that this depends on the permissions assigned in the additional workflow
controls table.

Your participants include reviewers, approvers, and optional approvers.
To add participants to a future status, you must select the future status in the workflow and click Add in the Participants

section.

Note:
« Your participants receive notifications which can be configured by your administrator.

- A Claim button appears on the approval notification when multiple reviewers are added. If one of the reviewers
claims the task, the others don't see any action buttons on the notification.

Current Change Status For Future Approval Status For Future Scheduled Status For Future Completed Status
Open Add or remove users and roles Add or remove users and roles Add or remove users and roles
such as approvers, optional such as reviewers. such as reviewers.

approvers, and reviewers.

Approval N/A Add users and roles such as Add users and roles such as
reviewers. reviewers.
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Related Topics
« Actions You Can Control

Add or Remove Participants in Current Status

You can add or remove approvers in the interim approval and approval status. You can add or remove participants of
type reviewers when the change is in draft, open, approval, and interim approval, scheduled, or completed statuses.

You can add roles as approvers or reviewers while approvals are in progress.

Note:
- Participants include reviewers, approvers, and optional approvers.

- This is applicable for change orders, change requests, problem reports, and corrective actions.

- Adding participants depends on the permissions assigned in the additional workflow controls table.

Here are some additional details:

- The newly added participants receive notifications. You're restricted from adding a role that has more than 40
members to the approval workflow if the Response Required From field is set to All. This happens when you
promote the change. Also, automatic promotion is prevented. You'll see a new entry in the action log and a
notification is sent to the analyst.

- Optional approvers can't be added when approval is in progress.
- Only the change analyst can remove approvers or reviewers in the current approval status.
- You can't add the same user as reviewer and approver.

- You can also remove a person or role from the participants list as long as there's at least one person or role
remaining as an approver. Only the change analyst can remove participants.

- You can't remove approvers who have already approved or rejected the change.
- You receive an FYI notification if you're removed as an approver or reviewer in the current interim approval or

approval status, and if you're removed from the approval group.
o You can see the comments provided during the removal action in the notification.

Note:
o In BPM Worklist configuration, it's recommended that you make commenting mandatory when
rejecting a change order so that rejection comments are captured.

o Comments are visible in the rejection notification for change orders, change requests, problem
reports, and corrective actions.
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Related Topics
« Why am | unable to add or remove approvers during the change order approval?

« Actions You Can Control
« View Product Management Notifications

Cancel Change Lines

If a change order is stuck due to an unforeseen reason, review the details in the History and Workflow tabs. Depending
on the workflow, you can cancel the change order or change lines (or affected objects).

Here are some things you need to know before you cancel change orders and change lines:

Manually Cancel the Change Order

Use the Cancel Change Order action. Then the application cancels all change lines except the ones that are complete;
the change order status is set to Canceled.

Note: To cancel a change order in the interim approval or approval status, you need the reschedule change order
privilege.

Manually Cancel the Change Line

Use the Cancel action.

If you cancel change lines in a Scheduled change order which is stuck because the operation post process job is stuck,
a message appears that the change line is implemented and the line will be set as Completed, not Canceled. An entry is
made in the change history and an FYI notification is sent.

Auto Cancellation of the Change Line

If the application detects an error when implementing or activating the change line, the change line gets canceled
automatically. If this happens you notice:
- an entry in the History tab indicating which change line is automatically canceled.

- the change line status appears as Canceled.

To proceed with the change line, you can move it to another change order.

Factors that Determine Whether you Can Cancel Change Lines

The following factors determine whether you can cancel change lines or not.

- the header status in a change order

- the progress on the header status.
If you aren’t the analyst (assignee), you must be assigned with the BPMWorkflowScmAdmin privilege,
regardless of the permissions defined in the additional workflow controls table.
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Note: If you modify the assignee, you must assign the BPMWorkflowScmAdmin privilege to the new

assignee.

Edit BAT_PD_CO_TYPE: Test_change_orders (2811)

Workflow

10Open

Draft £
Q S Not Start »

In Progress

Workflow  ummary

= No data to Bsplay.
- Not started - Indicates
progress on the

Draft - Indicates header header status

status

Affected Objects

Actions w Vieww [ " i Move Change Lines [y

?’,

Line Number Class Name Description Status

e 10 @ Root hem Class

TestNov1 Draft

| Draft - Indicates change line (or affected object) status |

When Can | Cancel Change Lines?

The table shows the criteria to cancel change lines:

Header Status Progress on the Header Status Change Line Status

Draft Draft Draft

Cancel Cancel Cancel

Open Open Open

Open Open Hold

Open Open Canceled (one line canceled)

Cancel Change Lines?

Yes

Not applicable

Yes

Yes

Not applicable

ORACLE
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Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Interim Approval

Interim Approval

Approval

ORACLE

Progress on the Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Failed

Failed

Failed

Change Line Status

Submitted for Approval

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Submitted for Approval

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Scheduled

Failed

Canceled (one line canceled)

Failed

Canceled

Completed

Approved

Submitted for Approval

Submitted for Approval

Chapter 10
Change Management

Cancel Change Lines?

Yes

Yes

Yes

Yes

Yes

Not applicable

Yes

Yes

Yes

Yes

Yes

Not applicable

Yes

Yes

Not applicable

No

No

No

Yes

Yes

Yes
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Header Status

Approval

Open

Interim Approval
Approval
Scheduled

Completed

Related Topics

Progress on the Header Status

Failed

Canceled

Canceled

Canceled

Canceled

Canceled

Change Line Status

Approved

Canceled (all lines canceled)

Canceled (all lines canceled)

Canceled (all lines canceled)

Canceled (all lines canceled)

Canceled (all lines canceled)

« Why did the Scheduled change order get promoted automatically?

Move Change Lines

Here are a few scenarios in which you can move change lines or affected objects:

Chapter 10
Change Management

Cancel Change Lines?

Yes

Not applicable

Not applicable

Not applicable

Not applicable

Not applicable

- The change order is stuck. Depending on the header status, you can move the change line to a new change
order and proceed with the change.

- The change order is automatically canceled. Depending on the header status, you can still move the lines to a

new change order.

Here are the factors that determine whether you can move change lines:

- The header status in a change order.

- The progress on the header status.

- The configuration for the move change lines action in Additional Workflow Controls for the change type.

If you're on update 21C or later, note that this action isn't controlled by the Reschedule Item Change Order

privilege.

The images show where the header status and the progress status are displayed:
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Edit BAT_PD_CO_TYPE: Test_change_orders (2811)

Workflow

1 Open

Draft (1
© R » Not Start >

InProgress

Workflow = ummary

= No data to Bsplay.

- Not started - Indicates
progress on the

Draft - Indicates header header status
status

Affected Objects
Actions w Vieww [ i (7] Move Change Lines [y
?’,
Line Number Class Name

Description | Status

e 10 @ Root hem Class

TestNov1 Draft

Ff)mﬂ - Indicates change line (or affected object) status

When Can | Move Change Lines?

The table shows the criteria for moving change lines:

Header Status Progress on the Header Status Change Line Status

Draft Draft Draft

Cancel Cancel Cancel

Open Open Open

Open Open Hold

Open Open Canceled (one line canceled)

Interim Approval

Interim Approval

Submitted for Approval

Move Change Lines?

Yes

Yes

Yes

No

Yes

Yes

ORACLE
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Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Interim Approval

Interim Approval

Approval

Approval

ORACLE

Progress on the Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Failed

Failed

Failed

Failed

Change Line Status

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Submitted for Approval

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Scheduled

Failed

Canceled (one line canceled)

Failed

Canceled

Completed

Approved

Submitted for Approval

Submitted for Approval

Approved
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Change Management

Move Change Lines?

No

No

Yes

No

Yes

No

No

No

No

No

Yes

No

Not applicable

Yes

No

Yes

No

No

No

No

No
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Header Status Progress on the Header Status Change Line Status Move Change Lines?
Open Canceled Canceled (all lines canceled) Yes
Interim Approval Canceled Canceled (all lines canceled) Yes
Approval Canceled Canceled (all lines canceled) Yes
Scheduled Canceled Canceled (all lines canceled) Yes
Completed Canceled Canceled (all lines canceled) Yes

Move Duplicate Change Lines

Here are some guidelines before you move duplicate change lines:

- If you need to move two or more duplicate change lines from one change order to another, you must select all
lines and move them in a single action. You can't move such lines one at a time.

- If a change line is canceled in the target change order, then you can't move the same item again as a change
line to the target change order. You must remove the canceled change line or move it to a different change
order before you move the same item to the target change order.

Related Topics
« Actions You Can Control

Understand Role Expansion in Change Orders

In the change order's Approvers table, roles are expanded to show all members of the role only in certain cases.

- If the approver is a role and Response Required From is set to All, the role is expanded to show all its
members.

- If the change is promoted to approval and the role has more than 40 members, it won'’t be expanded. You must
delete the role to submit the change for approval.

- If only one response is required on a user-defined approval and roles have been added as approvers, the roles
aren't expanded to show their members.

In either case, all members of the role receive notifications on completion of the change workflow, and you can track
who signed off. Note that the Assignee field in the notification is also not expanded to show all role members.

Edit Reference Designators on Changes

You can enter reference designators directly inline on the structure tab of the affected object, or in the side panel view.
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If your implementor has configured a range indicator for reference designators, you can enter a reference designator
range instead of entering each value.

Here's how you edit reference designators:

1. Navigate to the structure tab of the affected object on a change order.
2. Select the component for which you want to add or edit reference designators.
3. Edit reference designators directly in the Reference Designator column.

Here's what you need to know:

o To enter multiple values, use a comma-separated list of values, or a range, or a mix of both. For example,
if your administrator has selected '+' as the range indicator, you can enter 'A1+A5' and the application will
expand the range to create five reference designators: A1, A2, A3, A4, and A5.

o You can click the expansion button "..."' next to the reference designator cell to open a dialog box where
you can view and edit the expanded values for the reference designators. The expansion button is only
available for the row that's being edited. You can also enable or disable the quantity check and align
quantity from this dialog box.

o Use the drop-down list in the side panel to filter reference designator redlines. It includes the following
options: All, Added, Deleted, Modified or Unchanged. By default, All is selected.

o You can't edit the reference designators in the side panel, you can only edit the descriptive flexfields.
4. C(lick Save.

Manage Tasks in Change Orders and Change Requests

You can create a checklist of tasks related to the change order (or change request) and assign work to individuals.

You can make it compulsory for certain tasks to be completed by specified users before the change order can progress
to a status.

Here are some more details on tasks:

- Your ability to manage tasks depends on the permissions for the Add Tasks, Remove Tasks, and Update Tasks
actions in Additional Workflow Controls for the change type.

- You can mark the status of a task and assign tasks even after the change order is complete. Use this to manage
post-completion tasks such as documentation or qualification of contract manufacturers. Note that only the
change assignee can manage tasks in Completed status.

- The task can't be set as required if the Complete Before Status is one of the following: blank, first Open status,
Scheduled, or Completed.

Note: Status first Open indicates the first open status in case your administrator has configured additional
open statuses.

Here are some examples of tasks:
Prepare Functional Specification document.
Review and update cost attributes of affected objects.

Define regulatory attributes.

Publish information to Marketing and Sales.
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The Tasks table includes the following fields that let you specify task details:

- Sequence: Determines the order in which the tasks are performed. By default, this increments by 10.

- Required: Indicates that the task is compulsory for the change order to progress. If a task is compulsory, then a
Complete-Before Status must be specified.

- Assigned To: Specifies the person to whom the task is assigned.
- Assigned By: Specifies the user who assigned the task.
- Assigned On: The date and time when the task was assigned.
Note: If the same task has been assigned by different users, the Assigned By and Assigned On fields show details of

the latest assignment.

- Start-by Status: The status at which the tasks should be initiated. Includes current and future statuses, and a
blank value. Use the blank value when you want the task to being irrespective of the change status.

- Complete-Before Status: The status before which the task should be completed. Includes future statuses and
a blank value. Use the blank value to leave this field blank when Start-by Status is set to Completed.

- Need-by-Date: Indicates the date on which the tasks should be completed.

- Task Status: Can be updated only by the task assignee or the change analyst.

Copy Existing Tasks to New Change Orders

You can create a new change order based on an existing one, and copy over the tasks. Use the Save As action (in the
change order). Tasks in the newly created change order are reset to the Open state.

Related Topics
-« Why am | unable to update the task status in the change order?

- Understand Change Order Statuses

Secure Access to Changes

To secure a change order (or change request) from unauthorized access, you can add the users or roles who should
have access to it.

To add users or roles:

- Click the Security tab in a change order.
From Actions, click Add.
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Note:
If you're unable to add users, you must review privileges assigned to your role or create a data security policy
for change orders. For more information, see related topics.

- You can also secure extensible flexfields appearing on the change order. For more information see the related
topics.

Users in the Product Development and Product Information Management work area can view and approve change
orders, whereas users in the supplier organization can only view and publish change orders.

Here are some things you need to know about a new change order:

Until you restrict access, change orders can be accessed by all users including supplier portal users.

If a new user or group is added to restrict access, the change order creator and assignee are added
automatically.

- Toremove the creator and assignee, use the Delete All option.

To enable users to view or approve change orders, an administrator must also provide the necessary privileges.

When you search for a change order using any criteria, the search results show only the change orders that you're
allowed to view.

Track Modifications Made to the Security Tab

You can track modifications made to the Security tab of a change order (or change request) by using the View Item
Audit Trail report. Use the report to see who added or deleted entries in the list of users and roles.

1. From the Tasks panel tab, click View Item Audit Trail.

2. On the Audit Reports page, select the search criteria:
o In Product, select Product Hub.
o In Business Object Type, select Change Object Security.
o Click Search.

You can also use the History tab on a change to audit edits made to a change. For more information, see the related
topic on change history.

Related Topics
- View Change History

» Troubleshoot Issues in Change Objects
» Secure Extensible Flexfields on Change Types

View Change History

You can use the history tab on changes to audit edits made on the changes.
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You can also perform a comprehensive audit on the changes by opting in to the feature Track Affected Object Redlines
and Other Updates on Changes. You can then filter audit entries by any column (on the history tab) other than Date.
Once you opt in, history records are written for add, update, and delete action on:

- Change header general attributes, descriptive flexfields, and extended flexfields.
- Affected object redlines.
 Tasks.
Relationships.
« Security.
- Actions performed on affected objects.

History isn’t tracked for change attachments, affected object attachments, and supplier organization redlines.
Here are the key columns in the history table:

- Audit Type: Classification of audit.
- Action Type: Classification of audit action.
- Status: Status of the change at the time the audit row is written.
- Affected Object: Affected object that has been redlined.
- Affected Object Sequence: Sequence of the affected object that has been redlined.
Entity Type: Name of the tab or the attribute group.
Entity: Entity keys, if applicable.
- Action: Action on the change.
- Attribute Name: Name of the attribute that has been added, deleted, or updated.
- 0Old Value: Previous value of the updated attribute.
New Value: New value of the updated attribute.
- Comment: Shows additional information about an action.

- Author: Shows System when an action is performed by the application. Shows the user name when the action
is performed by a user.

Here are some considerations when you opt in for the feature Track Affected Object Redlines and Other Updates on
Changes:

- You will require the privilege View Change History (EGO_VIEW_CHANGE_HISTORY_PRIV) for a comprehensive
understanding of actions performed on changes.

- You must migrate history on existing changes using the Upgrade Product Management Data scheduled
process, or they will not be visible.

During the migration, rows may have missing data in certain columns, which depends on the availability of the
data prior to the migration.

- The History table displays 25 rows per page, but you can use Query By Example to refine the history records or
you can use Export to Excel to download all the rows.

- When you create or add an affected item to a change, a single row containing audit details is recorded in the
history table.

- You can import change history using the change FBDI template, and the application won't run any validations
while importing the data.
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In the Product Information Management work area, you must opt in for the feature Use Simplified Change
Management Interface to view the enhanced history tab resulting from the feature Track Affected Object
Redlines and Other Updates on Changes.

If you opt in for the feature on simplified change management after you have opted in for the feature on track
affected objects for some time, you must run the Upgrade Product Management Data scheduled process to
migrate the change history.

Related Topics
» Upgrade Product Management Data

Impact Analysis in Change Orders

You can launch an impact analysis from the Impact Analysis side tab on a change order or change request.
Start the impact analysis from an impacted product. Use either of the following:

From the Impacted Product panel look into the details for a specific impacted product.

Filter the multilevel item structure of the product, to see only that part of the item structure that is impacted by
the change. Thus, it is easier to focus on the relevant part of a larger item or document structure.

- Go to the Affected Object panel, select a specific affected object, and start an impact analysis from the toolbar
icon or Actions menu.

View the list of impacted products, and analyze why the product is impacted. Understand how many affected objects
impact the product. Adapt the change definition to achieve the intended list of impacted products. The impact analysis
opens the affected assembly and displays where the modified object exists in the impacted structure. The change order
originator and reviewers may use this impact information for decisions about the proposed changes.

Change Order Notifications

Notifications are sent to assignees throughout the lifecycle of the change order.

For a detailed list of new item request notifications, notification types, and recipients, see View Product Management
Notifications available on the Oracle Help Center.

Here's when the notifications are sent:
- When a change order is submitted, notifications are sent out to assignees, approvers, and the requester.
- When you start a step, notifications are sent to each of the assignees of the step.
- When the change order is approved or rejected, a notification is sent to the creator, and approver.

Notifications are of the following types:
- Task notifications are sent out to the assignees of each task.

FYI notifications are sent to the creator, assignee, requester, and approver of change order lines and headers
when it moves to Scheduled or Completed Status.
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Important Considerations about Notifications:

Note:

Note:

FYI notification is sent if you're removed as an approver or reviewer for the change that's in the current interim
approval or approval workflow status.

FYI notifications are sent to all the removed participants of the approval groups.

FYI notification shows who has rejected the change order approval request and the rejection comments for the
same.

Comments are visible in the rejection notification for change orders, change requests, problem reports, and
corrective actions.

You can see the comments provided when you're removed as a workflow participant.

If the approval notifications are delayed ensure that approvers have the following role:
EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV_OBI

The assignee in the notification refers to the users who are part of the approval groups. If your role is
designated as the workflow status participant, the Assignee field of the FYI notifications displays your role,
instead of your user name.

Sometimes, unanticipated issues prevent the workflow from getting completed as expected, and terminating
a workflow maybe inevitable. You can stop an approval routing workflow, even if it isn't completed using
Terminate Workflow. Related notifications, if any, are removed from the assignees' work lists.

In BPM worklist configuration, it's recommended that you make commenting compulsory when rejecting a
change order so that the rejection comments are captured.

Workflow participants (approvers, optional approvers, and reviewers) don't receive FYI notifications for change
workflow events that aren't relevant to them.

Only participants added to the current and previous workflow statuses receive notifications when:

o The change is rejected or completed.

o Autopromotion fails.

Participants added to future workflow statuses or skipped workflow statuses don't receive FYI notifications for
these events.

If the change moves through a status and is demoted, participants of the status through which the change
moved will receive a relevant FYI notification.
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Note:
- The number of affected objects displayed in an email notification depends on a threshold.

If the number of objects exceeds this threshold, a link to the change order page is provided so that you can
navigate to the object and view the full list.

For change order approval task notifications, the threshold is 25.

For FYI notifications, the threshold is 100.

- A predefined request comment notification is associated with the Open status. The change order can't move to
the next status until this notification has a response. The notification is then sent automatically to the assignee
and the requester.

This automatic notification can be bypassed by removing the assignees. If the notification is bypassed and the
BPEL process is set to automatically promote, then the change order automatically moves to the next status.
Otherwise, you need to manually move the change order to the next status.

- Change order notifications aren't sent for the following actions:
o Skip Current Assignment

o Suspend

o Create Subtask

o Request Information
o Route Task

o Add Comments

Related Topics
« What Change Orders Modify

- Understand Change Order Statuses
« View Change Order Notifications
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Notifications

You can view natifications for change orders, change requests, problem reports, and corrective actions. You can review,
approve and reject workflow requests in both the in-app and email notifications.

Note: You can view the details in a workflow notification according to the access permissions defined in the workflow
access control list. The information displayed in the notification matches the content of the workflow in the Redwood
interface.

Here are the notification types:

- Approval and Review
FYI

Requires comment

Approval and Review Notifications

The following attributes are available in all notifications:

- Organization
Description

+ Assignee
From

- Assigned Date

-« Task Number

Change Approval Notifications

Here are the attributes shown in change approval notifications:

In the Header details section:
o Change Number: A link that opens the details of the change order in a new page.

o Requester Comments: Comments submitted by the requester.
o Activity Type: An optional approval or approval notification.
o Response Required From: Response required from either one assignee or from all the assignees.
o Expiration Date
o Approval Status
o Sign Off As: The assignee is either an individual or part of a role.
« The Line details section has two parts:
o Affected Objects that includes the affected item number, item description, the old and new revisions (if
changed) of the item and the old and new lifecycle phases (if changed) of the item.

o Impacted Products that includes the impacted item number, item description, item revision, item lifecycle
phase, and the number of affected objects.
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Note: Impacted Products are shown only in Change Order notifications.

Review Notifications

Let's look at the attributes shown in the review notifications:

In the Details section:
o Change Number: A link that opens the change details in a new page.

o Comments: Comments submitted by the requester.
o Priority

o Reason

o Change Status

- The Affected Objects section includes the affected item number, item description, the old and new revisions (if
changed) of the item, and the old and new lifecycle phases (if changed) of the item.

Important Considerations

- Toinclude configured attributes, you've to reconfigure your Oracle Business Intelligence Publisher (BIP)
notification using the new template and add your preferred attributes.

- The application uses the configured BIP template:
o Change Order Participant Notification Report

o New Item Request Participant Notification Report

- To display additional attributes in the notification, you've to configure the new template.

FYI Notifications

The following attributes are available in notifications:

- Organization: when applicable

- Object Number or Object Name
- Status of the notification

- Assignee

- Assigned Date

- Task Number: when applicable

Change FYI Notifications

Here are the attributes supported in the Change FYI Notifications

In the Details section:
o Object Number: Link that opens the change details in a new page, depending on your profile option.

o Object Description
o Approval Status
o Need-By Date
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o

o

Priority
Reason

Comments: This is conditional. Comments provided by you're displayed only when the object is
approved, deleted, rejected or canceled.

<Rejected/Approved/Removed/Canceled> By: User who made the action.

Reject Reason: The reason is shown only when object is rejected.

- The Affected Objects for Change section: includes the Affected Item Number, Item Description, Item Class,
Effective Date, Iltem Status, Status, Request Id. This section isn't available in the Task Assigned Notifications.

- The Tasks section: includes task name, description, Required, Start-by Status, Complete Before Status,
Task Status, Assigned To, Need-by Date, Assigned By, Assigned On. This is shown only in Task Assigned
Notifications.

- When promotion fails, the Message section displays the following message: Error in workflow, see object action
log for more details.

Send Object FYI Notifications

Let's look at the attributes in the Send Object FYI Notifications.

In Contents section:

o

o

o

Object Type

Sent By

Recipients

Object Number or Object Name
Notification Type

Message: Message displays the comments you've provided when you send the notifications.

Assigned Notifications

You can now view the details in Assigned Notification. Click the link in your notification to review the details, or review
the details in your email notification.

Here are the details that are available in the Assigned Notification:

In the Details section:

o

o

o

Object Number: Link that opens the change details in a new page, depending on your profile option.
Object Description

Assignee

Assigned Date

Approval Status

Need-By Date

Priority

Reason

Task Number
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- The Affected objects for Item (for New Item Request) section: includes the Affected ltem Number, Item
Description, Item Class, Effective Date, Item Status, Status, Request Id.

Important Considerations

- After you've opted in, the application automatically uses the new predefined Oracle Analytics Publisher
Template:

o Workflow Notification Report

o Workflow Item Send Notifications Report
o Send Object Notification Report

o Workflow Send Object Notification Report

- To display additional attributes in the notification, you must configure the new predefined template.
Configuration is only available in change orders, change requests, problem reports, corrective actions, and
items.

Requires Comment Notifications

You can view requires comment notifications for change orders, change requests, problem reports, and corrective
actions when the status changes from draft to open and the Skip Request Comment option (on the change type) is
deselected. This is supported in both the in-app and email notifications.

Once the comment is submitted, an FYI notification with task completion details is sent to the assignee. Depending on
the configuration, change orders, change requests, problem reports, and corrective actions can be moved from open to
the next status either automatically or manually.

The application automatically uses the predefined Oracle Analytics Publisher template: Workflow Required Comment
Notification Report.

The following attributes are available in notifications:

- Organization
- Object Number: Link that opens the change details on a new page
Description
- Assignee
From: Only appears when an action is required
- Assigned Date
- Outcome: Only appears when a task is completed
- Approval Status
Need-By Date
« Task Number
Priority

Reason
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Publish Change Orders

Publication enables you to schedule and publish engineering change orders.

You can publish engineering change orders as an XML package. Use filters to select the type of change data you want to
publish, including attachment files.

Note: You can retrieve the publication files from Oracle WebCenter Content programmatically, or by using the File
Import and Export option available in Tools of the Navigator.

Here's how you publish an engineering change order:

1. Inthe Product Development work area, select an engineering change order in the Completed status.

2. Open the change order that you want to publish. Click Actions > Publish. You can also choose the publication
action from the Manage Change Orders page.

3. Select the entities that you want to publish in the Change Publication Criteria box. You can choose either some
or all the entities from the list.

o Affected objects

o Header attachments

o Affected object redlines only
o Affected object attachments
o Affected object structures

o Affected object AML

Note: The Include attachment files check box is enabled only when you select an entity that includes
attachment.

Click Publish. A confirmation box is displayed with the process number.
To see the report, click Tasks > View Scheduled Process.
Enter the Process Id in the View Scheduled Processes window.

Click View Output to download the published engineering change order. The output is available in a zip file
format. Click the file to download it.

No vk

Note: You can automate the publishing of engineering change orders using SOAP web services. You can also use the
ltem Publication event - PublicationJobCompleted to determine if a change order is published and automate the
additional steps.

Related Topics
« Refer to support note: Doc ID 13344711 Sample Soap Requests for Use in WebCenter Content (WCC/UCM) 11g
Calls to the GenericSoapService

- Refer to support note: Doc ID 2885473.1 Invoke, monitor and download the change order publication using
SOAP Web services
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View Published Change Order Reports

You can access the published file in XML format from the Oracle WebCenter Content.

Publication files for change orders are published to the FAlmportExport Security Group root folder in Oracle WebCenter
Content instead of the Contribution Folders location to avoid any limitation in the number of files that can be stored.

Use a Change Order to Redline an Item Structure

Redlining is the process of marking modifications to an item or structure that must be approved to be implemented.
This topic describes how to use a change order to redline an item structure.

To use a change order to redline an item structure:

1. Use Navigator to go to the Product Development work area.
2. From the Tasks panel tab, click Create Change Orders.

o From the Change Type list, select a type of change order.
o Inthe Name field, enter a name for the change order.
o Inthe Description field, enter a brief description.
o Click Save and Close.
3. Click the Affected Objects side tab.

o On the change order, click Select and Add to search for and add the affected object so that you mark it
for modification.

o Go to the Structure tab. From the results, select an item row.
o Go to the X icon and select Withdraw to withdraw the item from the structure.
o Click OK.

4. Now you must add a new item to the Structure.

o Click the Create icon.

o Select a class from the Class list.

o Inthe dialog, enter a name in the Name field.
o Enter a description in the Description field.

o Click Save and Close.

You can view the saved modifications in the summary of changes.
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Use a Change Order to Add a Manufacturer Part to an
ltem

This procedure creates a change order, adds an item, and associates the item with a manufacturer part.

1. Use Navigator to go to the Product Management work area. From the list of offerings, click Product
Development.

2. Create a change order, using the following steps:
o From the Tasks panel tab, click Create Change Order.
o Inthe Create Change Order dialog, select a change type. Click Save and Close.
o Enter the following details for the change order: number, name, and description.
o Select the priority.
o Click Save and Close.

3. Add the item as an affected object to the change order, using the following steps:

o Click the Affected Objects side tab and click Select and Add.
o Enter the item name and click Add.

4. After the item is added as an affected object, select the item and click Edit Affected Object.
5. Edit the item to add the manufacturer part, using the following steps:

o On the Edit Item page, click AML.
o Click Select and Add to add the manufacturer part as a recommendation.

o Select the manufacturer name, part number, status, and context. Click OK.

The manufacturer part is highlighted and includes a plus icon to indicate that it's a new assignment.

Note: The change order must be approved for the manufacturer part to be implemented.

o Click Save and Close.

How Application Validates Change Assignee

When you promote or demote a change order (or change request) to the next status, an additional check validates
whether the assignee is an active user. This check is performed for each status up to Approval status.

If the assignee isn't an active user, the promotion doesn't proceed. Demotion will proceed, and an entry is added in the
action log.

During manual or automatic promotion to Open status, if the application detects that the person who initially requested
the change is an inactive user, the change isn't promoted.
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During demotion, if the assignee is found to be an inactive user and Skip Request Comment is disabled, the Request for
Comment notification isn't sent. A corresponding entry is created in the action log. In this case, the user must choose an
active user as the assignee and then promote the change manually.

What actions can | take as an assignee on a pending
change?
You can take the following actions as a change assignee on a pending change.

Remove participants while approvals are in progress - includes approvers, optional approvers and reviewers.
- Terminate and restart the workflow.
- Cancel the change as long as it isn't completed.

Reschedule the effectivity date of the change.

How Revision is Calculated for Engineering Change
Orders

Here's how the next higher item revision number in an engineering change order is calculated.

In releases prior to 20D, only the past, current effective, or future effective (change order is scheduled) revisions were
considered.

From release 20D onward, all revisions (past, current effective, future effective, and pending) are considered when
searching for the highest existing revision number. Instead of retrieving the item revision with the furthest future
effectivity date, the application retrieves the item revision that was created most recently.

Here's how this impacts application behavior (from release 20D onward):

- The item revision identified as the base revision for new revision calculation changes because the application
evaluates the creation date of the item revision instead of the effective date. In case the calculated item revision
is already used, the application doesn't blank out the item revision number, but continues to increment the new
item revision number until it finds an unused number, so the user doesn't have to enter a number manually.

- The algorithm to calculate the next higher revision number supports up to 18 characters.

Note: When you add an item as an affected object to a change order, its revision is automatically bumped up. But
revision field remains blank when the bump-up mechanism fails to calculate the next higher revision in the following
actions: Assign to Change Order on an item, and Save As on a change order for creating an engineering change order.
When you access the Attachments tab on the change order, a message informs you to specify the new revision before
you can view attachments. If you don't specify the revision, you're prompted to specify it when you promote the
change order for approval.
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How Item Approval Privilege is Validated at Role Level

Make sure any role that you add as an approver, or a parent role, has the Approve Item Change Order privilege assigned.

When a role is assigned in the approvers panel of a change order (or change request), and the change

is submitted for approval, the application checks whether the Approve Item Change Order privilege
(EGO_APPROVE_ITEM_CHANGE_ORDER_PRIV) is assigned to the role (directly or through role inheritance). If it isn't, an
error is shown.

FAQs About Change Management

How do | add an item or document as an affected object?

Open the item or document and select Assign to Change Order from the Actions menu.

What's the difference between an affected object and a change
line?
Both the terms indicate an object affected by the change order.

Affected object is used in the Product Development work area and Simplified Change Management Interface.

Change line is used in the Product Information Management work area.

How can | create a new change order based on an existing change
order?

You can use the Save As action to create a new change order. In the Create Change Order dialog box, you must select
the change type for the new change order.

Here's what you need to know before you before using the Save As action:

Depending on the work area, you can choose to copy over the existing descriptive and extensible flexfields,
contextual attributes, attachments, tasks, and affected objects.

In the Product Information Management work area, you can save the change order to any type of
commercialization change order.

In the Product Development work area, you can save the change order to an engineering change order or
change order without revision control.

- To copy over the descriptive and extensible flexfields select the Additional Information option in the Save As
dialog box.
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What's the difference between Withdraw and Remove?

Use Withdraw, to delete a component that was added before the item was assigned to the change order.

Use Remove, to delete a component that was added after the item was assigned to the change order.

How can | view the list of change orders that are on hold or
canceled?

You can use OTBI to generate a report listing change orders that are on hold or canceled.

How do | add items or documents to an existing change order?

With a change order open, click the Select and Add button to add existing items or documents, or click the Create
button to add new business objects.

What's the difference between cancel and terminate actions in a
change order?

Use cancel to stop further processing of the change order. You can still move the change lines to a new change order
and retain redlines.

Use terminate to temporarily pause the workflow and resume it in the same change order.

Related Topics
« Terminate and Restart a Workflow

» Cancel Change Lines

Why am | unable to modify the change order?

The change order is in an Interim Approval status and the Allow Updates option on the Interim Approval status has
been disabled. Or, you only have privileges to view the change order.

Where can | approve or reject a change order?

Use one of the following to approve or reject the change order:
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Bell icon
- The change order page

Home page of the Product Development work area

Select the My Changes information tile. Click Approve or Reject appearing against the change order.
Email notification
BPM Worklist

You can approve multiple change orders from BPM Worklist. But the signature policy for change orders must be
disabled.

In Things to Finish section on the home page

Related Topics
» Configure the Signature Policy for Change Order Approval

How can | edit a pending revision in the context of a change
order?

Select Edit in Change Order from the Actions menu of a pending revision in the context of a change order to modify it.
The changes made will be redlined.

Why am | unable to edit the change order?

If the change order is created in Product Information Management, you can't edit that in Product Development.
Conversely, the change order created in Product Development can't be edited in Product Information Management.

Can | modify the find number when the item is on a change order?

You can modify the find number when the change is in draft or open status. Here’s how:
Delete a component and add it again with a different find number.
Or

Use the Replace action to replace a component with the same component and provide a different find number.
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How can | find out who acted on a change order and the changes
they made?

Open the History tab of a change order or change request to see the sequence of actions recorded for that object. You
can see who has performed each action along with the time stamp and the details about each action.

For example, you can see who approved the change order and the approval comments. You can also perform a
comprehensive audit on changes by opting in for the feature Track Affected Object Redlines and Other Updates on
Changes.

Related Topics
- View Change History

Why did the change order approval prompt for a comment and
password?

Your administrator configured the comment and password fields as compulsory for the purpose of audit. Enter your
sign-in password.

How can | restart the change order workflow which is on hold
when the approval is in progress?

From the Actions menu, click Restart Workflow.

I Note: You can't restart the workflow using Continue.

What's the difference between an engineering change order and
change request?

Both the change types permit you to route items and documents through a workflow.

The engineering change order lets you markup the required changes and the changes become effective on approval.
But the change request doesn't provide any markup.
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Why did the Scheduled change order get promoted automatically?

Since the Autocomplete on Cancel option is enabled by default from update 23A, all scheduled change orders move to
the Complete status on cancellation of the last change line. This is applicable to new and in-progress change orders.

Let's say that the first three change lines are complete, and the last change line is stuck in the Scheduled state. You
cancel the scheduled change line, and the change order moves to the Completed status.

Related Topics
« Create Problem Reports and Corrective Actions

« Understand Change Types

Why did the change order fail on approval?

Open the History tab of the change order to review the sequence of actions on that change order. Depending on the
action performed, the application displays a comment.

For example, if you try to promote two change orders simultaneously and the effective dates are less than 30 minutes
apart, then a comment appears advising you to maintain a time difference of more than 30 minutes. You can also see
the Workflow tab to review the change order status.

Related Topics
» Cancel Change Lines

Why am | unable to add or remove approvers during the change
order approval?

You must be assigned with the add participants and remove participants actions in the additional workflow controls for
the change type.

Additionally, the value of Response Required From (in the change type) must be set to All.

How can | add roles as approvers or reviewers while approvals are
in progress?

In the Search and Select: Users and Roles dialog box, you’'ve two options: Person or Roles. After you select the
participant, the Add Participant page is displayed.
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In this page, you can do the following:
- Change Activity Type to either Approval or Review.
« Change Response Required From to One or All.

- Add comments. These comments appear in the notifications sent to the new approvers or reviewers.

Note:

- You can only remove individual users if the user is part of a role and the response required from that role is set
to All.

- You can't add Activity Type = Optional approval when the approval is in progress. This is the existing behavior.
- You can't send different comments to approvers and reviewers in a single Submit action.

- When the change assignee is modified, the new assignee:
o won't receive the notification that the workflow is complete.

o can't perform BPM worklist actions such as reassignment on the current approval notifications.

Why did the change order workflow restart automatically?

If the schedule processor job is stuck in the initial run and it doesn't require any user intervention, the application
restarts the job. It restarts up to 5 times with increasing time gaps in between each job.

You don't need to manually search for unsuccessful change orders that weren't processed due to locked affected
objects.

Note: Anitem can be simultaneously updated from different sources. A record can be updated through the user
interface, while another update could be triggered through a web service or scheduled process. This results in locking
issues, and the jobs can't be complete successfully. In such scenarios, the application restarts the subsequent job after
some wait time and attempts to complete the job.

How can | remove a participant from the change workflow?

In the Change Status dialog box, select the participant and click Delete. You can also perform this action from the
Participants section on the change Workflow tab.

Note:

- Your ability to remove a participant depends on the permissions assigned in additional workflow controls for
the change type.
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How can | do a bulk upload of change order attachments?

You can do a bulk upload of change order attachments using REST services.
Here are a few things to keep in mind:

- The change order must be in draft, open, or interim approval status, and
In the change type, the Allow Updates option must be selected against the status.
Refer to the REST API for Oracle Fusion Cloud SCM guide for more information about using these REST APIs.

Why am | unable to update the task status in the change order?

You can only update the status for the tasks that are assigned to you. But your change analyst can update the status for
all tasks.

How many objects can | add to a change order or new item
request?

The default limit is 50 and the maximum is 100. Your administrator can change the default limit for:
- The number of change lines or affected objects in change orders, and
- The number of items in new item requests.
Here are some additional details:
- When you exceed the limit while adding items through the user interface, an error message appears.

- When you import a large number of items in a batch, you can choose to automatically split items and create
new change orders or new item requests.

Related Topics
« Item Batch Change Order Options

 Item Batch New Iltem Request Options
» Configure the Limit for Objects in Change Orders and New Item Requests

Can | set a default priority for my change order or new item
request?

Yes. You must set the default priority for a change type or a new item request type. The priority is inherited when you
create a new change order (based on the type) or new item request.
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Use the following tasks from the Product Management Offering in the Setup and Maintenance work area:
- Manage Change Order Types
- Manage New Item Request Type Details

To set the default priority, use the Priority field.

What actions can | take on a change order when it's in the
Completed status?

As a change analyst, you can take the following actions when the change order is in the Completed status:

- Manage change header attachments
- Manage change header attributes

- Manage relationships

- Manage security

- Add tasks

- Remove tasks

- Update tasks

- Move change lines

Related Topics
- Move Change Lines

In a change type, can | configure additional controls for the Draft
status?

No. But you can configure additional controls for Open, Approval, Interim Approval, Scheduled, and Completed status.

Related Topics
- Control Actions by Participants

How can | know whether the entire change order (or new item
request) was rejected or if a few items were rejected?

The approval notification provides details of whether the entire change order (or new item request) was rejected, or if a
few items in the change order (or new item request) were rejected.
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How can | set the reason code field on a change as a required
field?

You can opt in to the Simplified Change Management Interface feature and then use Page Composer to edit the Reason
Code field component and set it as required.

Related Topics
- Watch Video: Use Page Composer to Modify Interface Pages

Where are the change header attributes and change descriptive
flexfield attributes displayed?

In the Product Development work area and Simplified Change Management Interface, the change header and
descriptive flexfield attributes are available on the General Information tab of the change order.

Examples of change header attributes: Number, Name, Description, and Reason Code.

How do | know whether my approval is required or optional for a
change order?

In the approval notification, the Activity Type field indicates whether you're an approver or an optional approver.

Why should | claim the change order approval?

The Claim action enables you to review and approve the change order before another user in the role attempts the
approval.

This is because your administrator assigned the change order approval to a role and set the value of Response
Required From as One. So one response from a user in the role is sufficient for approval. Note that an approval
notification is sent to all users in the role.

Can | create a change order without adding affecting objects?

Although you can create a change order without adding affected objects, you can't route it for approval. But you can
create a change request without adding affected objects and route it for approval.
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Can | configure extensible flexfields for a change order?

You can configure extensible flexfields for a change type so that these fields appear at the header level on the change
order.

Related Topics
- Configure Extensible Flexfields for Change Types

Why am | unable to edit the extensible flexfields on the change
order?

Your ability to edit flexfields depends on the following:

- You must have the Manage Change Order privilege.

Permission for the Manage Change Header Attributes action (in the additional workflow controls table) must be
set to All or Additional Information. For example, if you are the creator of the change, the Creator column for
this action must be set to All or Additional Information.

- You must be assigned both view and edit privileges on the Edit Context page.

In the Security tab of the change type, your role or user ID must be assigned the same view and edit privileges
(that was assigned on the Edit Context page). For more information, see the related topics.

Related Topics
» Secure Extensible Flexfields on Change Types
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11 Affected Objects and Redlines

View Affected Objects and Change Operations

The Affected Objects page provides the following views:

Redline Summary
Manage Affected Objects

You can toggle between the Redline Summary View and the Manage Affected Objects view.

Redline Summary View
Displays links to Affected Objects and Change Operations.

Affected Objects provides a summary of redlines for each object. For instance, when you replace a component, the
summary tab shows that the original component redlined and the replacement component in green (which is different
from the initial color).

Change Operations provides a detailed list of modifications that have been done during the progress of a change order.
If you modify both an attribute of an affected object and its structure, two change operations are displayed in this view.
Change operations are recorded on items, AMLs, structures, attachments, and reference designators.

The table shows the change operations recorded on object types.

Object Change Operations Recorded

Item and Attachment Modifications

Structure Modifications and withdrawals

Reference Designator Additions, withdrawals, and modifications.

Manage Affected Objects View

To perform an action on affected objects, select the affected objects and click the Actions drop-down list.

Note: When you update an affected object directly on the item page, a message appears informing you to use an
existing change order or create a new one to update the item.

Here are some additional details about affected objects:

- The presence of a Has Redlines icon (or a red dot icon) against an affected object indicates that the item has
redlines.
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- To filter a large list of affected objects, you can use Query by Example.

- View Scheduling and Activation Reports: You can view the process ID of the change order scheduling and
activation processes; it includes hyperlinks to reports in the first 72 hours of report generation. Later on, only
the IDs appear.

- View Additional Item Details:

In the Affected Objects table, each item appears with an information icon (orange triangle) to indicate that
additional information is available. You can click it to bring up a panel with details such as item name, class
name, description, status code, revision code, and primary UOM. You can also drill down directly to item details
using the hyperlinks in this panel without losing the change context.

Fill in Attributes:

You can quickly replicate a just-modified attribute or attributes in the Affected Objects tables on change orders,
change requests, problem reports, and corrective actions. To do so, use the following actions:

o Fill Up (Ctrl+U)
o Fill Down (Ctrl+D)

o Fill Selected (Ctrl+S)

For example, you modified the value of an attribute, but you have more items with the same attribute that need
the same change.

To populate similar changes in a consecutive range of rows, use actions Fill Up (Ctrl+U), and Fill Down (Ctrl+D).
Remember that you’ve to select the table cell and modify the value in the cell for Fill Down and Fill Up to work.

To populate changes in nonconsecutive rows, select the required rows and then select Fill Selected (Ctrl+S)
from the actions menu.

Freeze Structure Columns on Change Orders

You can select and freeze a single column or a group of columns on the change affected objects structure table. This
enables you to easily work with data in large item structures and review different parameters against the item number
while retaining the context of the frozen column. Note that you can only scroll through the columns to the right of the
frozen columns or scroll through the columns that come after the frozen columns.

You can't freeze individual columns within an attribute group (for example, Component Details, Purchasing); you must
select the complete attribute group. This is applicable on the structure view of commercial items and on the structure
view of affected objects on changes. Here's how you freeze a column:

- Click the Affected Objects tab on the change order and then click the item.

- Click the Structure tab of that item.

- Select the column you want to freeze and click Freeze.

Related Topics
- Can | edit context specific attributes (or descriptive flexfields) on a change order?

« Replace a Component
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Redlines in Change Orders

Redlines are the individual changes on items and on reference designators that display mark-up. They're indications of
recommended, modifications, additions, or deletions (withdrawals).

Any modification to a single item attribute is counted as one redline. The same is true whether you're adding or
withdrawing an element to a structure.

Any modification to an existing structure attribute counts as a single redline. So, modifying the content of the reference
designator attribute is one redline, and changing a second attribute counts as a second redline.

Redline information for item extensible flexfield attributes are shown in the Additional Information tab, next to the
Summary tab. The Additional Information tab appears only when redline information exists for extensible flexfields.

I Note: Validations aren't executed on extensible flexfield attributes that aren't redlined in a change order.

Merge Redlines Through Import

You can incorporate redlines coming in through import into existing affected items on a change order. This helps in
reducing the number of outstanding changes, stuck changes, and overall change order cycle time. This is supported for
engineering change orders and change orders without revision control.

You can import redlines and merge these with existing redlines on engineering items that are assigned to a change
order. You can do this as long as the change is in draft or open status. The following modifications can be merged:

Item general information
[tem structure components
Reference designators

- Substitute components

- AML

For more information, see the related topic.

Redlines in Multi-Row Attributes

When you delete a row in an attribute, the row is immediately removed. However after you save the changes, the row
appears as redlined.

Undo Redlines

In structures and AMLs, you can undo redlines resulting from addition, deletion, and modification of components and
manufacturers

Here's how you undo redlines in a structure.

1. Open the change order and navigate to the item structure page.
2. Select the rows in which you want to undo the redline and click Undo Redline.

An Undo icon appears against the rows you selected.
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The following screenshot shows the icon against redlines from deletion, modification, and addition:

Actions v View v + BE X 0

Change

Operation Item

nm  COMP-10004A

l"'\. &9 COMP-10001B

iy &8 COMP-10001C

Note: You can also cancel the undo redline action. Select the row in which you want to cancel the undo
action, and again click Undo Redlines.

3. Click Save.

I Note: The undo action is complete only after you click Save.

Troubleshoot Missing AML Redlines

Prior to update 23D, AML redlines weren't being captured correctly on a few change orders because the date attribute
values weren't synchronized. From update 23D onward you can run the Upgrade Product Management Data scheduled
process to resolve this issue:

To update start date values for AML, run the Upgrade Product Management Data scheduled process with the following
settings:

Upgrade Process: Execution
Functional Area: ltem Relationships
Feature: Update start dates on AML and display redlines

- Commit size: 10

To see which AMLs need to be fixed, you can run the same job with the upgrade process set as Analysis instead of
Execution.

Related Topics
- Item Batch Change Order Options
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Effective Date and Revision for Affected Objects

You can specify an effective date for an affected object or set the use-up date (defined in Supply Planning) as the
effective date. An affected object can become effective on completion of the workflow, or on a future date.

Revisions for Affected Objects

Here’s what you need to know about revisions for affected objects.

If an object is assigned to multiple change orders, each revision must have different effective dates. For
example,

Revision B resulting from change order BOO1, can be effective January 1.

Revision C resulting from change order CO01, can be effective January 6.

- When assigning an affected object to a change order, you select the particular revision that you want to modify,
and also enter the new revision for the modified object.

- The revision you want to modify includes either of the following:
o Revision that's currently effective. Note that you can't select a revision that's pending approval.

o Revision that's scheduled to be effective in future and resulting from a change order in the Scheduled
status.

Effective Date for Affected Objects

Here’'s what you must know about the effective date:

- The effective date for the modified version must include a date that's in-between the existing effective dates.
For example, revision B can be effective January 1and revision C can be effective January 6. So the modified
version can include an effective date January 4.

- To ensure that item rules run effectively when you update rows in the affected objects table, the application
prompts you to save changes to lifecycle phase and effective dates separately.

Note: If you modify the effective date after you modify the lifecycle phase while saving the change order, the
application prompts you to save lifecycle phase changes before saving the effective date. If you first modify
the effective date, the application prompts you to save the effective date changes before saving the lifecycle
phase changes.

- When you use the Fill Down, Fill Up, and Fill Selected functions to save effective date changes across multiple
rows, the changes are automatically saved separately. So you won't see a validation message if you modify
lifecycle phase values immediately after that.

Set Use-Up Date as the Effective Date

When you remove or replace a component, you can view and select a use-up date specified in a supply plan as the
effective date for the affected object. The use-up date calculation helps you identify the optimal effectivity dates for
structure components that are being removed or replaced on engineering and commercialization change orders.
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Here's how you set the use-up date when you remove (or replace) a component:

Click the Affected Objects tab on the change order.

Open the affected object that contains the component you want to remove (or replace).
Navigate to the Structure tab.

Select the component you want to remove and click Actions > Remove.

Click Save and Close.

Click Actions > Calculate Use-up Date on the Affected Objects tab.

The Select Use-Up date dialog box appears with the use-up dates defined in the referenced plans for the
component (in the Supply Planning work area).

7. Select the use-up date and click OK.
The date you select is populated in the Effective Date column on the Affected Objects tab. If you manually
update the effective date, any existing values for Plan Name and Use-Up Item are cleared out.

8. Save your changes.

cCUuhAhUWUNRA

Some additional considerations:

- The Calculate Use-Up Date action is only visible if the Supply Chain Planning offering is enabled.

If you've enabled Supply Chain Planning but aren't using Planning use-up dates, the Calculate Use-Up Date
action won't retrieve any use-up dates.

- The Plan Name and Use-Up Item columns are hidden by default. You can use View > Columns to show these
columns if you're using planning use-up dates.

- When you add the effective date using the Calculate Use-Up Date action, the time is set to 00:00:00, because
Use-Up Date is a date-only attribute.

- The affected item’s effective date automatically changes to Effective on Approval if the specified effective date
is in the past by the time the final approver (for the final approval status) approves the change order. If this
happens, the Plan Name and Use-Up Item values are cleared out.

If you update the affected object's lifecycle phase, you must first save the lifecycle phase change before
updating the effective date using Calculate Use-Up Date.

Related Topics
» Overview of Supply Chain Planning Work Areas

« View a Plan

Resolve Revision Conflicts

An affected object can be assigned to multiple change orders.

When you add an item as an affected object to a change order, its current revision appears in the Old Revision column
and you can provide the new revision in the New Revision column.

If the same item is already assigned to another change order, another revision is created in parallel. When you complete
one of the change orders, the application detects a conflict for the other change order. When this happens, you're
prompted to resolve the conflict.

Here are some examples to show you what causes revision conflicts and how to resolve them.
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Scenario 1

Let's say you've assigned the same item to two change orders, CO1and CO2.

- COtisin Open or Draft status and is set to be effective on a future date.

Old Revision is A and New Revision is B.

- CO2is set to be effective immediately.
Old Revision is A and New Revision is C.
Now you approve and complete CO2.

Later, when you complete CO1 which has its old revision set as A, the application detects a conflict because CO2 is
already effective with revision as C. A message appears asking you whether you want to change the old revision value.

If you click Yes, CO1is put on hold and a batch job is created to correct the revision. On successful completion of the job,
the initial revision on CO1is changed to C, hold on CO1is removed, and you can then promote CO1.

Here's an image that shows old and new revisions before you resolve revision conflicts.

Affected Objects
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Here's an image that shows old and new revisions after you resolve revision conflicts.

Affected Objects
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The flowchart shows how revision conflicts are resolved when one of the change orders is in open or draft status:
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Scenario 2

Let's say you've assigned the same item to two change orders, CO1and CO2.

- COtisin Approval or Interim approval status and is set to be effective on a future date.

Old Revision is A and New Revision is B.
- CO2is set to be effective immediately.
Old Revision is A and New Revision is C. Now you approve and complete CO2.

Later, when you complete CO1which has its old revision set as A, the application detects a conflict because CO2 is
already effective with revision as C. A message appears informing you to demote the change order to open status and
resolve revision conflicts.

To demote CO1to open status, click Change Status > Open.

Note: From this step onward, the process is similar to the previous scenario.

To resolve revision conflicts:
From the Affected Objects tab on CO1, click Actions > Resolve Revision Conflicts.

Change order CO1is put on hold and a batch job is created to correct the revision. On successful completion of the job,
the initial revision on CO1is changed to C, hold on CO is removed, and you can promote CO1.
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How to Resolve Conflicts Manually

Click Actions > Resolve Revision Conflicts, on the affected objects tab of the change order. Note that in the scenarios
listed in this topic, you select the change order which is open, draft, approval, or interim approval status.

What's Carried Forward in the Resolved Revision

The modifications made to AML, description and structure are carried forward from the valid old revision to the new
revision (when conflicts are resolved). Note that attachments aren't carried forward.

FAQs About Affected Objects and Redlines

How do | know whether an affected object has redlines?

Navigate to the Affected Objects tab of the change order to identify redlines.

- The presence of a Has Redlines icon (or red dot icon) against an affected object indicates that the item has
redlines.

- Click the item to open it. If any of its side tabs contain redlines, the side tab icons are highlighted for easy
reference. For example, the Structure icon changes to a Structure-Has Redlines icon with a blue highlight.

Related Topics
« View Affected Objects and Change Operations

Can | edit context specific attributes (or descriptive flexfields) on a
change order?

Yes. In the Affected Objects tab on a change order, use the Context Segment drop-down list to select the segment
configured for the change type. The configured attributes appear next to the segment.

Note: If you're a supplier portal user, you can view the context specific attributes depending on the change type
configuration.

Related Topics
« Configure Context Specific Attributes for Change Types
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12 Workflows

Workflows in Product Development

Workflows provide a mechanism to submit change orders and change requests for review and approval. You can use
workflows to manage business objects such as items and documents.

The type of the change order determines the kind of workflow. You define entry criteria for the workflow to enter a
particular status; define exit criteria for advancing the change order to the next status.

The Workflow tab in a change order documents the progress of status changes. To view the details of a status, select
the status.

The History tab records the sequence of actions performed on the change order.

After the edits are made to attributes and structure, the change order can be submitted to a formal workflow to be
approved. Once the change order is approved, the item's revision is changed according to the scheme defined by the
administrator using the system's automatic naming.

Related Topics
« Define a Workflow

« Approve or Reject a Workflow
« How can I learn of problems with the statuses in my change order's workflow?
- Why is the change order workflow status in the wrong place in the order sequence?

Define a Workflow

When the administrator defines a change type, the process includes the definition of the workflow that will be available
when you create a change order of that type.

Define the Sequence of Statuses
You can define individual status to be used in the workflow, but each status must be derived from standard Status
Types:

- Open

Interim Approval

- Approval

- Scheduled

- Completed

Every workflow has at least the following statuses by default:

- Open
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- Approval
- Scheduled
- Completed

You can define multiple status of the types Open and Interim Approval. However, the statuses of type Approval,
Scheduled, or Completed can each occur only once in a workflow.

A workflow for a change order always begins in Draft status after it has been created.

Transition of Status

To execute a status transition, use the change status option in the change order workflow.

If there is a problem in changing a workflow's status, running an Audit Report of the change order may indicate issues
with status Entry and Exit criteria.

Hold and Cancel Statuses

A workflow can be put on Hold with the Hold status option. Later this workflow could be resumed by moving it to
another status.

A workflow can be canceled with the Cancel status option. However, once the Cancel status is set, this workflow can't be
resumed.

Review the Change Order Workflow

You can use the change order workflow tab to review the workflow status, date when the status changed, and details on
approvals.

The Approvers panel shows whether the approval is assigned to a role or a user. In case of approvals assigned to a role,
the panel also shows whether the approval is required from one or all users.

Approve or Reject a Workflow

To approve or reject a change, click the Approve or Reject button on the Workflow page. You can also request more
information, reassign, escalate, or suspend the change.

Note that these buttons are displayed only if the opened change order is waiting for approval. If a change order is
eligible for approval, a task notification appears in the Worklist panel.

To view more details about the change order, open the task details from the Worklist panel.

When you request more information from a user, the user must submit the information using Actions > Submit
Information (available on the change) so that the change can be approved.

Note: If a message appears during the approval informing you that the action is invalid or the user doesn’t have
the privilege, review the change history. Identify if more information was requested from a user. The change can be
approved once the user submits the information.
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Rejection Reasons for Workflows

Approvers of a workflow can select one or more rejection reasons when rejecting the workflow from the workflow
object, in-app notification, and the overview page.

This applies to all workflow types - change orders, change requests, problem reports, and corrective actions. The
selected reasons will be displayed in the History tab and in the workflow history.

Note: You can't specify rejection reasons from your email notification.

You can add Rejected Reason as an attribute to your Oracle Transactional Business Intelligence (OTBI) report for
approval details.

Related Topics
- Workflow Rejection Reasons

Terminate and Restart a Workflow

If an approval workflow for a change order is stuck, you can terminate and restart the workflow.

You can terminate and restart the workflow in an engineering change order, change order without revision control, and
engineering change request.

Note: Only the Assigned to user sees the terminate and restart actions in the Actions menu.

Here are some scenarios in which the approval can be stuck:

- Approver has resigned from the company.

- Approver is mistakenly added and doesn't want to approve the change.

- Approver is on leave and a vacation rule hasn't been set up.

- Something unanticipated prevents the workflow from being approved as planned.

To terminate the approval workflow, use the Terminate Workflow action from the Actions list. This action is only
available for the change order assignee.
When you terminate the workflow:

It stops and remains in the Interim Approval or Approval status.

Previous approval notifications for which the approvers haven't responded are removed. Notifications are
removed from: BPM Worklist, worklist information tile in the Product Development work area, and bell
notification.

You can modify the list of approvers and restart the workflow. Use the Restart Workflow action from the Actions list.
When you use this action:

- The workflow restarts from the status it was terminated.
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- New approval notifications are sent.

FAQs About Workflows

What's the difference between One and All in an Approval type
status?

For an Approval type status, on the Header Approval row, you can select One or All for the Response Required From
property.

One: Only one of the assigned approvers must approve the change order for it to advance.

All: All assigned approvers must approve the change order for it to advance.

How can | learn of problems with the statuses in my change
order's workflow?

Run an audit and obtain the audit report. In the change order, click Actions > Audit, and select a name on the menu.
Then click the Audit Results side tab.

Why is the change order workflow status in the wrong place in the
order sequence?

It might be due to an incorrect sequence number specified in the Manage Change Order Types task (available in the
Product Management offering).

Why did the change order go back to the Open status when
rejected from the Approval status?

The Automatic Demotion Status property on the Approval status was set to Open by the administrator.
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Why can't | promote or reschedule a change order | created using
an import map?
Change orders that are generated from item import maps are automatically approved.

However, the change order won’t be promoted or rescheduled if the effective dates of some affected objects in the
change line are less than 30 minutes apart. Ensure that there is a time difference of at least 30 minutes between the
effective dates of the affected objects before promoting or rescheduling the change line.
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15 Workflows—New

Create and Edit Workflows

You can use the Product Management Search Workflows page to search for workflows such as change orders, change
requests, problem reports, and corrective actions.

The workflow header attributes on the page header persist across all the tabs, providing context for the workflow. Here
are some actions you can perform on the workflow.

- Search across workflow attributes.
Use filter chips for header attributes, additional attributes, and extensible flexfields.
Use the spotlight to quickly navigate through the affected objects.
Redline the item directly in the change order context.
Drag (select and move) items from the clipboard or spotlight to the Affected Objects tab.
Preview attachments.
- View the workflow statuses and approvals in one table.
Manage participants for multiple statuses in the same page.
Use filter chips on tasks and relationships.
- Click the workflow links in OTBI reports to open the workflow in Redwood.

You can also perform additional actions using the More Actions (...) button.

Create Workflow

You can create workflows in multiple ways:

« Click the Add (+) icon from the Product Management Search pages for Workflow, Workflow Approvals, and
Workflow History.

Use the links available in Actions on the Product Management home page.

If you're editing an item that has a needs approval rule, you can either create a new change order or add the
item to an existing change order.

If you're editing an item, you can also use the Assign to action to assign the item to a new or existing change
order, change request, problem report, or corrective action.

Identify Workflow Status Using Color Codes

You can identify the workflow status by the color codes in the workflow search results and the status shown next to the
workflow title.

View and Modify the Required Descriptive and Extensible Flexfields

You can view and modify the required descriptive and extensible flexfields attributes when you create the change order
from Product Management Search page, move the affected objects, or assign the item to a change order. Both global
and context sensitive descriptive flexfields can be set as required.
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Note: The workflow deep links in the OTBI reports open the workflow in Redwood when profile option
(ORA_ACA_WORKFLOW_REDWOOD_ENABLED) is set to Yes.

The following header attributes are hidden by default for change orders and change requests, but you can display them
using business rules:

- Supplier Site
Reported By
Reported Date

You can access data in the following tabs on a workflow:
- Attributes
- Affected Objects
- Attachments

- Workflow and Tasks with sub-tabs
o Activities

o Tasks

Relationships
History

Navigate to a Redwood Page Using Link in Notification

You can navigate to a Redwood page by clicking the change number link on the notification. To use this feature, set the
profile option ORA_ACA_WORKFLOW_REDWOOD_ENABLED to Y.

Create a Duplicate Workflow

You can create a new workflow based on an existing one in Product Management. Use the workflow page-level action
named Duplicate.

Click Duplicate to open the Duplicate <workflow name> drawer.

In the drawer, you can select a different change type. For example, you can create a change order from a change request
or a change request from problem report. You can also select which entities— Attributes, Affected objects, Affected
object additional attributes, Attachments, Tasks, Relationships, and Relate to workflow—you want to include or
exclude when copying them to the new workflow. All entities are selected by default. Except for Relate to workflow, the
others are organized into tabs within the new workflow.

If the Relate to workflow remains selected, then a relationship will be created between the source and the new
workflow.

Attributes

You can search for attributes across sections, which can be accessed directly by selecting a filter chip. Includes filter
chips for General Information, Additional Attributes and Extensible Flexfield pages:

- Additional Attributes
o Includes global descriptive flexfields followed by context sensitive descriptive flexfields.

o Includes the Migrated attribute (Yes/No) that indicates if a workflow was migrated using import.
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o To edit context-sensitive descriptive flexfields on a change line, navigate to the context-sensitive
segment, select the relevant attribute section, and create or update values in the Additional Attributes
drawer.

Note:
o Inthe Main section of the Attributes tab, the visibility of the Source, Customer, Supplier and
Manufacturer attributes depends on the workflow type.
o To view change line context sensitive descriptive flexfields in the Additional attributes drawer,
you must change the Context Display Type to List of Values in the Descriptive flexfield setup

page.

You can create extensible flexfield attribute groups as pages if you want the filter chips to appear on the Workflow
Attributes tab. Here's how:

- Access the Manage Extensible Flexfields task in the Setup and Maintenance work area.
- Search for the flexfield code EGO_CHANGE_EFF and edit the Change Extended Attributes.

In Change Type Details, select the Add (+) button to create a new page for the selected change type. You can
edit the Display Name as you'd like it to appear in the filter chip.

In the table, use the Add (+) button to add your extensible flexfields to the newly created page.

Affected Objects

Here are some tasks you can perform on the Affected Objects tab.

- Select affected objects using the Select and Add Items icon (the item picker).

Drag and drop (select and move) items from the clipboard or spotlight to the affected objects tab.
- Search affected objects table to filter rows.

Edit the new revision, new lifecycle phase, and effective date directly inline.

o You can also use copy and paste to edit these attributes.

Edit descriptive flexfields in a drawer (side panel).

Export all the affected object lines or just the selected ones.
- Cancellines.

Move lines.

- Copy selected affected objects to the clipboard.

Here are some additional details on affected objects:

If your administrator has set up an access control list, your access to affected objects will depend on the
permissions specified in that list.

- When you click an affected object number link on a change order, change request, problem report, or corrective
action, it appears in the workflow context, enabling you to view the affected object and easily return to the
change request, problem report, or corrective action.

- You must edit the affected object lifecycle phase and effective date separately.
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- When you add an affected object to an engineering change order, the new revision is automatically updated
through REST APIs, and during import. However, the revision isn't automatically incremented in the following
scenarios:

o The affected item is included in another change order that is currently in Scheduled status.

o The existing revision doesn't not follow a standard or recognizable pattern, making it unclear what the
next revision should be. For example, if the initial revision is set as .001 or Z.

Data Presence Indicators

Here are the presence indicator icons appearing on the tabs of an affected object.

lcon @ indicates Has Content
Icon @ indicates Has Redlines

The presence indicator for redlines is also visible in Spotlight if any of the change controlled entities have been redlined.
Here’s a list of fields for a change type on which presence indicators are available:

Engineering change order
o Attributes

o Attachments
o Structures
o AMLs
- Change order without revision control
o Attributes
o AMLs
- Commercialization change order
o Attributes
o Structure

o Associations

Note: To upgrade the data presence indicators introduced for change orders in update 25D, you must run the
following scheduled process.
Upgrade Product Management Data

Functional Area: Changes

Feature: Update data presence indicators for affected items

Fill up and fill down

You can select a cell, grab the small square in the corner, and drag it vertically or horizontally to fill adjacent cells (or
select and drag cells) to modify affected objects.

To perform bulk edits, select multiple cells and drag them up or down.

To quickly update cells, right-click a cell and select Auto Fill.
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Note: When you copy and paste objects or do a bulk update of effective dates to update the same effective date on
more than 10 change lines, a scheduled process is triggered to update the dates on click of Save. The change order is
put on Hold status until effective dates on change lines are updated.

Resolve Revision Conflicts

When there are revision conflicts on the affected objects in the change order, you can resolve them using the Resolve
Revision Conflict action available on the Affected Objects tab. Additionally, the application will prompt you to address
any conflicts when you attempt to change the workflow status to Approval or Interim Approval.

Note:
- If your administrator has set up an access control list for items, your access will depend on the permissions
specified in that list.

- When you click an affected object number link on a change order, change request, problem report, or
corrective action, it appears in the workflow context, enabling you to view the affected object and easily return
to the change request, problem report, or corrective action.

- You must edit the affected object lifecycle phase and effective date separately.
- When you add an affected object to an engineering change order, the new revision is automatically updated
during import. However, the revision isn't automatically incremented in the following scenarios:
o The affected item is included in another change order that is currently in Scheduled status.

o The existing revision doesn't follow a standard or recognizable pattern, making it unclear what the next
revision should be. For example, if the initial revision is set as .001 or Z.

Permissions for Adding Affected Objects When Access Control List is Configured
On the workflow object:

- Go to Affected Objects tab and add the affected object.

You will require the Manage Permission on Affected Objects.

On the item object:
« Click Actions on an item. You will require the View or Manage permission on the item.

- Select Assign to Change Order and Save to change order.

To create a new change order, you will require the Create Permission.

To assign the item to an existing change you will require the Manage permission on the Affected Objects Tab for the
specific workflow.
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Open an Affected Item in Change Context

When you open an item in the context of a change order, here's what you must know:

- A hyperlink Change order <name> Context appears along with the page title to indicate that you’re in the
change order context. Clicking this link will take you to the previous page you were on, either the Affected
Objects page or the Pending Item Revision page.

- You can use the drop-down list (next to the change order name) to select the other affected objects, while
viewing an object in the change order context.

Configure the Send Object Action

You can use business rules (in Oracle Visual Builder Studio) to configure the following fields that appear in the Send
Object action.

Messages
Roles

Users

Undo Redlines

In structure and AML tabs in a change context, you can undo the redlines of both saved and unsaved changes of an
item's pending revision. The Undo Redlines button is enabled when one or more redlined rows are selected. An Undo
icon appears against the selected rows.

Here's how you undo redlines in a structure:

1. Open the change order and navigate to the item structure page.

2. Select the rows in which you want to undo the redline and click Undo Redlines.

3. You can cancel the undo redline. Select the row you want to cancel the undo action on, and again click Undo
Redlines.

The undo action is complete only after you click Save. Note that the action is only displayed in the pending revision
context.

Reschedule Change Lines

You can reschedule the change lines on a change order in the scheduled status, by updating the effective date and
clicking Reschedule.

Publish Workflows
To publish workflows, on the workflow click Actions > Change Publication Criteria.

Here are some additional details:

- You can publish engineering and commercialization change orders, and change orders without revision control
as an XML package by selecting all or one of the following entities:
o General Information

o Affected objects

o Header attachments

o Affected object redlines only
o Affected object attachments
o Affected object structures
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o Affected object AML

- You can publish change orders in any status.

- You can’t publish :
o Structures on affected objects for change orders without revision control.

o Attachments and approved manufacturers lists (AMLs) for commercialization change orders.

Edit Context Sensitive Descriptive flexfields

You can edit the context sensitive descriptive flexfields on change lines, navigate to the context sensitive segment of the
change line, and click the specific attribute section to create or update the values in the Additional attributes drawer.

Add Attachments on Change Lines

You can add attachments to the change lines on workflows such as change orders, change requests, problem reports,
and corrective actions.

Calculate Use-Up Date
You can calculate the use-up date and update effective dates on components.

If you've enabled the Supply Chain Planning offering, you can use the Calculate Use-Up Date action on the change
order’s affected objects table to view and select the use-up dates defined in the planning application. This helps you
calculate the optimal effective dates for structure components that are being removed or replaced on engineering and
commercialization change orders.

View Redline Information in Item Context
You can leverage the item page level action Red Lines Only to view item redlines quickly.

Selecting Redlines Only will only display tabs that have redlined data on the selected revision, and only display the
redlined fields within each tab. In the Redlines Only mode you can select the action Show All to return to the standard
view that displays all tabs and fields.

The Redlines Only action will still be selected when you navigate between items and item revisions in the following
ways.
Navigate between affected object revisions.
Navigate between the items in spotlight.
- Select pending revisions on the item.
Change the Item Class on Pending Changes and Enable Needs Approval Rule

You can modify the item class in a pending change. The modification will appear as a redline and be recorded in the
change history. Additionally, you can configure a needs approval rule so that an item class change automatically triggers
a change order.

I Note: You can't redline other fields when you redline an item class.

Attachments
Undo Redlines
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Here are some tasks you can perform on this tab.

- Add attachments.

- Preview attachments in a drawer (side panel).
o Use the arrows to scroll through multiple attachments.

- Search for and filter attachments.

- Download attachments.
Access to Download and View Attachments from Workflows

Access to download and view attachments can be secured by your administrator using an access control list. To
download and view attachments, navigate to the workflow page, click More Actions > Download Attachments. For more
details, see Access Control Lists for Workflows

Workflow and Tasks

Displays the workflow statuses with the following color coding:
- Green- Completed statuses
« Blue- Current status

- Gray- Future statuses

The current status is selected by default (in the workflow status diagram on the Workflow and Tasks tab), or you can
click the status to see the corresponding activity for that status.

You can configure business rules to show and hide column attributes on workflows, and show or hide the Activity and
Tasks subtabs.

Activity Subtab

- By default, displays the activity for the current status. You can remove the status filter chip to see all statuses for
the workflow in the activity table.

- Use filter chips to refine the results.

- Use the Manage Participants button to open a drawer where you can add participants for current or future
statuses.

o Select current or future status.

o Enter participant names to get a list of users or roles with matching names and use checkboxes to select
users.

Use the checkbox or highlight a name to delete it.

Tasks Subtab

You can add and edit tasks using a drawer.
- By default, displays all open tasks.
- Supports filtering.

+ Includes Completed Date.
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Relationships

You can create relationships using a drawer. You can add filters on:
Relationship Type
- Object Type
- Status

Revision (Item relationships only)

You can create rules between workflow objects.

- Add rules in the drawer using the + icon.

- View rules in the drawer using the eye icon.

You can also configure business rules to show and hide column attributes.

History

You can add filters on:
- Audit Type
- Action Type
- Status
- Author
Date (using Date Range)

- Action

You can also export all or selected history rows.

Workflow Actions

Here are some actions you can perform on the workflow:
Spotlight

- Click More Actions (...) and select the Spotlight action to copy all affected objects to the spotlight tab of the
Navigator.

- Click the item number link in the Spotlight tab to see the item and its redlines in the change context.

For change requests, problem reports, and corrective actions, the affected items are in read-only mode, as you can't
perform redlines.

Change Status

Use the More Actions (...) button to change the status of the workflow. You can also add participants while changing
the status.

Comment character count is visible as you type your comment.
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Related Topics
« Configure Context Specific Attributes for Change Types

Generate Workflow Summary Report

You can generate a summary report for the workflow.
From the Actions menu on the workflow, click Generate Summary Report.

In the report, you can only see items for which you have one of the following permissions: Discover, View, or Manage.
The report displays only workflow attributes. To access redline-related data, you must navigate directly to the affected
object.

Note: The Generate Summary Report action will honor the access control list only when it’s launched from Redwood.

Perform Guided Task Flow to Mass Replace Approvers or
Assignhees

You can use the guided task flow to perform a mass replacement of an approver or assignee. To do this, you must have
the necessary permissions granted through the access control list, along with additional workflow controls.

Here's how you replace approvers and assignees:

Navigate to the Product Management work area.

In Actions click Guided Tasks.

Select the task configured by your administrator for replacing approvers or assignees.
Select replacement user.

Search for and select the user (approver or assignee on the workflow object) you want to replace and the
replacement user.

A WN

You'll be prompted to select the user you want to replace and the user that you want to replace it with (that's the
replacement user).
6. Select one or more workflow objects from the result.

You can view the list of workflow objects where the user is being added as an approver or assignee. You can
choose one or more workflow objects for which you want to perform the replacement. You can further refine
your search by filtering the results of the where used query. You can view the total number of workflow objects
returned based on the query.

Note that only workflow participants associated with the current status are displayed, and replacements can
only be made within this status. Additionally, the current status must be Open, Interim Approval, or Approval.
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Replacements can’t be made if the status is Draft, Scheduled, or Complete. Similarly, assignees can be replaced
only when the workflow status is Open, Interim Approval, or Approval.

For example, if you're trying to replace John Doe, who's an approver in the Approval status, the replacement
won't take place if the current status of the change order is Open. The replacement can only occur once the
change order has reached the Approval status, and you run this guided task at that point.

7. Review and submit.

You can review and submit the task for replacement.
8. View replacement status.

Generate Change Approval Summary Using Generative
Al

You can use the Generate button on workflow objects within the Redwood page to create a formatted change summary.

The generated summary is included to the workflow's formatted description field and is supported for the following
workflow objects:

- Change orders

- Change requests

The Generative Al feature will create a common section across change orders and change requests, and provide an
overview based on the object description and additional details. This will include:

Main Attributes: Reason Code, Priority, Status
- Configured Descriptive and Extensible Flexfields
- Affected Object Number, Lifecycle Phase, Revision, and Status
- Workflow Attachment updates

Another section specific to change orders and change requests is also generated.
Change orders will include a section titled Summary of Changes and will provide Affected Object Redline information:
- Structure Component change action, tem Number Quantity, ltem Sequence, Lifecycle Phase and Revision
- AML change actions, Manufacturer Part Number, Manufacturer, Manufacturer Part Number Status, AML Status
- Substitute Component change action, Item Number, Item Sequence Lifecycle Phase, and New Item Number
Reference Designator change action
- Attachment change action
- Workflow Attachment updates

Change requests will include a section titled Affected Items and Relationships and will gather information from the
following:

List of affected items
List of relationships detailing Name, Type, Description, Relationship Type, and Relationship Status.
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Note: This feature is enabled by default and to disable the Generate button, set the predefined profile option
ORA_ACA_WORKFLOW_GENAI_FORMAT_DESC to No.

Points to Consider

- To get the best desirable response from Al, you can run the Generative Al feature several times, if required, for
the same workflow object.

Using sentence format in the Workflow Description field ensures an accurate summary.

Providing descriptive and extensible flexfield attributes with appropriate names and values will result in a
detailed summary.

- The response time of the prompt depends on the number of attributes, including descriptive and extensible
flexfields, as well as the number of affected items, and redlines.

- When you manually enter values in the Formatted Description field while editing a workflow object, and then
click Generate, your existing values will be replaced with Al-generated values. However, you can still revert to
the previous values by clicking Cancel on the section edit.

Related Topics
» Update Prompts Using the HCM Experience Design Studio Tool
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14 Relationships

Relationships in ltems and Documents

In an item or a document, you can add related objects for the item you are working on.

When you set a relationship from one business object to another (or manufacturer part or change order), the
association is established in both objects; that is, both objects display the name of the other, related object as a live link.
Click the link to open the related object in its own dynamic tab.

There is no differentiation or hierarchy to relationships.

Use the Add icon + or Actions > Add; the Add Relationships dialog appears. You will only see objects for which you
have privileges. You can click the Refine button to bring the familiar fields for Advanced or Basic searches. The Search
list provides available types of objects that can be searched; the default is Items.

Some details about each item returned on the search appear on mouse hover-over, including the item's Name, Revision,
and Lifecycle Phase. Only the latest revision of any item is returned on the search.

If you select an associated object, the Delete icon X and Actions > Delete are enabled.

Relationships with Business Objects in Other Applications

The administrator may have set up object types from other compatible applications on your system. These external
object types may be listed on the Relationships Search list. For instance, if there are Oracle Cloud Innovation
Management applications configured on your system, object types such as Concepts, Requirements, and Ideas are
available for your search.

Product Development items are specifically available for relationships with Innovation Management business objects. If
a relationship is established between a requirements specification or requirement and an item, and the requirement is
modified in any way, the relationship link to the requirement in the item is then tagged with an indicator with the label
Has changed. (The indicator or icon displays this tool tip.)

A relationship may also be established to an object in another, external application. However, you may find your
privileges to modify such an object are more constrained than objects from Product Development. See your
administrator.

CAD for Cloud Integration

The CAD for Cloud integration enables functional users in the CAD development process to coordinate and relate
designs in Agile PLM to items in Product Development. You can relate a design in Agile PLM to an item in Product
Development with the Publish Workbench tool on the Affected Files tab of a design file change order. You can also
remove the relationship. Once a design object is successfully related to a Product Development item, the relationship
between the two objects is included on the Relationships tab of the design in Agile PLM. It also appears on the item's
Relationships table in Product Development.
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Relationships in Change Orders

You can use the Relationships tab in change orders to track relationships created automatically or manually between
change orders and other objects.

Here are a few examples:

Example 1: Let's say a change order is created from a quality action. Then a relationship is automatically created
between the change order and quality action.

Example 2: Let's say a change order is affected by a quality action. Then you can manually create a relationship between
the change order and quality action.

Note:
From update 23C onward, you can add, update, or delete relationships in canceled change orders. This means
you can also delete a canceled change order after deleting its relationships.

- You can make changes only on the Relationships tab, not on any other tab.

It's not recommended to add new relationships to canceled change orders.

Relationship Type

You can select a Relationship Type (on the Relationships tab) after the relationship is created. Here are the relationship
types:

Fulfills, Fulfilled by, Impacts, Impacted by, Verifies, Verified by, Validates, Validated by, Tracks, and Tracked by, and Split
by import.

Note that Split by import appears selected if the change is created through import and is split during import. A
relationship is automatically created between change orders split during import.

Add Rules to Validate Relationships

Let’s say a quality issue is raised against a defective part, a quality analyst raises a quality action. The defective part
contains a defective structure. So a change order is created from the quality action and a relationship between the
change order and quality action is automatically created.

When the defective part is fixed and released through the change order, the quality action is resolved. This change
order's release indicates that the quality action is validated.

For additional validations, you can create rules.

To add a new rule, click the plus ( +) icon on a change order's Relationships tab. The rule specifies the status that the
change order must be in (or reach) for the quality action to move to an appropriate state. You can change or delete the
rule.

The default rules are: release of the pertinent change order is the only means to validate the related quality actions;
validation of the pertinent quality actions is the only means to close the quality issue.
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Relationship Rules for Changes, Problem Reports, and
Corrective Actions

You can create relationship rules between change orders, change requests, problem reports, and corrective actions.

Use these rules to change the status of one object when the status of a related object is changed to a specific value.
For example, you can create a rule to close a corrective action when a related change order is implemented. Here the
'source’ object on which the rule is defined is the change order, and the 'target' object that the rule should act upon is
the related corrective action.

You create relationship rules using the Add Rule button on the Relationships tab of the source object. Before you create
a rule, the target object must be added as a related object on this tab.

When you add a rule, it lists the source object and then the target object.

Rule Syntax: When <source object name> moves to <status name> status, Move <target object name> to <status
name> status.

Rule example: When ECO 567657 moves to Completed status, move corrective action Keyboard Malfunction to Closed
status.

When the rule is triggered and the target object moves to the specified status, you'll see the action recorded in the
History tab of the target object.

Considerations:

- A relationship can only have one rule. However, this feature supports one-to-one, one-to-many, and many-to-
many relationship rules between the source and target objects.

- You can add or delete rules on both the source and target objects as required.

Note: Users with permissions for the Manage Relationships action in Additional Workflow Controls set to Yes can
add relationship rules.

On the Relationships tab of a change object:
- Click the +icon to create a rule.
- Click the pencil icon to edit the relationship rule.

- Click the X icon to delete the rule.

The rule doesn't trigger if the target object:
hasn't reached the status just before the status specified in the rule.

- is canceled.

Here are some points you must remember while choosing the target and source objects and setting rules:

The source object status can be in any status type except Scheduled.

- The target object status can be in any status type except Scheduled or Completed.
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If a rule fails, you can manually move the target object forward.
- Approval steps won't be skipped.

- The target object moves to the specified status even if you don't have access to edit the target object.
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15 Attachments

Manage Attachments in Items and Change Orders

The Attachments side tab on an item displays a list of documents or graphics or other files that have been attached to
the item. The application tracks changes to attachment file attributes such as name and description.

Attachments on items are subject to change control. You must create a change order to authorize and approve
modifications to attachments. Also, you can't modify an attachment on a released item without a new change order.

You can download item attachments for either first or all structure levels by using the Download action on an item
page.
Here's what you need to know before you download attachments:

- You can download the following attachment types: text, URL, and file. The application manages special
characters and duplicate file names in the attachment title.

- The content of a text attachment is stored in a text file, and the file name is composed of the text attachment
title with the suffix .txt.

If the title information is unavailable or the title contains special characters, then the file name is composed as
TEXT.txt.

- To distinguish multiple instances of the same file name, the application adds a number (#) to the file name. For
example, TEXT.txt, TEXT(1).txt, TEXT(2).txt.

- A similar behavior is available for attachments of type URL. However, the standard file name is URL.txt.

- To distinguish multiple instances of the file name of type DOC, the application adds a number (#). For example,
FILE.doc, FILE(1).doc, FILE(2).doc.

Note: If the download for an item attachment fails, you can use the application severity and Enterprise
Scheduler Service logs to identify attachments with missing file extensions, the file path, and the associated
components.

Attachment Redlines

The modifications to item attachments are called redlines. Redline information for an item is captured in its
Attachments page. The Redline Summary panel displays the attachment modifications. Attachment modifications are
counted in Change Operations.

Change Order Attachments

An attachment on a change order is a document that further explains something about the change order.

You can select Download Attachments from the Actions menu of a change and choose from the following options to
specify which attachments you want to include.

From Affected Objects you can download:
o Redlined: Includes only the redlined (added, created, or modified) attachments of affected objects

o All: Includes all attachments of affected objects
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o None: Excludes attachments of affected objects

- From AML you can download
o Redlined (default option): Includes only redlined (added, created, or modified) manufacturer part
attachments
o All: Includes all the manufacturer part attachments

o None: Excludes manufacturer part attachments
If you select None for both affected objects and AML, the Submit button is disabled.

The Download Attachments action also appears in the change history.

Actions on Attachments in a Change Order

Once the item holds an attachment, the Attachment page actions include:

. CheckIn
« Check Out
- Cancel Checkout

To associate files with items, use the Add icon + or Actions > Add.
If you select a listed attachment, the Delete icon X and Actions > Delete are enabled.

If you find the attachments Add icon + or Actions > Add is disabled, possible reasons are: the item has another, later
revision; or, the item is currently on a change order.

Related Topics
- View Affected Objects and Change Operations

Considerations for Managing Attachments in Items and
Change Orders

Attachments are handled differently in Product Information Management and Product Development work areas.

Here's what you should keep in mind if you're creating and managing attachments in both Product Information
Management and Product Development.

Product Information Management Product Development

Supports item-level and item revision-level Supports only item revision-level attachments.
attachments.

Item and item revision-level attachments  After an item is released, item revision attachments can only be edited by redlining through a change
can be edited through the item, but not order.
through a commercial change order.
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Product Information Management Product Development

Item revision attachments don't flow to the Item revision attachments flow automatically to the next revision, unless deleted.
next revision.

Item images are stored and shared as Item images are stored and shared as item-level attachments.
item-level attachments.

Note: When you add an attachment to an item in Product Development, it will be visible on the item in Product
Information Management only if the item is in a higher lifecycle status than Design. Note that the attachment appears
in Product Information Management as an item revision-level attachment, not as an item-level attachment.

Best Practices

Here are some best practices for managing attachments:

- Use item-level attachments to associate unstructured content and additional details with an item. These
attachments aren't revision-specific; they apply to all revisions of an item.

- Given that these item-level attachments aren't change controlled, always use the actions available on the
Attachments panel from the Product Information Management work area to manage changes to these
attachments.

- Always add attachments to a change order using the +Add button on its Attachments tab to ensure proper
association and auditing. Avoid adding attachments directly from notifications.

FAQs About Attachments

How do | attach files to an item or change?

On an item, document, or change, click the Attachments side tab and then click the Add Attachment icon.

You can optionally associate the file to an attachment category. Attachment categories defined by your administrator
are displayed in the drop-down list for selection. The default attachment category is Miscellaneous.

Related Topics
- Attachment Categories for Changes

- Attachment Categories
- Manage Attachment Security

Why can't | attach files to an item or document?

You need to attach some files to an item or document, but the Add icons on the Attachments tab are grayed out. The
item or document either has another Revision or is on a Change Order currently.
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How can | view redlined attachments for a change order?

On the Edit Change Order page, select Download Attachments from the Actions menu of a change and choose from
the given options to specify which attachments you want to include.

Related Topics
» Manage Attachments in Items and Change Orders

Will attachments | add in Product Development show up in
Product Information Management?

The attachment you add for an item Product Development is visible in Product Information Management only if the
Product Development item is in a lifecycle phase higher than design.

Note that the attachment appears as an item revision attachment in Product Information Management.
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16 Roll Up Costs

Overview of Cost Rollups in Product Development

As part of product design and development, design engineers need estimated costs of a product or its components and
assemblies. During new product development, users build products by using new items and by reusing existing items.

For existing items, costs may have been captured in a costing solution, such as Oracle Cloud Costing. This company can
use costs captured in the costing solution to estimate the costs of the product during product design and development.
For new items, and for existing items that have no set cost, design engineers must provide a high-level estimate of
costs directly to each item.

Note: Documents aren't supported by cost rollups.

Display Costs in Product Development

The following capabilities are supported for cost rollups. Existing or "historical" items in Cloud Costing may provide
costs to Product Development, but the cost rollup functions don't depend on being connected to a deployment of
Costing.

Costs in the Costing solution are based on an inventory organization. To support this, Product Development

can determine what inventory organization to use, to retrieve costs. This option can be disabled if the company
doesn't deploy Costing. By default, the inventory cost organization is the same as the default Product Development
organization, which is the Master Organization.

The Material Cost, Overhead Cost, and Total Cost fields are on the General Information page of an item. On a
structure - a subassembly or top-level assembly - choose Refresh Cost from the list; this retrieves from Costing the
latest costs of all child items and performs the rollup.

Display Costs for a Leaf Item

The Material Cost of an existing item may be retrieved from Costing.

If the item had a cost in Costing, the Material Cost of the item in Product Development is Read Only.

If an item had no cost in Costing, or it's created in Product Development, its Material Cost may be entered, and
it remains an editable field.

For a leaf item, Overhead Cost and Total Cost are always Read Only fields.

Note: The leaf item appears at the end of the entire structure.

Let an item be an assembly, which has a user-entered Overhead Cost; should it become a leaf item, its
Overhead Cost is no longer displayed.
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Display Costs for a Structure

Determining the cost of a structure, or assembly, depends on the completeness of the data on the child items of the
top-level item.

- Material Cost of an assembly is rolled up from the child items. Material Cost is a Read-Only field for an
assembly in PD.

- Overhead Cost for a subassembly or top-level assembly can be entered manually, and it remains an editable
field.

- Let there be aleaf item, which has a user-entered Material Cost; should it become an assembly (top-level or
otherwise), its Material Cost is no longer displayed.

- An assembly's costs may be incomplete because not all of its child items have been assigned costs. To indicate
that the assembly cost is incomplete, a warning icon is displayed next to the Total Cost attribute.

Business and Validation Rules

This topic lists various rules that govern cost rollups in Product Development.

Business Rules of Cost Rollups

This table displays the Material Cost, Overhead Cost, Total Cost and several conditions of Status and Revision for an

Item or a Structure and indicates if the field can be edited or is Read Only.

Item Type Item Status Item Revision Material Cost Overhead Cost Total Cost
Leaf Not Released (new Initial (Rev A) Editable (unless cost Not editable Not editable
item in preliminary came from Costing)
state)
Leaf Released Latest Editable (unless cost Not editable Not editable
came from Costing)
Leaf Released Not latest Not editable Not editable Not editable
Leaf Pending change order = Any pending rev Editable (unless cost Not editable Not editable
came from Costing)
Assembly Not Released (new Initial (Rev A) Not editable Editable Not editable
item in preliminary
state)
Assembly Released Latest Not editable Editable Not editable
Assembly Released Not latest Not editable Not Editable Not editable
Assembly Pending change order = Any pending rev Not editable Editable Not editable
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Item Type Item Status Item Revision Material Cost Overhead Cost Total Cost

Validation Rules of Costs

Rules that apply to the expression of costs.

If the user can enter the cost, it must be a positive value (that is, $0 or greater).

- Users may enter any number of digits after the decimal; however, the application only displays four digits after
the decimal.

FAQs About Roll Up Costs

Can an item's material cost be edited, even if it is retrieved from
costing?
The material cost cannot be overwritten by the user.

However, if the original cost record has been deleted in Costing, that item no longer has a cost, the material cost of the
leaf item can be edited in Product Development. The original material cost will be removed in the Product Development
item.

Can a cost be specific to a revision?

Yes, if you set the cost of an item in Revision A at $10, and create a Revision B and set the cost to $12, the item's rev A
displays as $10 and rev B displays as $12.

Does costing capture revision specific costs of items?

No.

Costing provides costs based on effectivity dates. When Product Development retrieves costs from Costing for a leaf
item, it will use that cost for all revisions of the item, regardless of the item's effectivity date. If a leaf item has a cost of
$15 from Costing, the amount will carry to any future revisions of the same item - as long as it's still a leaf item. If the
cost of the item changes in Costing to $20, the next rollup in Product Development displays the cost of that leaf item as
$20, which would carry to future revisions of the item.
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What happens if an item with a material cost becomes a structure?

If this occurred in the same revision, the original material cost is removed and becomes read-only for the structure or
assembly.

Note that it could still be stored in the schema so that it can be used in a future release. If this occurred in a newer
revision, the material cost remains visible for the previous revision of the item, when it was a leaf item. In the new
revision, the material cost is rolled up from the child items.

Can costs be redlined through a change order?

No, costs can't be redlined through a change order.

What formula is used to calculate total cost?

Material Cost of an assembly is always the rollup of the total costs of its children, including the quantity.

For example, if the total cost of a child item is $10, and there are 5 of these in the structure or assembly, the material
cost of that assembly is $50.

- Total Cost of a leaf item = Material + Overhead (although Overhead will always be 0)

- Total Cost of an assembly = Rolled up Total Costs from the children + Overhead

What happens if the Inventory Cost Organization of an item is
changed to another organization?

When you change the organization of an item, the next time you roll up that item, the cost from the new organization is
used.

If the item, with its original organization, had a cost from Costing, but the new organization doesn't have it, the cost for
the item in Product Development is deleted. This lets you to manually provide a new cost.
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17 Manage Objects from Supplier Portal

View Items on Supplier Portal

As a supplier portal user, you can view the following side tabs on items:

- General Information - the default or cover page of an item.
You can view an item's revision number and the corresponding change order from the Revision list. Note that
canceled item revisions don't appear in the list.

- Attachments - text or graphic files, or URL, with more information about the item.
- Structure - the Bill of Materials for assemblies, products, and other collections of items.

- AML - approved manufacturers list; represents a list of manufacturers, suppliers, or vendors approved for the
purpose of procuring manufactured items.

- Changes - lists changes that the item is on.

- Quality - problem reports, or corrective actions to which this item is added.

- Where Used - displays those item-structures to which the item is added.
History - shows data changes made to audit-enabled item attributes.

Content Presence Indicators

The following content presence indicators help you quickly access item and component details:

- A blueicon indicating the presence of content appears on the item's side tabs. Additionally, when you hover on
the tab that has content, the tooltip displays Has Content.

Note: The General Information tab icon isn't displayed in blue since it always has content.

Blue dot icons on structure component rows indicate the presence of pending changes and quality-related
data. You can click the blue dot to navigate to the corresponding details in the side tab.

For quality objects, the blue dot appears if there is at least one quality issue, quality action, problem report,
or corrective action in any workflow status against any item revision. Note that the object can be pending or
released.

When you click the blue dot on quality objects, only problem reports and corrective actions appear in the
Quality side tab. You can only see and navigate to those objects for which you have access.

Create Problem Reports and Corrective Actions

You can create problem reports and corrective actions from the:

- Create (+) menu on the Overview page in the Quality management work area
- Actions menu of an item in the Product Development work area
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- Actions menu of an item in the Product Information Management work area

You can see that they appear on the Quality tab of items in the Product Development, Product Information
Management, and Quality Management work areas. Remember that the Create Problem Report and Create Corrective
Action options appear on the Actions menu only after you create and save an item.

For suppliers the page reloads with the newly created object.

Note: The newly created problem reports and corrective actions automatically display organization data from the
item.

The workflow of a problem report or corrective action progresses as specified by the statuses defined by the
administrator. For more details, see Set Up Problem Reports and Corrective Actions.

Create 8D Corrective Action.
You can choose to create a corrective action from the following two options in the Type drop-down list:

- Corrective Action — action to mitigate a quality issue and prevent its further occurrence.

- 8D Corrective Actions — action that uses the 8D methodology. An investigative dive to find the cause of a
problem, a solution to fix it and a method to prevent recurrence.

The 8D methodology involves a systematic investigation into the root cause of a problem to prevent recurrence. It uses
a structured, preconfigured template based on 8 disciplines to define the problem, identify the root cause, and run the
corrective and preventative action (CAPA) to prevent recurrence.

Here's a brief description of the eight disciplines:

1. Plan and form team: Create a plan to minimize or mitigate the problem and establish a team of skillful and
knowledgeable people

Define Problem: define and describe the problem

Interim Containment: define and implement containment actions

Determine Root Cause: identify the root cause

Verify Correction: verify and choose the most effective corrective action

Implement Corrective Actions: implement the corrective actions

Prevent Recurrence: implement actions to prevent a recurrence

Recognize Team Effort: acknowledge and congratulate the collective effort of the team.

0Oy U hWON

Note: Although the change type 8D Corrective Actions is predefined, the attribute visibility setting is read-only. The
change type inherits the configuration from its parent change type, Corrective Action.

Create a Corrective Action from a Problem Report

You can also create a corrective action from the Actions menu of a problem report. The corrective action opensina
dynamic tab for editing. For suppliers the page reloads with the newly created object.

While creating a corrective action from a problem report, you can select to copy over the descriptive flexfields,
attachments, relationships, and tasks for the problem report. You can also copy over the affected objects including
descriptive flexfields to the new corrective action. The corrective action is automatically linked to the problem report in
the Relationships tab.
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Related Topics
« Overview of Change Type Setup

« Configure Change Orders
- Understand Change Types

View Changes on Supplier Portal

As a supplier portal user, you can view the changes for which you're granted access.
Here are some of the side tabs available on change orders:

- General Information - the default or cover page of a change order.

The General Information tab displays the cover page details including the trading partner reference attributes
like Customer, Supplier, Manufacturer, and Source. The trading partner reference attributes exposed to the
business user are displayed in the supplier portal.

- Affected Objects - items and structures (including components) that are the subject of the proposed change
or modification. Items can contain problem report, or corrective action.

To view the structure, open the affected object and click the Structure tab.

- Attachments - text or graphic files, or URL, with more information about the change order. As a supplier portal
user, you can only view attachments for which you're assigned permissions.

Content Presence Indicators on Affected Object Structure

Content presence indicators on the structure tab of the affected object provide quick access to changes and quality-
related data.

Here's what you need to know:

Blue dot icons on structure component rows indicate the presence of pending changes and quality-related
data. You can click the blue dot to navigate to the corresponding details in the side tab.

For quality objects, the blue dot appears if there is at least one problem report, or corrective action in any
workflow status against any item revision. Note that the object can be pending or released.

When you click the blue dot on quality objects, only problem reports and corrective actions appear in the
Quiality side tab. You can only see and navigate to those objects for which you have access.

Submit Change Requests from Supplier Portal

If you're a supplier portal user, you can submit change requests to suggest changes to a released item.

You can also initiate the change request workflow by changing the status from Draft to Open. Once the request is open,
the change analyst receives a notification.
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Note:
- The change analyst (or change request assignee) is configured by the administrator as part of the change type
setup.

If you're unable to manage changes from the supplier portal, ensure that you have relevant privileges. For more
information, see the related topics.

Here's how you submit a change request from Supplier Portal:

In Products, click Manage Item Change Requests.

On the Manage Item Change Requests page, click Actions > Create Change Request.
Enter details of the change request, and click Save and Edit.

To change the status of the request from Draft to Open, click Change Status > Open.
Click Save and Close.

vihUN

When you receive a notification to approve the status change, enter comments to help the change analyst
review the request.

Related Topics
« Overview of Change Orders and Change Requests

» Configure Supplier Portal Users
» Troubleshoot Access to Objects on Supplier Portal

Publish Change Orders from Supplier Portal

As a supplier portal user, you can publish engineering change orders into an XML report. You can then use the report to
integrate change order data with another application, or for another purpose.

After publishing is complete, the process number including hyperlinks to reports appears in the first 72 hours of report
generation. Later on, only the process number appears.

Here's how you publish a change order from Supplier Portal:

1. In Products, click Manage Item Change Orders.

2. Onthe Manage Item Change Orders page, open an engineering change order that you want to publish. You can
select more than one change order.

3. Click Actions > Publish. Note that you can only publish engineering change orders.

4. Inthe Change Publication Criteria dialog box, select the entities you want to publish and click Publish.

A process ID is generated for each change order. You can also monitor the publication status from the Manage
Item Change Orders page.

Here are some additional details about entities:

o The Include attachment files check box is enabled only if you select the change attachment entity.
Select this check box to include the attachment files (digital assets) along with the attachment metadata
when you publish.

o By default, the Change general information entity is always selected for publishing and you can't
change this setting.
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View Objects from Supplier Portal

As a supplier portal user, you can access the Product Management Search page (a Redwood page) to search for
objects that have been enabled by your administrator.

You can add the objects to clipboard, access objects using the Recently Visited panel, and use the Saved Searches panel.
Also, you can access to guided journeys if your administrator has configured it for you.
To access Product Management Search, click the Product Management card after logging in to the supplier portal.

When you navigate through the objects on the supplier portal, the content appears based on access control lists or
business rules (configured using Oracle Visual Builder Studio).

Note:
- The search pages are compliant with a web application firewall and support single sign-on bypass.

- The object pages appearing on supplier portal show the same tabs that are visible to other users by default,
unless they’re explicitly hidden through configurations.

Configure Users to Access Product Management Search Page on Supplier
Portal

Here's what you must do:

- Optin to the feature Redwood: Enable the New Supplier Portal Home Page Experience.

- Configure a view for supplier portal users with the Application field set to Supplier Product Management.
Configure views for item search, workflow search, and structures to ensure that supplier portal users can see
only the attributes relevant to them.

- Secure items by clearing the Public option for all item classes where it's selected.

« Secure access to changes such as (such as change orders, change requests, problem reports, and corrective
actions). To do this, you must add users to the Security tab on changes (from the classic interface). This is
because supplier portal users can view all changes that don’t have any users added in the Security tab of the
change. In short, all such changes will be visible to all supplier users.

Hide tabs on workflows according to your business requirements by using business rules configured in Visual
Builder Studio. This is to avoid supplier portal users from viewing all actions and tabs across all workflows
available to other internal users.

193
ORACLE



Oracle Fusion Cloud SCM Chapter 17
Using Product Development Manage Objects from Supplier Portal

Note:

- The Additional Workflow Controls configured in the Portal User column as part of the change type setup will
also be applicable on Redwood pages. Note that:

o Supplier portal users can be granted a higher-level access by adding a new role and assigning
permissions to that role through additional workflow controls.

o Between the permissions in the Portal User column and the new role, the functionality that’s higher of
the two will be applicable.

For example, for the Promote Manually action, if the Portal User is set as No, and New Role is set as To
next status, the portal user can promote the workflow to the next status. If you don't want the permission
in Portal User column to be applied, you can set all actions in that column as No.

- Supplier portal users can't navigate to the Product Management landing page like any other users of Product
Management.

- Supplier portal users won’t have access to the Navigator icon available for the other application pages.

If you're configuring a view for supplier portal users, set the Application as Supplier Product Management.
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18 Analyze Objects with OTBI

Why Use OTBI Reports

Use OTBI (Oracle Transactional Business Intelligence) reports to view embedded real-time analytics, reports, and
dashboards based on real-time transactional data in Oracle Fusion applications.

To access reports and analytics from the Product Development work area, click the Reports and Analytics side tab.

Related Topics
« Overview of Transactional Business Intelligence

Use Predefined OTBI Dashboards for Changes and Items

With additional dashboards in OTBI (Oracle Transactional Business Intelligence), you can view analyses for PLM objects.

Navigate to Oracle Transactional Business Intelligence > Dashboards > Supply Chain Management > Change
Orders Dashboard or PLM Details Dashboard.

Use the Change Orders dashboard to analyze the count, cycle time, and aging metrics of change orders, change
requests, problem reports and corrective actions and drill-down to view detailed reports. By default, the dashboard

will display data from the current year and the previous year. You can view the status, and the remaining or pending
approvers to approve the change orders using change order approval reports. Use the PLM Details dashboard to search
for items using various attribute filters. Use the link in the dialog box with available reports, set up by the administrator,
to view the OTBI report results page.

Publish Items for Analysis in OTBI

To make data available for reports, you must first publish the data for analysis in OTBI (Oracle Transactional Business
Intelligence). You can publish the item structure and where-used data.

Here's how:

- On the item page, click Actions > View Reports > Publish.
Or

- On the item search results page, select the items you want to publish. Then click Actions > Publish for
Analysis.

The analysis on items and structures provides critical decision-making information.

Note that you must these privileges:
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Manage Item (EGP_MANAGE_ITEM_PRIV) and Manage Change Order (ACA_MANAGE_CHANGE_ORDERS_PRIV) along
with

Monitor Product Management Workflow Objects
(ACA_MONITOR_PRODUCT_MANAGEMENT_WORFLOW_OBJECTS_PRIV)

Note: To see the descriptive flexfields in OTBI, you must run the scheduled process - Import Oracle Fusion Data
Extensions for Transactional Business Intelligence and to populate data in Structures and Components and Where
Used subject areas, you must run the scheduled process - Run Scheduled Process for Populating Subject Areas.

Related Topics
« Overview of Creation and Administration of SCM Analytics and Reports

« SCM Subject Areas in Oracle Transactional Business Intelligence
- How You Create and Edit Reports

FAQs About OTBI

How can | add the publish date and time in a report?

Navigate to Tools > Reports and Analytics > Browse Catalog. Open a report and expand Views in the side panel.
In the Compound Layout page, select the Title attribute and click Edit.
- Select Display Date and Time from the Started Time drop-down list and click Done.

The report will display the last publish date and time.
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19 New Item Requests

Overview of New ltem Requests

In Product Development, items are usually created with create dialog or various add item features on items, structures,
and change orders.

There's a more formal process of item creation called the New Item Request process. The administrator can establish a
Product Development item class that requires the new item request process to be followed.

In the new item request process, a new item is validated and approved before it's made available to enrichment
processes and structure-building in Product Development. The validation steps take place in the Product Information
Management work area.

A new item request may be appropriate for a product that will go through the complete manufacturing or
commercialization phases. A less formal process may be appropriate for a more preliminary, design phase of product
innovation.

Your enterprise may use either the formal new item request process, or the informal processes for the development of
new items and structures.

Related Topics
« Create New Item Requests

« When can items be added to a new item request?
« Set Up New Item Requests

New [tem Request Process

The formal process of item or structure creation requires the new object to go through a workflow. The item creation
may be initiated in Product Development, but it passes over to Product Information Management for the analysis and
approval process.

When a development item is created in Product Development, and it's going to be oriented through new item request,
a product manager or item analyst is notified of the item. When the new item request process is triggered, the item is
routed to assignees, who are informed what needs to be considered based on the item class setup.

The stages of the workflow are:
- Open - submitted
- Definition - when the assignees respond
- Scheduled
- Completed

The item is routed for approval, only after it has passed through the Completed status.
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For an item that's undergoing the new item request process, the Approval Status attribute - on the General
Information tab - displays the new item request number along with its approval status. This lets a Product
Development user identify those items that are engaged in the new item request process.
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